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\section{Introduction}

Object-oriented particles simulation project assumes an interactive
operation under PC Windows. This brings about the necessity to construct a
user-friendly interface and develop the object-oriented control and
interaction of the parts of the model. Therefore, while addressing the
general architecture of the 00 model one should forsee the interaction
types of object classes not only within the model functionality itself
but also interactions between GUI classes, manager classes and
computational classes (Fig. 1). The first goal of decompositions is to separate
control, visualization and computation parts, thus providing
flexibility and extendibility of each of the sections irrespective of
each other. The problem is simplified by already existing class hierarchy
for the interface and the CUA standard supported, in particular, by OWL
Borland C++.
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The 00 programming allows description of the numerical model made of objects
containing components of the physical task. These same objects, however,
include abstract data describing the solution methods of the numerical
model. Conventionally when writing a program a significant part of the code is
taken by the input information detailing physical conditions of the task as
well as by the selection of calculation data. Therefore, in developing 00-PIC
we used an approach of structural differentiation of the code into functional
sections connected with operation of the program. Thus, everything relating
to input of initial and boundary conditions of the task and to visualization
of information in our method is presented as a group of classes CUI-interface
and visualization. In addition to these the program makes use of stream
classes to save information on the model and the obtained data with the help
of service stream classes. Between GUI and the numerical model we use the
objects group "Manager" responsible for handling messages between separate
sections of the program and systems messages between OC Windows and the
program. With such an approach at hand one can readily organize the temporal
cycle of the task outstanding the objects describing the numerical model.
The numerical model includes description of the task geometry, electrophysical
data and the numerical algorithm. Therefore, while developing the class
"Model" we included an object desribing the relevant section. Thiss allows us
(within one and the same approach for the same physical models) to easily modify
the section in the oject "Model" which is connected with modification of
numerical algorithms. Utilization in the code of several objects "Model"
creates an opportunity for carrying investigation into optimization
of plasma physics models and numerical algorithms.

\section{Differential Field Equations}



In the general case the macroscopic behavior of the electromagnetic
fields of a continuous medium is described by the set of Maxwell's
equations:
\begin{eqnarray}
\rot\vec{E} &=& -\partial\vec{B}/\partial t - \vec{K} , \label{2.l} \\
\dvg \vec{B} &=& \rho_{m}, \label{2.2}
\\ \rot \vec{H} &=& \partial \vec{D}/ \partial t + \vec{J})
\label{2.3} \\ \dvg \vec{D} &=& \rho_{e},
\label{2.4}

\end{eqnarray}
where $\vec E$ and $\vec B$ are the electric and magnetic fields,
respectively. The electrostatic and magnetic induction are defined by the
vectors $\vec D$ and $\vec B$, the volume densities of electric and magnetic
currents are given by the vectors $\vec J$ and $\vec K$, and the
corresponding space charge densities are denoted by $\rho m$ and $\rhoe$.

Leaving aside the philosophical problems concerning the interpretation
of the above equations that can be found in books \cite{ 1 }-\cite{9}, we should
note that in some cases the introduction of magnetic currents and
charges offers a convenient formalism that makes electric and magnetic
fields tantamount, so that the equations become symmetrical.

Maxwell's equations for a continuous medium are written in the form
\begin {eqnarray}

\vec{D} &=& \hat{\varepsilon} (E) \vec{E} , \label{2.5} \\
\vec{B} &=& \hat{\-nu} (H) \vec{H} , \label{2.6}

\end{eqnarray}
where the $\hat\varepsilon$ and $\hat\mu$ tensors are, in the general case,
nonlinear functions of field strength and, indirectly, functions of
coordinates and time.

Given a temporal dispersion, the polarization and magnetization of the
medium at a given time are determined by the values of these quantities
at preceding times. The time dependencies of the tensors are given by the
integral equations
\begin {eqnarray}
\varepsilon(t) -\int\varepsilon(\tau)G_{ 1 }(t-\tau)d\tau, \label{2.7} \\
\mu (t) = \int \mu (\tau) G_{2}(t- \tau) d \tau. \label{2.8}

\end{eqnarray}
The nuclei $G I(t-\tau)$ and $G_2(t-\tau)$ describe the relaxations mechanisms
of polarization and magnetization of the medium, which possesses in this
case a sort of'"memory".

From the mathematical point of view, this type of the problem is
complicated in that the tensors $\hat\varepsilon$ and $\hat\nu$ are not
single-valued functions of the field even in a steady-state treatment. This shows
up in hysteretic phenomena and substantially dramatizes the problem
concerning the solution uniqueness.

Written in the above form, Eqs. (\ref{2.5}) to (\ref{2.8}) present in fact a
phenomenological model of a medium, where the microfields of elementary
charge carriers are averaged in volumes exceeding the atomic sizes and,
the more so, the charge carriers {\em per se}.



The external field sources, space charges and currents are not
absolutely independent quantities. They obey the conservation laws
formulated as continuity equations:
\begin{eqnarray}
\partial \rho_{e}Apartial t + \dvg \vec{J} &=& 0, \label{2.9} \\
\partial \rho {m}Apartial t + \dvg \vec{K} &=& 0, \label{2.10}
\end{eqnarray}
and the relations between the current densities in the medium and the
field characteristics are given by generalized Ohm's laws
\begin {eqnarray}

\vec{J} &=& \gamma {e}(E) \vec{E} , \label{2.11} \\
\vec{K} &=& \gamma_{m}(H) \vec{H} . \label{2.12}

\end{eqnarray}

The electric conductivity, $\gamma e(E)$, and magnetic conductivity,
$\gamma m(H)$, of
a medium are generally nonlinear tensors like $\varepsilon$ and $\mu$.

To isolate a unique solution to the set of Eqs. (\ref{2.1 })--(\ref{2.4}) it is
necessary to formulate the boundary-value problem by setting boundary
conditions for the field components at the intermediate boundaries:
\begin{eqnarray}

E_{\tau+} = E_{\tau-} , \:\: H {\tau+} = H_{\tau-}, \label{2.13} \\
D_{n_+} = D_{n_-}, \:\: B_{n_+} = B_{n-} \nonumber

\end{eqnarray}
and at perfectly conducting surfaces:
\begin{eqnarray}

D_{n} = \sigma {e} , \:\: B = \sigma_{m}, \label{2.14} \\
H_{\tau} =j_{e} , \:\: E_{\tau} =j_{m}, \nonumber

\end{eqnarray}
Here the indices $\tau$ and $n$ are associated with tangential and normal
field components, respectively, and $je$, $jm$, $\sigma e$, and $\sigma m$
are the respective densities of electric and magnetic surface currents and
charges. The signs -'+" and "--" refer to different sides of boundaries.

For the impedance-type boundaries, whose radii of curvature are large
compared to the skin layer thickness, the Leontovich boundary
conditions are valid, which relate the surface current densities as
follows:
\begin{equation}
\vec{K} = Z [ \vec{n} \times \vec{J} ], \label{2.17}
\end{equation}
Here $Z$ is the wave impedance of the conducting surface.

For the space charges and currents, it is necessary to set their initial
$(t=0)$ distributions in volume $V$:
\begin{eqnarray}
\rho_{e} (r,t_0) = \rho_{e0}(r), \:\:
\rho_{m} (r,t_0) =\ rho_{m0}(r), \:\: r \in V, \label{2.15} \\
\vec{J} (r,t.) = \vec J._0(r), \:\:
\vec{K} (r,t_0) =\vec K_0(r), \:\: r \in V. \label{2.16}
\end{eqnarray}

Given dispersion media, it is necessary to prescribe the 'prehistory' for



the polarization and magnetization of the medium by Eqs. \ref{2.7} and
\ref{2.8}.

In some cases, it appears convenient to introduce auxiliary functions,
such us scalar potentials $\phi -{e}$ and $\phi {m(})$ and vector potentials $A$
and $F$ related to the field components by the equations
\begin feqnarray}
\vec{JE} J \nabla \phi { e} - \partial \vec{A} / \partial t, &&
\vec{D} =\rot \vec{F} , \abel{2.18} \
\vec{fH) = - \nabla \phi {m}) - \partial \vec{F} / partial t, &&
\vec{113} = \rot \vec{A}.

\end{eqnarray}

In order that the introduced quantities be singlevalued, a certain gauge
condition should by applied to them. For example, the Lorentz gauging
is described by the equations
\begin jeqnarray}
\dvg vec {A) + \varepsilon\,\mu\,\partial\phi eApartial t +
\mnu\,\gamma -e\phi -e &=& 0, \label {2. 191 \\

\dvg \vec {F) + \varepsilon\,\mu \,\partial \phi mApartial t +
\varepsilon\,\gamma~m\phi~m &=& 0. \nonumber

\endfeqnarray}

Having performed a rotor operation on Eqs. \ref{ 2. 1 ) and \ref{2.3 }, we obtain
so-called wave equations with separated characteristics of electric and
magnetic fields:
\begin {eqnarray}
\rot (\MUA{-1 } \ot \vec{E}) + \varepsilon \,\partialA {2) \vec{E}Apartial
tA {21 &=& \partial \vec{J}Apartial t + \gamma {e} \partial \vec{E}/
\partial t, \label {2.201 \\
\rot (\varepsilon A{_l} \rot \vec{H}) + \mu
\,\partialA {21 \vec{H}Apartial tA {2) &=& \partial \vec{IK}Apartial t +
\gamma -{m} \partial \vec{H}/ \partial t. \nonumber
\end{eqnarray}

If we introduce a symbolic d'Alamberian $\Box=\Delta-\partialA2Apartia1
tA2$, where $\Delta=dA2/dxA2+dA2/dyA2+dA2/dzA2$ is Laplace's operator,
then we obtain similar wave equation for the fields and potentials:
\begin {eqnarray}
\Box\vec{E} &=& \mu \,\frac {\partial) {\partial t) (\vec{J} + \gamma-le}

\vec {E}) , \cr
\Box\vec{(H) &=& \varepsilon \,\frac {\partial) {\partial t} (\vec{(K) +

\gamnma m) Wvee{H)) , \cr
\Box\vec{(A) &=& \mu\, (\gamma {e} \frac{(\partial \vec {A}}I {\partial t) -

\vec {J}) , \cr
\Box\vec {F) &=& \varepsilon\, 6\gamma {m} \frac {\partial \vec{(F)

{\partial t} - \vec {K}) , \label{12.21}) \\
\Box \phi { fe} &=& \mu \,\gamnma {e} \frac {\partial \phi} {\partial t} -

\frac {\rho_{e} I {\varepsilon}, \cr
\Box \phi {m(i} &=& \varepsilon \,\gammaf m} \frac (\partial \phif {m)}}

{\partial t} - \frac{\rho {m} I {\mu}. \nonumber
\end{eqnarray}

In the right-hand sides of these equations, the first term describes



the external or foreign field sources and the second one the
conduction currents of the medium. The potentials $\vec A$ and $\vec F$,
$\phi e$ and $\phi m$ are not independent, as the field strength vectors
are related to the induction vectors by field equations.
The introduction of one or
another potential couple depends on the statement of the problem, i.e. on
which type of field source, electric or magnetic, can be introduced in a
more convenient manner.

At this point we suppose that the statement of the problem in the form of a
set of Maxwell's equations is completed and we may turn to the
discussion of the most important particular cases. Throughout the
subsequent consideration we shall deal with dispersion-free media.

First of all, the case of harmonic oscillations deserves consideration,
where any characteristic of the field or the source, $T(r,t)$, can be
expressed as
\begin{equation}
. T (r, t) = T_0(r) \,e^{i\omega t} , \label{2.22}
\end{equation}
where $T_0$ and $\omega$ are, respectively, the oscillation amplitude
and frequency.

Such statements are typical of electrodynamic systems possessing
pronounced selective or resonance capabilities, such as waveguides,
resonators, and slowdown system in microwave devices. For this case
Maxwell's equations take the form
\begin{eqnarray}
\rot \vec{E}_{0} &=& -i\omega \vec{B}_{0} + \vec{K}_{0},

\label{2.23} \\
SVrot \vec{H}_{0} &=& i\omega \vec{D}_{0} + \vec{J}_{0} .\nonumber
\end{eqnarray}

Using two remaining equation, Eqs. (\ref{2.2}) and (\ref{2.4}), we may
represent the complete set of equations as a couple of second-order
equations, each including quantities only relevant to the electric field
or to the magnetic field:
\begin{eqnarray}
\rot(\mu^{- 1 }\rot\vec E_0) &=& \omega\vec D_0-
i\omega\vec J_0-\rot(\mu^{-1 }\vec K_0), \label{2.24} \\

\rot(\varepsilon^{-1 }I\rot\vec HO0) &=& \omega\vec B_0 -
i\omega\vec K_0+\rot(\varepsilonA{-1 } \vec{J}{0}).\nonumber

\end{eqnarray}

For piecewise homogeneous media these equations can be simplified to
\begin{eqnarray}
\rot\rot\vec E_0 - kA2\vec E_0 &=& {} - i\omega\mu\vec J_0 -

\rot\vec K_0, \label{2.25} \\
\rot\rot\vec H_0 - k^2\vec H_0 &=& {} - i\omega\varepsilon\vec K_0 +

\rot\vec J_0, \nonumber
\end{eqnarray}
where $kA2=\varepsilon\mu\omegaA2=(\omega/c)A2$, $\vec k$ is the wave vector
and $c$ is the velocity of propagation of electromagnetic oscillations
in the medium.



With the above assumptions, the finite conductivity of the medium can be
taken into account by introducing complex quantities marked by an upper
dot, $\dot\varepsilon=\varepsilon-i\gammaeAomega$,
$\dot\nu=\nu-i\gamma mAomega$, the relations between
the field strengths and the sources intensities are determined by formulas
(\ref{2.1l}) and (\ref(2.12}).

If we put the source intensities equal to zero, nontrivial
solutions to the set of Eqs. (\ref{2.25}) will exist only for fixed $k$ or
$\omega$ values. So the problem is reduced to finding the eigenvalue spectrum
for $k$ (or resonance frequency $\omega$) and the free oscillation modes
described by the Helmholtz equations
\begin{equation}
\begin {array} {rcl}
\Delta \vec{E}_{0} + k^{2} \vec{E}_{0} &=& 0, \\
\Delta \vec{H}_{0} + kA{2} \vec{H}_{0} &=& 0.

\end{array} \label{2.26}
\end{equation}

Note that, despite the fact that the equations for the electric and
magnetic fields are separated, this nevertheless does not mean that
they are independent of each other, since in an oscillatory mode the
electric field energy is continuously converting into the magnetic
field energy and vice versa. This is not the case for steady-state or
time-independent fields.

The equations for static fields are substantially simplified, as they
involve no time derivatives, and can be separated into couples. Let us
first consider the magnetic field equations
\begin {eqnarray}

\dvg \vec{B} &=& \rho_{m}, \label{2.27} \\
\rot \vec{H} &=& \vec{J} . \label{2.28}

\end{eqnarray}

The efficiency of one or another algorithm of solving the problems of
magnetostatics depends essentially on the details of the problem statement
and on the choice for the unknown quantities fields, vector or scalar
potentials. These issues are treated rather comprehensively in review
articles \cite { 1 0} --\cite{ 1 5}. We shall only give a brief outline of these
approaches.

The simplest algorithm involves a straightforward solution of the set of
Eqs. (\ref{2.27}) and (\ref{2.28}) jointly with field equations
\begin{equation}

Bi=\mu {ij } (H)Hj. \label{2.29}
\end{equation}

This technique is not frequently applied because of its high cost.
In deriving Eqs. (\ref{2.29}) we used the Einstein rule for summation over
repeating indices that will be frequently used in the subsequent
discussion.

A more widespread approach is to introduce a vector potential by the



relation $\vec B=\rot\vec AS, that results in a unique second-order equation
\begin {equation}
\Delta \vec{A} = -\mu ( \vec{J} + \vec{J}_{m}). \label{2.30}

\end{equation}
Here $\vec Jm=\rot\vec M$ is the volume density of the magnetization current
for the medium, $\vec J$ is the density of the conduction current for the
foreign field sources, and the magnetization vector $\vec M$ is related to
$\vec B$ and $\vec H$ as
\begin {equation}

\vec{B} = \vec{H} + \vec{M} . \label{2.31}
\end{equation}

Thus, for systems including constant magnets we way put $\vec J=O$, while
for linear media we have $\vec M=O$ and $\vec J_m=O$. Arrange the boundary
conditions for Eqs. (\ref{2.30}) to the form
\begin{equation}
\vec{n} \times ( \rot\vec{A}_+ - \rot\vec{A}_-)
\rnu(vec{j} + \vec{j}n ), \label{2.32}
\end{equation}
where $\vec j$ and $\vec jm$ are the corresponding surface current.

Using a scalar magnetic potential, $\phi m$, such that $\vec
H=-\nabla\phi-m$, leads to quasilinear equation of the form
\begin{equation}
\frac{\partial} {\partial x i} \left( \mu {ij} \frac{\partial\phim}
{\partial x_j }\right)=-\rho \label{2.33}

\end{equation}
with the boundary conditions given by
\begin{equation}
\mu_+\frac {\partial\phi-m } {\partial n+} +\left(\vec n [
\vec j\times\vec n]\right)=\mu_-\frac {\partial\phi} {\partial
n_-}. \label{2.34}

\end{equation}

The use of a scalar function substantially moderates the requirements to
the computer operative memory needed to remember the

values of the unknown variables, being, however, not free from some
disadvantages. The principal disadvantage is that a scalar potential is not a
single-valued function in a space incorporating vortex sources, i.e.
conduction currents. In order to eliminate this defect, an intermediate

boundary is introduced into the space, at which a jump in $\phi_m$
proportional to the total excitation current of the magnetic system is
specified.

Most widely used in practice is the method of a modified scalar
potential $\psi m$ introduced by the relationship
\begin{equation}

\vec{H} = \vec{H}_{O} - \nabla\psi_{m} . \label{2.35}
\end{equation}
Here the total field $\vec H$ consists of the vortex component $\vec H_0$
excited by the given conduction current $\vec J=\rot\vec H_0$ and the
potential components described by a function $\psi m$ obeying the equation
\begin{equation}
\dvg( \mu\nabla\psim ) =\dvg (\mu\vec{H}_0). \label{2.36}



\end{equation}

In such a model a nonlinear boundary problem is solved only for the
region filled with a magnetized medium, while the quantity $\vec H_0$ involved
in the right-hand side of the equation is calculated by integration
over the volume occupied by conduction currents:
\begin {equation}
\vec{H}_{0}(r) = \frac{ 1 } {4 \pi} \int {V} \frac{[\vec{J} \times
\vec{r}\,])} {\vec{r} - \vec{r}\,'l}\, dV, \:\:\vec{r}\,' \in V. \label{2.37}

\end{equation}

The simplest form is taken by the equations of electrostatics for linear
piecewise homogenous media, which transform into the Laplace's equation
\begin{equation}

\Delta \phi = 0. \label{2.38}
\end{equation}

The Dirichlet conditions
\begin{equation}

\phi [_{S_0} = \phiO(r) \label{2.39}
\end{equation}
are set at the surfaces of the conducting electrodes, while at the
boundary between two media having dielectric constants $\varepsilon +$ and
$\varepsilon-$ the continuity conditions for the normal component of the
electrostatic induction vector
\begin{equation}
\varepsilon+\frac {\partial\phi} {\partial n} L_{S1+} = \varepsilon_-
\frac{\partial\phi} {\partial n}l_{S_-} \label{2.40}

\end{equation}
is satisfied.

The current passage through a medium having a finite conductivity is
described by the equation
\begin{equation}

\fWrac{\partial} {\partial x{i} } \left( \gamma{ij} \frac{\partial \phi}
{\partial x {j} } \right) = 0, \label{2.41}

\end{equation}
where the conductivity tensor for the medium, $\hat\gamma$, is related to the
current density by the expression $J_i=-\gamma {ij}\partial\phiApartial xj$.

Statements of electric elasticity and magnetic
thermoelasticity problems can be found in articles by Bitsadze \cite{ 16}
and Rukhadze \cite { 17)}.

\section{Algorithms for Numerical Solution the Problems of
Electrodynamics}

For a finite difference approximation of Maxwell's equations (\ref{2.1}) and
(\ref{2.3}), the great diversity of double-layer schemes applied for solving
the evolution problems can be classified as explicit schemes described by
the equations
\begin{eqnarray}

BA{n+1/2} &=& B^{n-i/2} + \tau ( rot E^{n} - K^{n} ), \nonumber \\ &&

L --



\label{13.1} \
EA{n~l} &=& E"{n} + \tau (-rot BAIn+1/2} - JA{n+l/2} ) \nonumber

\endleqnarray}
and implicit schemes described by the equation
\begin {eqnarray}

B/Afn+1}{Ik+1} &=& BAI{n} + \tau (\rot(E A{n+l} _k + EAn) -KA{n12

\nonumber \\ &&
\label{3,2} \

E A n+1}{jk+l} &=& E A {n) + \tau(-\rot( B A{n+1} {k} + B A{n}) -JA {n+1/2})
\nonumber

\end{eqnarray}
Here the superscript denotes the number of time steps. The Lack's
time-centered explicit scheme, when applied to hyperbolic equation sets
like Eq. (\ref{ 3. 1 ), is of the second-order accuracy. It is stable when the
Courant condition $\tau/h<l1$, where $\tau$ is the step of discretization in
time and $h = ( h A{f 2} x\,\min} + h A{j-2} y\,\min} + h A{f 2} {z\,\min} )A{- 1/2)$
is the step of discretization in spatial variables is satisfied.
Here the superscript denotes
the number of time steps. The idea of applying these schemes to Maxwell's
equations was proposed by Yee \cite{42}. So stringent conditions for
stability result in that most of versions of this scheme use a uniform
spatial grid.

The implicit scheme, Eqs. 6\ref{3.2}) is absolutely stable. However,
it requires inner iterations at each time step marked with a
subscript. The initial values of variables in iterations may be set
equal to the corresponding values at the preceding time step, e.g.
$E_1JA{n+1}=EAn$. As pointed out in Ref. \cite{143), in order to attain the
convergence to a relative accuracy of $1OA {-31}$, four to nine iterations
are needed. Application of explicit schemes may be recommended for the
simulation of the motion of ultrarelativistic particles as well as for
systems whose state is close to physical instability.

\subsection{(Three--Dimnensional Fields)

Let us write an explicit scheme in a Cartesian coordinate system with
shifted grids, which is of the second-order accuracy both in time and in
spatial variables and was used in most of the relevant computations
\cite{144}1-\cite{161 }. This scheme uses a uniform grid
$\{ x~ji} (i-1) hjx} \) \times \{yU} = (j-1) h -{y} \) \times
\f zý{k} = (k-i) h.{z} \} \times \{\tau {n} = (n-I) h.{\tau} \}$,
such that
\begin {eqnarray}
\frac{( E,_x} )A{n+1}_{i-1/2,j,k} - ( E_{x )A {n}_{i-12,j,k}}{\tau}
\frac{( B~fz )A {n+l1/21_{i- 1/2,j+ 1/2,k) - ( B{z} )A {n+1/2}_ {i-112,j-1/2,k} } {h_{y} I \nonumber \

-\frac{( B_{y} )A {n+l/2} {i-1/2,j,k+l/2} - (B_{y} )A jn+112}_{i-l/2,j,k-l/2}) } h {z}
( (Jfx} )A jn+1/2} {i-l/2,j,k} , \label{3.3} \\

\frac{( E_{y} )A {n+l} {i~j-l/2,k} _ (Eý_y} )A {n} {i~j-I/2,k}} {\tau)
\frac{( B~x} )A {n+1/2)_ {ij- i/2,k+1/2} - ( B{x} )A {n+l/2} {i~j-l/2,k-1/2} }{h_{z} I \nonumber \\

-\frac{( B,_z} )A {n+112} {i+1/2,j-112,k} - (B~jz} )A {n+lI2}{ji-1/2,j-lf2,k}}{h_{x}}
( (J{y} )Af n+ 1/2}_{i~j- 1/2,k) , \label{(3.4) \\

\frac{(f E_ Z) )A {n+l} {i~j,k-l/2} _ ( E~jz )A {n} {i~j,k-l/2}}{f\tau}
\frac{( B_{y} )A {n+1/2}_{i+112,j,k-112} - (B_{y) )A jn+1/2} {i-l/2,j,k- l/2) } h {x} } \nonumber \

- \rac{( B~jx} )A Jn+1/2} {i~j+1/2,k-1/2} - ( B{x} )A {n+1/2} {i~j-1/2,k-1/2}} {h_{y}}



-(LIZ) )A {n+1/2} {i~j,k-112} , \label{ 3.5} \
\frac{I( Bý_x}y. )A In+ 1/2} {i~j-1/2,k- 1/2} - ( B~fx) )A {n-l/2} {i~j-l/2,k-1/2}}{\tau}
\frac{( E,{y} )A {n)} {i~j-1/2,k) - ( Eý_y} )A {n}_ {ij-1/2,k-l}}I{h-{z}} \nonumber\

-\frac{( E,{z} )A{n}_{i~j,k..1/2} - ( E_{z} )A1fn}{i~j-1,k-l/2}} {hý{y}}
( (K{X} )A {n} {i~j-l/2,k..1/2} , \label{3.6) \\

\frac{( B{y} )A fn+1/2} {i-1/2,j,k-1/2} - (Bp{y} )A{n-l/2}_{i-l/2,j,k-l/2}} {\tau)
\frac{ Ef]ý{z} )A{n} {i~j,k- 1/2) - (E]_fz} )A {n} {i- 1 j,k-l/2} } h_{x} } \nonumber \\

-\frac{( Eý_X} )A {n} {i-1/2,j,k} - (13{x) )Afn}{ji-l/2,j,k-l1}}{hfz)}
-(K.1y} )A{n} {i-1/2,j,k-l/2} , \label{3.7}\\

\frac{( B~jz} )A jn+l/2}_{i-1/2,j-1/2,k} (B_{z} )A In- 1/2_ {i-l1/2,j-1/2,k)}I {\tau})
\frac{I( E_{x} )A{n}_ {i- 1/2,j,k} - ( E,-x} )^f n} {I-12j1k}h{} nnme

- \frac{I( E_{y} )A {~ {inj -12k - E y} ) { i-l/,j-l/,k } }{h. { x}) }n n m e \

- (KýJZ} )AIn} _{i-2j- 1/2,k) -l(bel{3.8}ni l-12,)I{h{l

\end{eqnarray} {-/j12k).Vb]38

\subsection{IPlane Symmetric Fields)

The case of plane symmetrical fields characteristic of uniform waveguides of
any cross section is analyzed using the limit $h z\Rightarrow\infty$ and
removing the indices corresponding to the coordinate $z$:
\begin {eqnarray}
\frac{( E,{x} )A {n+l} {i-l/2,j} - (EL{x} )A(n}_ {i-1/2,j}}{\tau) &=&
- ( JfX} )A Jn+1/2} {i-1/2,j} \nonumber \\ &+&
\frac{( B3ý{z} )A {n+l/2} {i-1/2,j+1/2} - (B{z} )A {n+1/2} {i-l/2,j-l/2} } {h {y} }

,\label{3.9} \\
\frac{( E{y} )A{n+1} _{i~j-1/2} (E{y} )A{n} {i~j-1/2}} {\tau) &=&
- (J{y} )A{n+1/2} {i~j-l/2} \nonumber \\
&-& \frac{(f B~fz} )A {n+1/2} {i+l/2,j- 112} j B_{z} )A {n+l/2} {i-1/2,j-l/2} } h {x} }
,\label {3.l10) \\

\frac{( E,{z} )A {n+1} {~ij}j - ( E,_z) )A In} {i~j}}{\tau} &=&
\frac{( B,{y} )A In+ 1/21_{i+l1/2,j) - ( B~y} )A fn+l/2} {i-l/2,~j} h_{xj}}
- (JLIZ) )A {n+1/2} {i~j} \nonumber \\
&-& \frac{ ( B_{x} )A{n+1/2} {i~j+1/2} - (B{X} )A {n+1/2}{fi~j-/2}} {h_(y}}
, \label{3.1 1} \\

\frac{( B_{x} )A fn+l/2} {i~j-1/2} - (B_{x} )A In- /2} {i~j-1/2}}{I\au} &=&
- \frac{(f EIz} )A{~ {~i~j} - (E]ý_z} )A In}~ {ij- I) I {h {y} I \nonumber \
&& - (K_{x} )Ajn}~ {ij-l1/2) , Mlabel {3.12)
\end{eqnarray}
\begin {eqnarray}
\frac{( B~y} )A {n+1/2}_ {i- 1/2,j} (By} )A (n-1/2}_ {i- 1/2,j) I {\tau} &=&

( (K{y} )A{n} {i- 1/2,j) \nonumber \\
&+& \frac{(fE_{z} )A {n} {i~j} - (E_{z} )A {n}_{il Ij}}I{h_{x}I
, \label{3.13} \\

\frac{( B~fz )A jn+l/2} {i-l/2,j-1/2} - (B_{z} )A In-1f2} {i-1/2,j-1/2}} {\tau) &=&
\frac{( E{x} )A jn} {i-l/2,j} - (E]ý{X} )A {n} {i- 1/2,j- 1}} {h {y}} \nonumber \

-\frac{J( Eý_y} )A {n} {i~j-1/2} - (E~jy} )A In}{fi..J1,/2}}{th-x}
&-& (Ký{Z} )A {n} {i-1/2,j..1/2} .\label{3.14}
\endleqnarray}

\subsection {Axially Symmetric Fields)

For a cylindrical coordinate system $(r,\phi,z)$ with the assumpti .on that
$\partialApartial\phi\equivO$ we have the scheme
\begin jeqnarray}



\frac{( EJr} )A {n+1} {i..1/2,j} - ( E~fr} )Afn} {i..1/2,j}}{\tau} &=&
- (J{r} )A{n+1/2}_{i-l/2,j} \nonumber\\ &+&
\frac{I( Bf {\phi) )A {n+1/2} {i- 12,j+112} - (B {\phi} )Afn+l/2} {i-1/2,j-1/2} }{h {z} }

,\label{13.15) \\
\frac{( E{z} )A {n+l} {i~j-l/2} - (E,_z} )A{n} {i~j- 1/2}}1\tau} &=&

-(Jz} )A {n+l1/2}_ {ij- 1/2) - \nonumber \\
- r {i+1/2}( B {\phi} )A In+l1/2)_ {i+1/2j-l1/21 &-& r {i-1/2)

(B_{\phi} )A fn+1/2} {i-l/2,j-l/2} I / ( r {i~h.{r} ) , \label{3.16} \
\frac{(E,{\phi} )A In+1}_ {i~j - ( E {\phi} )A I n} {i~j}I{I\tau) &=&
\frac{( Bý_r} )A {n+l/2} {i+1/2,j} - (B,{r} )A {n+1/2}{fi-1/2,j}}{hfzJ}
- ( J {\phi} )AJn+l/2} {i~j} \nonumber \\
&-& \frac f (ý_ Bz} )A {n+l/2} {i~j+1/2 - (B3ý_z} )Afn+1/2}_{i~jl/2}}{h~fr}

,\label{3.17} \\
\frac{( B~r} )A {n+1/2} {ij-1/2} - (B~r} )A{n-1/2} {i~j-l/2)}}\tau} &=&
- \frac{(f E {\phi} )A Il {_i~j} - ( E {\phi} )A {n} {i~j-l}){h_{z}} \nonumber\
&-& ( K{r} )A Jn} {i~j-I/2} , \label{3.18} \\
\frac{(.B_{z} )A Jn+1/2} {i-l/2,j} - (B_{z} )A In-l/2} {i-1/2,j}}{\tau} &=&
- (K~fZ} )A {n} {i- 1/2,j) \nonumber \\ &+&
\fracJrJi}( E {\phi} )A Jn} {i~j} - r=-i-1 }( E {J\phi} )An}{1,j}{ri1/h{z}

,\label {3.191 \\
\frac{( B_{\phi} )A In+ 1/2}_{i-l1/2j-l1/2} - ( B_{\phi} )A In- /2} {i-l/2,j- 112} }\tau} &=&

\frac{( E_{r} )A In}_{i-1/2,j} - (E,{r} )A Jn} {i-1/2,j-1) } h_{z} \nonumber \
- \frac{ ( E__z} )A fn}{i~j-l/2} (]E_{z} )A {n}_{i-1,j-/2}}Jh.{r}}
&-& ( K {\phi} )A {n} {i-1/2,j-1/2} . \label{3.20}
\end{eqnarray}

By passing the limit, we obtain for the axis of symmetry:
\begin {equation)
(E]_{Z) )A {n+l} {1,k-l/2} - (Eý_Z} )A {n}_ {1,k-1/2} =\frac{4 \, \tau I}{h.1r}}
(B_{\phi} )A {n+1/2} {3/2,k-l/2} -4 \, \pi \tau ( Jf z} )A fn+l/2}{l ,k-1/2}
\label{3.21}

\end{equation}

\subsection{JApproximation of Boundary Conditions)

The principal disadvantage of rectangular grids is that the boundary of
the simulation region for any actual problem does not conform to the
grid, i.e., does not lie along the grid lines or parallel to them.
The roughest model for taking into account boundary conditions
approximates the actual boundary by a polygonal line consisting of
segments that run along the grid lines as close to the actual boundary
as possible. The perfectly conducting boundaries, the tangential
components of the electric field, and the normal components of the magnetic
field at corresponding points of the approximated boundary are set to be
zero for each time step. An analysis of the properties of the
difference scheme shows that with such an approximation of boundary
conditions the scheme as a whole has the first rather than second order
of convergence, if only there exits just one segment of the actual
boundary that does not coincide with the grid lines.
By contrast, at the axis of symmetry and in the planes of symmetry
of the solution the normal components of the electric field and the
tangential components of the magnetic field are set to be zero.

It appears more



complicated to analyze the conditions for emission of an electromagnetic wave
from boundary. They result in simple expressions only in the case when the
TEM wave is normally incident on a boundary segment that coincides with
a grid line. For instance, for a wave propagating in a coaxial along the
$z$ axis in the positive direction these conditions in a cylindrical
coordinate systems have the form
\begin {equation}
Br = -E_\phi,\quad B1phi = E r,\quad Ez = Bz = 0. \label{3.22}

\end{equation}

For a wave striking the boundary at an angle these conditions will not
be exact. In order to diminish the effect of the inexactness of the
boundary conditions for an inclined incident wave, open boundaries
should be placed at a distance from the region of charged
particle-field interaction or separated from this region by areas of
finite conductivity, which well absorb radiation. Conditions (\ref{3.22}) are
approximated by the finite-difference equations
\begin {eqnarray}
(B_{r} )A{n+l/2}_{i,k+1/2} + ( B{r} )^{n-l/2}_{i,k-l/2} &=&
- 2 \, ( E_{\phi} )A{n}_{i, k} , \label{3.23} \\
(B_{\phi} )A{n+l/2}_{i-1/2,k+l/2} + ( B_{\phi} )A{n-1/2}_{i-1/2,k-l/2} &=&
2 \, ( E_{r} )A{n}_{i-1/2,k} , \label{3.24} \\
(E_{z} )A{n}_{i,k+l/2} + ( E_{z} )A{n}_{i,k-1/2} &=& 0, \label{3.25} \\
(B_{z} )A{n+l/2}_{i-l/2,k+l/2} + ( B_{z} )A{n+1/2}_{i-1/2,k-1/2} &=& 0.
\label{3.26}

\end{eqnarray}
Here the index $k$ at the boundary is assumed to be fixed.

Engquist and Majda \cite{62} and Mur \cite{63} considered boundary conditions
of the absorbing type for the case of an arbitrary position of the wave
incident on a plane boundary.

Let, for instance, a plane wave having the velocity components $c x$, $c_y$,
and $cz$ such that $c__xA2+cyJA2+c__zA2=cA2$ be incident in the direction of
decreasing of the coordinate $x$. Then for the plane $x = 0$ any
component of the field $W$ satisfies the wave equation
\begin{equation}
\left(\partial x - \frac{\sqrt{ 1 - (c/cy)^2 - (c/cz)A2} } {c}
\partial-t \right) W L_{x = 0} = 0 . \label{3.27}
\end{equation}

Expanding the square root into a series, we obtain boundary conditions
of the first order
\begin{equation}
\left\partial x - \frac{ 1 } {c} \partial t \right) W j_{x = 0} = 0 \label{3.28}
\end{equation}
and the second order
\begin {equation}
\left(\partialA2_{xt} - \frac{ 1 } {c} \partialA2_{tt} + \frac{c} {2}
(\partialA2_{yy} + \partialA2_{yy} )\right) W L_{x = 0} = 0. \label{3.29}
\end{equation}

These equations can be substantially simplified for a two-dimensional
case. Consider, for instance, a field independent of $z$ and an



$E$-polarization wave having the components $E-z$, $H-x$, and $HJy$ only. From
Maxwell's equations it follows that
\begin {equation}
\frac{\partial B -x} {\partial t} = \rac {\partial E~z} (\partial y}1.
\label{f3.3 0}

\end{equation}

Substitution of Eq. (\ref{ 3.30)) into Eq. (\ref{3.28}) gives the absorption
condition for $W=E-z$ in the form
\begin {equation}
\left( \frac{\partial E~z} {\partial x} - \frac{l I } c} \frac{ \partial E -z}
f{\partial t} - \fraclc} {2) \frac{\partial Bx} {\partial y) \right)_ {x = O} = 0.
\label {3.3 1 }
\endfequation}

Similar conditions can readily be deduced for an $H$-polarization wave.
Let us now write finite-difference approximations for the absorption
conditions. For Eq. C\ref{3.27}) the difference scheme has the form
\begin fequation)
(Ez )A fn+1} {0,j,k+1/2} =(Ez )An{ l~j,k+1/2} +
\frac{c\tau - h~x} {c\tau+h x} [ ( Ez )^n+l }_{ 1j,k+l/2} -
(Ez )Afl {0j,k+ 1/2} ] . \abel{f3.32)

\endjequation}

Write the second-order scheme for Eq. (\ref{3.28}) assuming that
$h x=hjY=h z-h$:
\begin {eqnarray}
( E_{Z} )A {n+1} {0j,k+1/2} &=& -( E,{z} )AIn-l} {1, j,k+1/2} + \frac~c \tau - h)
{c \tau+ h} [ ( Eý_z} )A jn+l} {_l j,k+1/2} + ( E{z} )AI{n-1 ){0,j,k+l/2} ] \nonumber\
&+& \frac {2 \, h) f{c \tau + h}
[ ( Ez} )A{n} {O~j,k+1/2} + ( E{z} )A~n In)_{j,k+l1/2) + \nonumber \\ &+&
\frac{( c \, \tau )/1{211}c \tau + h) ( ( Efz) )AI{n} {0j+l,k+1/2} -
2 ( E,_z} )A {n} {0j,k+1/2} + \nonumber \
&+& (E_{z} )AIfn} {0j-1,k+1/2} +
(E~fZ} )A fn}_ {j+l,k+1/2} - 2 (E_{z} )A fn} {l j,k+l1/2) + \nonuinber\
&+& (Eý_z} )A fn} {1,j.l,k+1/2} +
(E_{z} )A {n} {0,j,k+3/2} - 2 ( E{z} )A fn} {0j,k+112} + \nonumber \\
&+& (]EýJZ )A jn} {0j,k..1/2} +
( E_{z} )A{n}_ I lj,k+3/2} - 2 ( Ejz} )A {n} { lj,k+112} + \nonumber \
&+& (E~fZ} )A {n} {1,j-1,k-1/2} ). \label{3.33}
\end{eqnarray}

For a two-dimensional case condition, Eq. (\ref{3.29}), is approximated by the
scheme
\begin {eqnarray}
(Eý_z} )A {n+l}_ {Oj} &=& ( E{Z} )A In} {Il~ + \fracfc \tau - h) {c \tau + h)
(Eý_z} )A {n+1} {lIj} (EL{Z} )A {n} {0,j} ) - \nonumber \\ && {)}-
\frac{c} {2 ( c \tau + h (} ((B {x} )A {n+1212}{O~j+1/2} - (B~fx} )A {n+112} {)j- 1/2) + \nonumber \
&& {}+( B{x} )A {n+1/2} {1,j+l/2} - (B~fx} )A jn+1/2}_{l~j.l/2})
\label{3.34}
\end{eqnarray}

A somewhat different approach to the conditions at an open boundary
segment was used by Weiland in the BCI code modeling axially symmetrical fields



\cite {51 } and the TBCI code modeling azimuthally nonuniform oscillation
modes \cite {52,53} Weiland considers a particular case of a wave propagating
along an axially symmetrical tube and assumes that the field at a point
$z_0$ at a time $T$ is the same as that at a point $z_0-ct$ at a time
$t-\tau$, so that the $B_\phi$ component is approximated by
\begin{equation}
(B{\phi} )A{n+1/2}_{i-1/2,k} = ( {\phi} )A{n-m+l/2}_{i-l/2,k-1 },

\quad mc\tau = h_{z} . \label{3.35}
\end{equation}

The equation approximating the $E-r$ component will then take the form
\begin {equation}
( E{r} )A{n+l _{i-1/2,k} = (E_{r} )A{n}_{i-1/2,k} + \frac{\tau} {m \,h_{z} }
[( B_{\phi} )A{n+l/2}_{i-l/2,k-1} - ( B_{\phi} )^{n-m+l/2}_{i-1/2,k-1} ] . \label{3.36}

\end{equation}

The computation by this scheme requires storing an intermediate
information for $m$ layers. In deriving the finite-difference
equations Weiland used the finite integration method where the volume
or area (in a two-dimensional case) of the grid cell is considered
as an element for integration. The finite-difference equations
constructed in this case are the same as those we derived for the inner
point of the grid. In the methodological respect, this approach is
interesting in view that, when integrating for a near boundary element, one
may introduce into the finite-difference scheme a factor equal to the
cell volume (area) occupied by the field. Weiland, however, uses only a
simplified version of this method where he distinguishes outer cells
(occupied by metal) and inner cells (completely occupied by field) and sorts
the near-boundary cells by running out a diagonal through a
rectangular cell. Thus, if this diagonal approximates well the inclined
segment of the boundary, only a correction factor of two may appear in
the equations.

The construction of a finite-difference scheme of the second-order
accuracy for the approximation of the boundary conditions for a
boundary contour consisting of second-order curves was completely
automated by Ivanov \cite{49} in an applied program package named MAXWELL-T
For the axially symmetrical case, the boundary conditions have the form
\begin{eqnarray}
(E{r} )A{n+l }_{i-1/2,k} &=& (E_{r} )A{n}_{i-l/2,k} +
\tau \sumU} P{j} (B_{\phi} )^{n+l/2}_{j} , \label{3.37} \\

(E_{z} )A{n+l}_{i,k-l/2} &=& (E_{z} )A{n}_{i,k-1/2} +
\tau \sum _ } P{j} ( B_{\phi} )A{n+1/2}_{j} , \label{3.38}
\end{eqnarray}
where $Pj$ are the difference template coefficients and the whole summation
is carried out by all grid points neighboring the near-boundary
points.

This approach requires preliminarily marking the types of
near-boundary points and storing the $Pj$ coefficient for them.

\section {Library of Classes for Object-Oriented Field Solver Code}

The classes library which reflects the structure of the complete



PIC-code architecture is made up of base classes, visualization classes
interface and contemplation classes. Note should be made that the library
contains different implementations of the same concepts (classes):
vftrix, matr, array, vector, etc. This has been done in order to provide
for a search for the most optimal program implementation both during
the creation stage of certain classes and while developing a method
to approach them.

BASE CLASSES are considered here as class hierarchies describing the
numerical model of a specific task. To new base data types should also
belong data classes (structures) describing common base concepts:
coordinate, axis, vector, etc.

VISUALIZATION CLASSES are required for graphical specification of the
computational region, checking of the correctness of mesh generation and
specification of the boundary conditions of the task, as well as graphical
representation of the results.

INTERFACE CLASSES serve to create an advanced interactive data input
under MS WINDOWS. Application of this approach helps to create a user-friendly
interface. The entire class hierarchy is based on a standard
class TDialog OWL, Borland Library.

COMPUTATIONAL CLASSES are developed to implement various numerical
algorithms useful for solving electrostatic tasks. Thus, the emphasis
in this report is made on developing straightforward method of solving
Poisson equation.

\subsection {Base Classes}

Development of new data types (structures and classes) requires a detailed
description of the inner structure of the abstract class as well as the
interface of interaction of the objects of a given class with other
data types in a specific implementation of numerical algorithms. The process
of writing the base classes is, however, iterational. This is due
to the fact that in object-oriented programming it is difficult to readily
determine the final structure of the new type data and still more difficult
it is to describe all possible methods of the interaction of objects of
a given class with the other program data. Classification of the library
classes used here allows us to separate major (base) data (structure)
with further detailed development of the structure and methods. These
classes form the "lower" level of the library.

\begin {verbatim}
struct:

AXISTRUCT - describes the type of the coordinate axis
for physical values

pixel - determines 2D coordinates on the display
vect - determines the physical value of the 3D coordinate
index - determines the 2D index
para - determines the 2D coordinates (TEMPLATE data type)
point - determines the 2D coordinates
array -

TVector -



W~ell -

TPhPoint -

class:
axis -

TBoundary -

TElectrod -

TAbstrRegion -

TGeom -

TGeomFrameWork -

TAbstrMesh -

TAbstrModel -

TAbstrPhysVal -

TEulerVal -

TLagrangeVal -

THistoricVal -

TGridVal -

TFunctionVal -

TDoubleGridVal -

TBeamVal -

\endlverbatim}

As a result of detailed elaboration of specific conditions of the
numerical model each of the classes enumerated above gives rise to new type
data inheriting both the data structure and the interactive behavior of
the parent classes. These classes fill the upper level of the base classes
describing the numerical model.

The following class hierarchy is used to describe the mesh type of the
computational region :\vspace{ Il2pt}

\noindent
\begin Iminipage} [c] {5true cm}
\unitlength=lmm,
\special (em:linewidth 0.4pt}
\linethickness {0.4pt}
\begin Jpicture} (45.00,32.00)
\put(0.00,24.00) {\framebox(3 5.00,8.00)[] {J I
\put(35.00,28.00){(\line(1,0) { 10.00)
\put(1 0.00,00.00) {\line(0, 1) {24.00)
\put(45.00,00.00){f\line(0, 1){128.00}
\put(l 0.00,0.00) {\line(1,0)(3 5.00} }
\put(l 0.00,8.00) {\line(1,0) {3 5.00} }
\put(1 0.00, 16.00) {\line(l,0) {3 5.00 J}
\put(1 0.00,28.00){I\makebox(0,0)[lc] {\tt axis)}I
\put(1 8.00,20.00) f{\makebox(0,0)[lc] {\tt TGeomAxis}
\put(1 8.00,12.00) {\makebox(0,0)[lc] f\tt TPhysAxis} }
\put(I 8.00,4.00) {\makebox(0,0)[lc] {\tt TTimeAxis}}I
\end{picture}
\end {minipage} \hfill \begin {minipage} [c] {I Otrue cm}
This hierarchy is meant for the introduction into the numerical
model of objects subsequently used as components of physical values. Their
usage will simplify the display of physical values.\end{minipage}\\[2ex]
\begin {minipage} [c] {S0true mm}
\unitlength=lmm



\special jemn:linewidth 0.4pt}
\linethickness {0.4pt}
\begin (picture) (5 0.00,45.00)
\put(0.00,32.00) {\framnebox(40.00,8.00)[cc] {\tt TGeomFrameWork} I
\put(40.00,36.00) f\line(1 ,0) { 1 0)}}
\put( 10.00,00.00) f\line(0, 1) 132.00} }
\put(50.00,00.00) {\line(0, 1)13 6.00)}}
\put(1 0.00,0.00) {\line( 1,0) {40.00} }
\put(1 0.00,8.00){(\line(1,0) {40.00} }
\put(1 0.00, 16.00) {\line( 1,0) {40.00}
\put(1 0.00,24.00) {\line( 1,0) {40.00}
\put(20.00,28.00) {\rnakebox(0,0)[lc] {\tt TGeomXY} }
\put(20.00,20.00) {\makebox(0,0)[lc] {\tt RGeomRZ} I
\put(20.00, 12.00) {\makebox(0,0)[lc] {\tt TGeomRTh} I
\put(20.00,4.00) {\makebox(0,0)[lc] {\tt TGeomX1X2} I
\end~picture}
\end{minipage}\hfill \begin {minipage} [c] 11 Otrue cm)
The name of this group implies that it deals with determination of the
geometry type of a numerical model. These classes should be added by
{\tt TElectrod} and {\tt TGeom} for specification of a random computational
region.
\end Iminipage} \\[2ex]

This hierarchy of classes is used to describe the type of the computational
region:

\noindent
\unitlength~lmm
\special Jemn:linewidth 0.4pt}
\linethickness {0.4pt}
\begin fpicture)}(5 5.00,40.00)
\put(0. 00,24. 00) {\framebox(3 5.00,8.00)[ 11}
\put(3 5.00,28. 00) {\line(1 ,0) { 1 0.00) )
\put(l 0.00, 8. 00) {\line(0, 1){ 116.00) )
\put(45.00,8. 00){f\line(0, 1){(20.00} )
\put(l 0. 00, 16. 00) {\line(1 ,0){135.00} )
\put(I 0. 00, 8. 00){I\line(1,0)13 5. 00} )
\put(45.00, 12. 00) {\line(1 ,0){18.00} }
\put(7.00,28.00) {\makebox(0,0)[1c] {\tt TAbstrRegion} }
\put(1 8.00,0. 00){f\line(0, 1) {8.001})
\put(5 3. 00,0. 00){(\line(0, 1){ 12. 00}}
\put(1 8. 00,0.00) {\line(1,0) {3 5.00} 1
\put(1 6.00,20. 00) {\makebox(0,0) [1c] {\tt TSampleRgn}}
\put( 16.00, 12.00){\makebox(0,0)I[lc] {\tt TRectangleRgn} }
\put(26.00,4.00) {\makebox(0,0)[lc] {\tt TRectRgnRZ} }
\end lpicture}\vspace{I 1 2pt}

Classes hierarchy of the mesh of the computational region is needed to
describe the type of the computational region, the knods template, etc.
The abstract class TAbstrMesh incorporates two other abstract classes.
\newpage
\begin Ifigure* } [t]
\unitlength~lmm



\special {em:linewidth 0.4pt}
\linethickness {0.4pt}
\begin fpicture)}(140.00,60.00)
\put(0.00,42.00) {\framebox(45 .00,8.00)[cc] I
\put(0.00,54.00) f{\framebox(45.00,8.00)[cc]{}}
\put(45.00,58.00){f\line(1,0){f20.00} }
\put(45 .00,46.00) {\line(1 ,0) f{20.00})}
\put(65 .00,46.00) f\line(0, 1) f 1 2.00} }
\put(65.00,52.00) {\line(1 ,0){( 10.00} )
\put(75.00,48.00) {\framebox(45 .00,8.00)[cc] I
\put(1 20.00,52.00) {\line(1 ,0) {I 0.00} 11
\put(90.00,40.00){f\line(0, 1){(8.00} )
\put( 3 0.00,40.00) {\line(0, 1) { 1 2.00})}
\put(90.00,40.00){f\line(1,0){(40.00) }
\put( 3 0.00,44.00){f\line(1,0) { 10.00) 1
\put( 100.00,32.00) f{\line( 1,0) {40.00} }
\put( 100.00,24.00) {\line(1 ,0) {40.00} )
\put( 100.00, 16.00) {\line(0, 1) f{24.00} }
\put(1 40.00, 16.00) {\line(0, 1) {28.00) )
\put(90.00, 16.00) {\line(1 ,0) {50.00} }
\put( 3 0.00, 12.00) {\line(1,0) { 1 0.00) }
\put(90.00,8.00){\lVine(0, 1){f8.00}
\put( 3 0.00,8.00) {\line(0, 1) {8.00}
\put(1 00.00,0.00){f\line(0, 1) {8.00}
\put(1 00.00,0.00) f{\line(1 ,0) { 40.00}
\put(1 40.00,0.00){f\line(0, 1){ 112.00} }
\put(90.00,8.00){f\line(1 ,0){f40.001}}
\put(5.00,5 8.00) {\makebox(0,0)[lc] {\tt TAbstrRegions} I
\put(5.00,46.00) {\makebox(0,0)[lc] {\tt TGeomFrameWork} }
\put(80.00,52.00) {\makebox(0,0)[lc] {\tt TAbstrMesh} I
\put(95.00,44.00) { \makebox(0,0)[lc] {\tt TMesh2D} I
\put( 105.00,3 6.00) {\makebox(0,0)[lc] {\tt TRegularMesh} I
\put(1 05.00,28.00) { \makebox(0,0)[lc] {\tt TCellListMesh} I
\put(1 05.00,20.00) {\makebox(0,0)[lc] {\tt TNonRectMesh} }
\put(95.00,12.00) {\makebox(0,0)[lc] {\tt TMeshlID))}
\put(1 05.00,4.00) { \makebox(0,0)[lc] {\tt TSurfaceMesh}
\endfpicture}
\end{figure* }

Classes describing the numerical model make use of the data of the
computational region, boundary conditions, dimensions and symmetry,
as well as the type of the \linebreak task/problem.

\begin {figure* I [bth]
\unitlength=lmm
\special fem: linewidth 0.4pt}
\linethickness f{0.4pt}
\begin fpicture) (140.00,50.00)
\put(1 00.00,0.00){f\line(0, 1) {8.00)
\put(1 50.00,0.00) {\line(0, 1){I 12.00}}
\put( 3 0.00, 12.00){f\line(1,0) {20.00} }
\put( 100.00,0.00) {\line(1 ,0) {50.00} )
\put(1 05.00,4.00) {\makebox(0,0)[1c] {\tt TElectrostaticModel} I
\put(90.00,8.00){\line(0,1){ 16.00))}



\put(1 30.00,8.0O){\line(0,1I){f20.00))}
\multiput(90.00,8.00)(0,8){ 2} {\line( 1,0)f 40.00} }
\put(120.00,28.00)f\line(1 ,0)f 10.00}))
\put(95.00, 12.00) {\mnakebox(0,0)[lc] {\tt TSimple2DModel} }
\put(95.00,20.00) {\makebox(O,0)[lc] {\tt TPiClassicModel} }
\put(75.00,24.00) {\framebox(45 .00,8.00)[cc] { }
\put(80.00,28.00) {\makebox(0,0)[lc] {\tt TAbstrModel} }
\put(65.00,28.00){\line(1,0){ 10.0O} }
\put(65.00, 10.00){\line(0, 1){36.00} }
\multiput(45 .00,1 0.00)(0, 12) {4} {\line(I1,0){20.00} }
\multiput(0.00,6.00)(0, 12) {4} {\framebox(45 .00,8.00)[ccj {)}
\put(5 .00,46.00) {\makebox(0,0)[lcj {\tt TAbstrRegions} }
\put(5.00,34.00){\makebox(0,0)[lc] {\tt TAbstrProcess} }
\put(5.00,22.00) {\makebox(0,0)Iilc] {\tt TAbstrPhysValJ}}
\put(5.00,10.00){\mnalebox(0,0)[lc]{\tt TGeomFrameWork} }
\end{picture}
\end{figure* }

\subsection{ Visualization Classes}

This part of the library is based on the GUI-interface of the OWL Library
compiled by Borland. The major classes developed to display in the child
windows are based on the abstract class {\tt TBasePlotswin}.

\noindent
\unitlength=lmm
\special {ern:linewidth 0.4pt}
\linethickness f{0.4pt}
\begin {picture) (70.00,45.00)
\put(25.00,0.00){\line(0,1){ 16.00)}}
\put(65.00,0.00){\line(0, l){20.00} }
\multiput(25 .00,0.00)(0,8) {2} {\line(1 ,0) {40.00} }
\put(55 .00,20.00) {\line( 1,0) 1 0.00))}
\put(15.00,16.00){\line(0,1){16.00}}
\put(55 .00,16.00) {\line(0, 1) {20.00} }
\multiput(1 5.00,1 6.00)(0,8) f{2} {\line(1 ,0) f{40.00} }
\put:(40.00,36.00) {\line(1 ,0) { 15 .00})}
\put(0.00,32.00){\framebox(40.00,8.00)[cc] { }
\put(5.00,36.00) {\mnakebox(0,0)[lc] {\tt TBasePlotsWin} }
\put(20.00,28.00) {\makebox(0,0)[lc] {\tt TSurfacePlot} }
\put(20.00,20.00) {\makebox(0,0)[lc] {\tt TLinesPlot} I
\put(30.00, 12.00){f\mnakebox(0,0)[lc] f{\tt TRegionPlot} }
\put(3 0.00,4.00) {\makebox(0,0)[lc] {\tt TPointsPlot}
\end{picture}
%/\end {figure*)}

\subsection{(Dialog Classes}

Dialog classes are necessary to create a friendly environment for the
user working with the software package. In view of the fact that the project
under developments meant for operation under MS WINDOWS we make use of the
OWL Library, v.2 compiled by Borland.

The report contains the child classes from the class {\tt TDialog} OWL



Borland Library. They were developed for input and variation of data required
to initialize new objects. In addition to the input dialog windows the library
contains windows for systems messages and information windows.

{\bf Windows informing of the version and authors of the code)

\begin Ifigure* } [h]
\unitlength= 1 mm.
\special {em:linewidth 0.4pt}
\linethickness {0.4pt}
\begin fpicture) (140.00,20.00)
\put(85.00,0.00){\line(0, 1){8.00})}
\put(1 25.00,0.00) {\line(0, 1){( 12.00} }
\put(85.00,0.00) {\line( 1,0) {40.00)}}
\put(1 15.00, 12.00){\line(1,0){ 10.00} }
\put(0.00,0.00) {\framebox(45.00,8.00)I[cc] {\tt ProjectRCVersion} }
\put(45.00,4.00){\line(1,0){40.00} }
\put(75.00,8.00) {\framebox(40.00, 12.00)[cc] I
\put(90.00,4.00) {\makebox(0,0)[lc] {\tt TAboutVersDlg} }
\put(95.00,15.00){\makebox(0,0)[cb] {\tt OWL-class} }
\put(95 .00,13.00) {\makebox(0,0)[ct] {\tt TDialog} }
\endfpicture}
\end{figure* }

The dialog window ({\tt ThIfoDigi }) and the data structure ({\tt TlnfoTrsl })
are to output information data on reserves of the computer, on computational
model, etc. through the window of the class {\tt TlnfoDlg I):

\begin (figure*)} [h]
\unitlength= 1mm
\special Jem: linewidth 0.4pt}
\linethickness {0.4pt}
\begin {picture) (140.00,20.00)
\put(85.00,0.00){J\line(0, 1) {8.001 }
\put(1 25.00,0.00){J\line(0, 1) { 12.00) }
\put(85.00,0.00){I\line(1,0){140.00} }
\put(1 15.00,12.00){f\line(1,0) {10.00)}
\put(0. 00, 0. 00) {\framebox(4 5.00,8. 00) [cc] {\tt TlnfoTrs 1 I
\put(45.00,4. 00){I\line(1 ,0){140. 00} 1}
\put(75 .00,8. 00) {\framebox(40.00,1I2. 00) [cc]{}}
\put(90.00,4.00) {\makebox(0,0)[lc] {\tt TlnfoDIgi I I}
\put(95 .00,15. 00) {\makebox(0,0) [cb] {\tt OWL-class)
\put(95.00, 13 .00){\inakebox(0,0)[ct] {\tt TDialog} }
\endlpicture}
\endffigure* }

The dialog window ({\tt TRegionBndsDlg}) and the data structure
({\tt TRegionBndsTrsl}) are to input data into the class {\tt TAbstrRegion}
and its child classes:

\noindent
\unitlength= 1mm
\special fem: linewidth 0.4pt}
\linethickness {0.4pt}



\begin {picture) (140.00,25.00)
\put(85.00,0.00) {\line(0, 1)18.00}))
\put(125.00,0.00){\line(0, I){ 112.00} }
\put(85.00,0.00) {\line(1 ,0) {40.00} }
\put(1 15.00,12.00){\line(1,0){10.00}}
\put(0.00,0.00) {\framebox(45.00,8.00)[cc] {\tt TRegionBndsTrs 1 }
\put(45 .00,4.00) {\line(1 ,0) {40.00} }
\put(75 .00,8.00) {\framebox(40.00, 12.00)[cc] {J)
\put(90.00,4.00){\makebox(0,0)[lc] {\tt TRegionBndsDlg} I
\put(95.00, 15.00) {\mnakebox(0,0)[cb] {\tt OWL-class} }
\put(95.00, 13 .00){\makebox(0,0)[ct] {\tt TDialog} I
\end{picture}
%/\end {figure* I

{\bf A service class to check the input information in the dialog window} \linebreak
({\tt TRegionBndsDlg})

\noindent
\unitlength= 1mm
\special Jem:linewidth 0.4pt}
\linethickness {0.4pt}
\begin {picture) (140.00,24.00)
\put(1 0.00,0.00) {\line(0, 1) f 8.00) }
\put(60.00,0.00) {\line(0, 1) 12.00} }
\put(1 0.00,0.00) {\line( 1,0) {50.00} }
\put(50.00,12.00){\line(l,0){ 10.00}))
\put(0.00,8.00){\framebox(50.00, 12.00)[cc] { }}
\put( 15.00,4.00) {\makebox(0,0)[1lc] \tt TAboutVersDlg} }
\put(20.00, 15 .00){\makebox(0,0)[cb] {\tt OWL-class} }
\put(20.00, 13.00) {\makebox(0,0)[ct] {\tt TFilterValidator)}}
\end{picture}
%/\end~figure}

\subsection {Computing Classes)

Due to the fact that during the project implementation various
numerical algorithms are used to compute the same physical values and also to
reach the main target of the project -- REUSABILITY -- we attempted to
separate computational classes from base classes. Development of the class
hierarchy with inheritance is feasible only for families of certain numerical
algorithms having similar structure and identical sets of input and output
parameters. In this case the base class is used for late binding and
replacement of the numerical algorithms on the run. The library contains only
one computational class ({\tt TPoisson}) which is a prototype of the approach
described.

The service class providing links between the computational module and
the object-oriented base classes is to be made up by the classes-descendants
{\tt TAbstrProcess}.

\begin {verbatim)
TAbstrProcess
TDetermPrcs



TMomentPrcs
TStaticPrcs - TElectrostaticPrcs
TDynamicPrcs
THistoricPrcs

\end{verbatim}

However, simple and laconic algorythms can be fully encapsulated into
respective classes of our main structure, e. g. the FFT algorithm can be
implemented both in a member-function of the class {\tt TGridVal: Spectrum} (),
and in a member-function of the class {\tt THarmonic Process::Spectrum (TPhysVal*)}.

\section{PiCsim3 code for Computation of Poisson Equation}
\subsection{Goal of Program}

To carry out testing of the library of 00 classes we developed the PiCsim3
code based on the 00-PIC classes hierarchy. This software furnishes an
illustration of interactions between the classes developed. Using the
calculations of the test problems of the solution of Poisson equation as an
example it was shown that the version developed is capable of doing
computations of the problems in simple geometries.

The software is run under Windows 3.1 and Win32, therefore the diskette
has both projects for the Compiler Borland C++ v.4.5 (ps3$_-$work.ide
and ps$_-$32.ide). In the 32-register version there should be determined the
global variable $_-$WIN$_-$32$--$ to inhibit usage of the functions of the
Toolhelp library, such as SysMemorylnfo (), Heaplnfo (), GlobalCompact (.

The software program satisfies the requirements set for the codes with
user-friendly graphical interfaces. This program makes use of the standard
Windows MDI implemented as the Borland's OWL.

Correct performance of the program is possible provided it is run on

the 486DX computers with 8MB on-line memory.

\subsection {Installation of Program onto Hard Disk}

To ensure successful installation of the software product onto your
hard disk the latter has to possess no less than 15 MB free space. In view of
the fact that the version provided is of a de-bug character we chose not to
develop the installation program unrolling the code of fields computation.
We applied a simple way of transportation of the self-unpacking archives of
the source modules of 00-PIC library of PiCsim3 and projects for the compiler
Borland C++ v.4.5.

To port the program onto your hard disk is easy. You are to open a PICSIM
catalogue on a disk with no less than 10 MB free space, e.g.:

\begin{verbatim}
C:\>MD PICSIM

\end{verbatim}

Then insert the work diskette into the disk drive and copy the self-unpacking
archives with the program into the catalogue C: {$\backslash$}PICSIM

L-



\begin{verbatim}
C:\>A:
A:\COPY PICSIMA.EXE C:\PICSIM\PICSIMA.EXE

\end{verbatim}

Upon transporting the archives on the disk of your computer take the diskette
out. The next preparation step is to unpack the archive file. To do so the
user is to transfer to the work disk in the catalogue PICSIM using the command

\begin{verbatim}
A:\>C
C:\>CD PICSIM
C:\PICSIM\>

\end{verbatim}

Then print in the command line the command

\begin{verbatim}
C:\PICSIM\>PICSIMA.EXE

\end{verbatim}

Upon completing the archives unpacking your disk should display the directory
tree:

\begin{verbatim}
C:\

--------.PICSIM\
-------- INC
--------.OBJ
--------.EXE
I....-~HLP
-------- CPP

I---------BASE
---------. INTERFACE
I---------MAIN
I---------PLOTS
---------.SERVICE

\end{verbatim}

It is essential to make sure that all the files necessary for successful
compilation of the program PiCsim3 have been duly unpacked. Check the file
lists using the work subdirectiries against the lists cited in the report.

When unpacking has been finished you may delete the archive file from
the hard disk, as its duplicate is on the work disk now.

\subsection{Working with Program}

The program should be started from 00 WINDOWS, e.g. using the command:

\begin{verbatim}
C:\PICSIM\EXE\>WIN PICSIM3.EXE

\end{verbatim}



Your computer will display the main window of the program. Due to
implementation of the MDI interface the main function creates the object of
the {\tt TPICsimApp} class inheriting all the properties from the class
{\tt Tapplication} of the class library OWL which calls the Run ( ) method.
The class {\tt TPiCsimApp} initializes the main window of the program and, in
accordance with the rules of building the MDI interface, these are two
objects:

\begin{ verbatim}
TPiCsimFrameWin - inheriting from clan TDecoratedFrame
TPiCsimClientWin - inheriting from clan TMDIClient

\end{verbatim}

In initializing the object of the class {\tt TPiCsimFrameWin} (SetupWindow
()) there creates a window for problems and other managing elements of the
window. Additionally the object checks the sequence of messages under Windows
and calls Winhelp by pressing the Fl key, and when the message under WM$_-$NEWMODEL
and WM$_-$CLOSEMODEL are input it changes the manner of operation with the
computation model. This approach allows the user to change the main
problem window at run time (menu, ControlBar, StatusBar, ...). For this
purpose in the message processor under OCWindows use is made of the client
substitution technique enabling, by simple means, addition of new models with
their own user-friendly interfaces. A necessary condition for this approach
is the inheritance of the model class from the class {\tt TPiCsimClientWin}.

Thus, in starting the program the computer displays the main window with the
menu, status-line and control panel. This window is generated for the user to
select the computation model. During implementation of the test program we
used, as an example, the electrostatic model. Having selected pictogram $<\phi>$
you initialize the electrostatic model under your own window tuned to operate
with this model type. The main window, in addition to the $<\phi>$ pictogram,
has the $<?>$ pictogram which generates the message Windows and the F1 key
which calls Winhelp. The $<\rm C>$ pictogram displays the information window
ABOUT, and pressing the pictogram $<\rm Q>$ causes quitting of the program.

Having selected the electrostatic model, the program replaces the main window
of the problem with its own menu by the control panel and status-line. As
shown by experience of working with software complexes under Windows the
simplest method of running the program is to use pictograms from the control
panel. Therefore, developing the working scenario we paid a lot of attention
to underlining the basic action of the control panel pictograms

\begin {tabular} {ccl}
$<{\rm N}>$ & -- & opening new model\\
$<{\rn O}>$ & -- & opening model stored on disk\\
$<I\rm S}>$ & -- & saving working model\\
$<{\rm R}>$ & -- & starting computation of potential\\
$<{\rm St}>$ & -- & computing electrostatic fields\\
$<{\rm Nx}>$ & -- & next computation step\\
$<{\rm T}>$ & -- & opening graphics window with the results of potential $\phi$(r,z)\\

& & displayed as surface\\
$<{\rm G}>$ & -- & opening graphics window with display of isolines of equal \\

& & electric field strength\\
$<{\rm E}>$ & -- & exit into main window of program selecting model type.



\end{tabular}

\subsection{Test Results}

The program allows test runs based on computation of the electric field
potential and strength at a given distribution of the charge density under
boundary conditions. Correctness of operation of the program was determined by
comparing the initial charge distribution with the distribution of the charge
density reconstructed from the calculated distribution of the electric field
strength. The results we obtained in these tests were generelly good, since
the error of the reconstructed charge density was of the order ($hA2$),
which corresponds to the accuracy of the algorithm used.

Additionally, calculations by our program were compared with the data
obtained by other authors \cite{66, 67}.

\subsubsection{Test Tasks}
Numerical model for the test tasks are formulated in 3 files: "testl.mod",
"test2.mod" and "test3.mod". To load the test task into the program and
carry out the computation it is necessary to do the following:
\defdlabelitemi{--}
\begin{itemize}
\item put the program on the run and select an electrostatic version of the
task;

\item open the model by pushing the button $<{\rm O}>$;
\item choose the file "test.mod", N 1, 2, 3;
\item push the button $<{\rm R}>$ and solve the Poisson equation for the
given conditions; and
\item visualize the windows with graphics information on distridution of the
charge density, the electric field potential and strength, having selected in

the menu the items = Plots/2d Plots/Space Charge (Potential or Restore
Source).
\end{itemize}
The program has the following options for controlling the graphics windows:
\begin{itemize}
\item scaling of the graphics information in the window and its frames;
\item addition of standard objects (text, boundary, of the calculation region and
calculation mesh, symmetry axes, ...) to the information;
\item withdrawal of the above objects from the window and their subsequent
editing;

\item while selecting -edit" for the main physical value visualized
graphically in the window the screen displays the dialog window within which
one can define orientation of the surface with respect to the look-up plane,
etc.
\end{itemize}

\subsubsection{Test run 1 }

The most completely studied charge distribution was that of a single
uniform sphere of charge. The data for the first run is set-up by the
file "testl.mod" and correspond to the data for the test run 1 reported in
\cite{66}.



\begin {figure} [h]
\centering
\unitlength=0.24pt
\begin {picture} (1298,1003)
\put(O, 1003) {\special { em:graph testO 1 .pcx}}
\end{picture}
\caption{ }
\end{figure}

Figure 2 shows the input charge distribution and the calculated fields
and associated errors. The calculation by our program agree well with
the data obtained by Beard and Hockney using the POT 4A program \cite {66}.

\subsubsection{Test run 2}

In a more stringent test, we checked the accuracy of the program
using an input charge density consisting of two equally but oppositely
charged spheres of equal radii. The data for this run is set-up by the
file "test2.mod" and corresponds to the data for the test run 2 from Ref.
\cite{66}.

\begin {figure} [t]
\centering
\unitlength=0.24pt
\begin {picture} (1298,1003)
\put(O, 1003) {\special {em:graph test02.pcx} }
\end{picture}
\caption{}
\end{figure}

These results are shown in Fig. 3. They agree well with the results
obtained using the POT 4A program \cite {66}.

\subsubsection{Test run 3 }

When using the test deck to verify our program the test deck will
generate a potential distribution and obtain the source function from
this potential. The potential is stored to provide a check on the
accuracy of the solution. The generated potential can be an analytic
function of $x$ and $y$ and is set-up by the file "test3.mod." as
\begin{equation}
\phi(x,y)=X(x)Y(y).
\end{equation}
The form for the analytic depends on the boundary conditions is
\[ X(x)=\left\{\begin {array} {11} \sin\Big(\displaystyle\frac{3\pi x}
{N\Delta x}\Big) & \rm for- MBCX = 1,\\
\cos\Big(\displaystyle\frac {4\pi x} {N\Delta x}\Big) &
\rm for- MBCX = 2,\end{array}\right. \]
\[ Y(y)=\left\{\begin{array} {11} \sin\Big(\displaystyle\frac{3\pi y}
{N\Delta y}\Big) & \rm for- MBCY = 1,\\
\cos\Big(\displaystyle\frac{4\pi y} {N\Delta y}\Big) &
\rm for- MBCY = 2.\end{array})right. \]

\newpage
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In the previous report we presented a general scheme of relations
architecture of the base classes, which, upper levels, is capable of
including various particles models. While developing the 00-model archi-
tecture we made account of the necessity to create methods of the object
classes interaction not only inside the functional model but also that
between the computation and GUI-classes. The present report views
classes allowing us to create a model with a GUI interface operating
under MS WINDOWS.

The classes library which reflects the structure of the complete
PIC-code architecture is made up of base classes, visualization classes
interface and contemplation classes. Note should be made that the library
contains different implementations of the same concepts (classes):

vftrix, matr, array, vector, etc. This has been done in order to provide
for the search for the most optimal program implementation both during
the creation stage of certain classes and while developing a method
to approach them.

BASE CLASSES are considered here as class hierarchies describing the
numerical model of a specific task. To new base data types should also
belong data classes (structures) describing common base concepts:
coordinate, axis, vector, etc.

VISUALIZATION CLASSES are required for graphical specification of the
computational region, checking of the correctness of mesh generation and
specification of the boundary conditions of the task, as well as graphical
representation of the results.

INTERFACE CLASSES serve to create an advanced interactive data input
under MS WINDOWS. Application of this approach helps to create a user-
friendly interface. The entirely class hierarchy is based on a standard
class TDialog OWL,Borland Library.

COMPUTATIONAL CLASSES are developed to implement various numerical
algorythms useful for solving electrostatic tasks. Thus, the emphasis
in this report is made on developing straightforward method of solving
Poisson equation.

1. BASE CLASSES



Development of new data types (structures and classes) requires a de-
tailed description of the inner structure of the abstract class as well
as the interface of interaction of the objects of a given class with other
data types in a specific implementation of numerical algorithms. The pro-
cess of writing the base classes is , however, iterational. This is due
to the fact that in object- oriented programming it is difficult to readily
determine the final structure of the new type data and still more difficult
it is to describe all possible methods of the interaction of objects of
a given class with the other program data. Classification of the library
classes used here allows us to separate major (base) data (structure)
with further detailed development of the structure and methods. These
classes form the "lower" level of the library.

stuct:
AXISTRUCT - describes the type of the coordinate axis for

physical values
pixel - determines the 2D coordinates on the display
vect - determines the physical value of the 3D coordinate
index - determines the 2D index
para - determines the 2D coordinates (TEMPLATE data type)
point - determines the 2D coordinates
TPhPoint - determines the physical value of the 2D coordinate
TCell - determines the 2D coordinates on the mesh
array - determines the array physical values
TVector - determines the array physical values

classes
axis
TBoundary
TElectrod
TAbstrRegion
TGeom
TGeomFrameWork
TAbstrMesh
TAbstrModel

TabstrPhysVal
TEulerVal
TLagrangeVal
THistoricVal
TGridVal
TFunctionVal
TDoubleGridVal
TBeamVal

As a result of detailed elaboration of specific conditions of the nume-
rical model each of the classes enumerated above gives rise to new type
data inheriting both the data structure and the interactive behavior of
the parent classes. These classes fill the upper level of the base classes
describing a particular

UAAAAAAAAAAAAAL,
I axis AAA•A
AA .AAAAAAAAAAP 3

-Ad



3 TGeomAxis 3

AAAAAAAAAAAAA'
3 TPhysAxis 3

AAAAAAAAAAAAA"
3 TTimeAxis 3

AAAAAAAAAAAAAA.(
This hierarchy is meant for the introduction into the numerical model

of objects subsequently used as components of physical values. Their
usage will simplify the display of physical values.

PAAAAAAAAAAAAA
3TGeomFrameWorkAAAA,

AAAAAAAAAAAAAAAf'3
3 TGeomXY 3

AAAAAAAAAAAAAAA"
3 TGeomRZ 3

AAAAAAAAAAAANAA.
3 TGeomRTh 3

AAAAA•AAAAAAAA.
STGeomXlX2 3

AAAAAAAAAAAAAAAt
The name of this group implies that it deals with determination of the

geometry type of a numerical model. These classes should be added by
TElectrod and TGeom for specification of a random computational region.

The following class hierarchy is used to describe the mesh type of the
computational region.

(AAAAAAAAAA.Ak
3TAbstrRegion AAAAj,
AAAAAAAAAAAAAA3

3TSampleRgn 3

AAAAAlAAAAAA"k'
3TRectangleRgnAAAL

AAAAAAAAAAAAAA.IU
3TRectRgnRZ 3

AAAAAAAAAAAAAAPý

Classes hierarchy of the mesh of the computational region is needed to
describe the type of the computational region, the knods template, etc.
The abstract class TAbstrMesh incorporates two other abstract classes.

fiAAAAAAAAAAAAAAA.Ak
3 TAbstrRegions AAAAA...... O.AA.AAA
AAAAAAAAAAAAAAAAAAP AAAA.A" TAbstrMesh ,AAA
OAAAAAAAAAAAAAAAA, A3 AA AAAAAAAAAf 3
3 TGeomFrameWork AAAAAAAAAAU 3TMesh2D AAAAL,
AAAAAAAAAAAA AAAA. AAAAAAAAAO

3TRegularMesh 3

AAAAAAA.AAAAAAAA'
3TCellsListMesh3

AAAAAAAAAAAAA.
3TNonRectMesh 3



OAAAAAAAAAAAAAAAAAfP
3 TMeshlD AAAA 1,
kAAA&AAAAA.AAAAAA.3

3 TSurfaceMesh3
AAAAAkAAAAAAAAAAPJ

Classes describing the numerical model make use of the data of the com-
putational region, boundary conditions, dimensions and symmetry, as well as
the type of the task.

OIAAAA.AAAAAAAAAAAAA 1,
3 TAbstrRegion AAAAAAAAXAA,
AAAAAAAAAAAAAAAkAfj 3

3TAbstrProcess AAAAAAAAAA' (IAAAAAAAAAAAAA
AAAAAAAAAAAAAWAA.AA AAAAA.TAbstrModel AAAAL
I3AAAAAAAAAAAAAAAAkL AAA3AAAAA
3 TAbstrPhysVal AK&AAAAAAAK 3 TPiClasicModel3

AAAA.AAAAAAAAiJAAAAAA.A AAA.AA
OA WAAAA AA L 3 3TSimple2DModelAAAAAAAA

3 TGeomFrameWork ALAAAAAAXAI 3 J~
AAAAAAAAAAAAAAAAAA. 3 TElectrostaticModel 3

AAAAXAAAAAAAAAAAAAAAAP

1* ObjectOriented PIC for C++
1* ~Version 1.00 *

/* Copyright (c) 1993, 1994 The Group Compuetr Simulation *
1*High Current Electronics Institute *
1*Contract SPC93-4035(F6 170893 W0612)

1* ~Last write 10-20-94 ~

/*PSARRAYRH~~
#i! defined QPS_ARRAY H)
#defme _PSARRAYH

#include "ps~defs.h"

void msg (int a, int t, int i, hit n);

static mnt gc =0;

static hit gca =0;

static int mgc; = 0;

---- ---- ---- ---- ---- array

class array

protected:
num* e;



int step;
int N;
int iO;
int own;
int typ;

static int cont;
int id;
int cling;
int tmp;

public:
array 0 : iO (0), N (0), typ(0), chng (0),tmp (0), own (0), step (1)

{ id=++cont; gca++; gc++; msg (1,typ,id,own); };
array (int Size, int Tmp=0) : i0 (0), typ(l), chng (0),tmp (Tmp), step (1)

{ e = new num [N=Size+l]; gca++; gc++; own =N; id = ++cont; msg (1,typ,id,own); };
array (int Org, int End, int Tmp) : iO (Org), typ(2), chng (0),tmp (Tmp), step (1)

{ e = new num [N=End-Org+l]; gca++; gc++; own = N; id= ++cont; msg (i,typ,id,own); };
array (const array& v, int Tmp=0);
array (num* d, int Size, int Step=l, int Tmp=O) : iO (0), typ(4), chng (0), tmp (Tmp), step (Step)

{ e = d; N = Size; own = 0; gca++; gc++; id= ++cont; msg (i,typ,id,own); };
-array 0 { gca--; gc--; N = 0; if (own) delete [] e; e = 0; msg (-1,typ,id,own); };
int alloc (int Size) { if (own) return 0; e = new num [N=Size+1]; return own = N; };
void assign (num* p) { e = p; };

num& operator [] (int i) { return *(e+(i-iO)* step); };
array& operator = (const array& v);
array& operator = (num a);
array& operator += (const array& v);
array& operator *= (num a);

friend array operator + (array& vl, array& v2);
friend array operator * (num a, array& v);

void add (array& vI, array& v2, num a = 1.0);
void add (array& vl, array& v2, array& v3, num a = 1.0);
int size 0 { return N-i; };

/*- - --- -matrix

class matrix
{
public:

num * data;
public:

int Ni;
int Nj;

indx NN;
int typ;

static int cont;
int id;
int own;
int cling;
int tmp;

matrix 0 : Ni(0), Nj(0), typ(O), chng(0), tmp(O), own(0)
{ mgc++; gc++; id= ++cont; msg (2,typ,id,own); };

matrix (int N, int M, int Tmp = 0);
matrix (int N);
matrix (const matrix& a, int Tmp = 0);
matrix (num * d, int N1, int N2, int Tmp = 0);



-matrix o t (
array & operator [] (int i);
array & operator 0(int j);

num & operator 0 (int i, intj) { return *(data + i*Nj +j); };
matrix & operator = (const matrix& a);
matrix & operator = (num a);
matrix & operator += (const matrix& a);
matrix & operator *= (num a);

friend matrix operator + (matrix& al, matrix& a2);
friend matrix operator * (num x, matrix& a);

void assign (num* p) { data = (typ==4)? p : 0; }; HI!
num & elem (int i, intj) { return *(data + i*Nj +j); };
array row (mit i) { return array ((data+i*Nj), Nj); };
array col (intj);
void assign (int i, intj, num x) { *(data + i*Nj +j) = x; };

•/******************************************************************* end *!

#endif

#include <mem.h>

void msg (int a, int t, int i, int n)
{
}
/* array */
int array :: cont = 0;

array :: array (const array& v, int Tmp)
{

N = v.N; iO = v.iO; gc++; gca++;
e = new num [N];

typ = 3; chng =0; own = N; tmp = Tmp; id=++cont; step = v.step;
for (int i=0; i<N; i++) e[i]= v.e[i];

msg (1,typ,id,own);
}

array& array :: operator = (const array& v)

if ((step == 1) && (v.step == 1))
memcpy ((void*)e, (void*)v.e, N*sizeof(num));

else
for (int i=0; i<N; i++) *(e + i*step) = *(v.e + i*v.step);

return (*this);
}

array& array :: operator = (num a)
{
for (int i=0; i<N; i++) *(e + i*step) = a;

return (*this);
}

array& array :: operator += (const array& v)

for (int i=O; i<N; i++) *(e + i*step) += *(v.e + i*v.step);



return (*this);

array& array:: operator *= (num a)
{
for (int i=O; i<N; i++) *(e + i*step) *= a;

return (*this);

void array:: add (array& v1, array& v2, num a)
{
for (int i=O; i<N; i++)

*(e + i*step) = *(vl.e + i*vl.step) + a*(*(v2.e + i*v2.step));
}

void array :: add (array& vi, array& v2, array& v3, num a)
{
for (int i=O; i<N; i++)
*(e + i*step) = *(vl.e + i*vl.step) + *(v2.e + i*v2.step) + a*(*(v3.e + i*v3.step));

I;

/ ........ friends ........................................

array operator + (array& vI, array& v2)

{
array res (vl.N-1);

for (int i=O; i < res.N; i++)
*(res.e + i) = *(vl.e + i*vl.step) + *(v2.e + i*v2.step);

return (res);
I;

array operator *(num a, array& v)
{
array res (v.N-1);
for (int i=O; i<res.N; i++)

*(res.e + i) = a*(*(v.e + i*v.step));
return (res);

I;
------------------------ num* data;

int matrix :: cont = 0;

matrix:: matrix (int N, int M, int Tmp)
{ gc++; mgc++;
Ni=N+I; Nj =M+I; NN =Nj*Ni; data=newnum [NN];

typ = 1; chng = 0; own = NN; tmp = Tmp; id=++cont;
memset ((void*)data, 0, NN*sizeof(num));

msg (2,typ,id,own);
}

matrix:: matrix (int N)
{ gc++; mgc++;
Ni = N+1; Nj = N+1; NN = Nj*Ni; data = new num [NN];

typ = 2; chng = 0; own = NN; tmp = 0; id-=++cont;
memset ((void*)data, 0, NN*sizeof(num));



msg (2,typ,id,own);

matrix :: matrix (const matrix& a, hit Tmp)
{ gc++; mgc++;

Ni = a.Ni; Nj =a.Nj; NN =Nj*Ni; data = new num [NN];
typ = 3; chng = 0; own = NN; tmnp = Tmp; id=++cont;

memcpy ((void*)data, (void*)a.data, NN*sjzeof(num));
msg (2,typ,id,own);

matrix: matrix (num * d, mnt Ni1, int N2, hit Tmp)
f
Ni =Nl1; Nj =N2; NN =Nj *Ni; data =d; gc++; mgc++;
typ = 4; chng = 0; own = 0; tmp = Tmp; id=++cont;

msg (2,typ,id,own);
I

matrix :: -matrix0
I gc--; mgc--;
if (own) delete [] data;

data =0; Ni =0; Nj=0
msg (-2,typ,id,own);

matrix& matrix :: operator = (const matrix& a)

memcpy ((void*)data, (void*)a.data, NN*sizeof(num));
return (*this);

matrix& matrix:: operator = (num a)

for (indx i=0; i<NN; i++) *(data+i) = a;
return (*this);

array & matrix :: operator [(int i)
f

return (*new array ((data+i*Nj), Nj, 1, 1));

array & matrix:: operator 0(int j)

return (*new array ((data+j), Ni, Nj, 1));

matrix& matrix :: operator += (const matrix& a)

for (hidx i=0; i < NN; i++) *(data+i) -f= *(a~data+i);
return (*this);

matrix& matrix :: operator "'= (num a)



{
for (indx i=0; i<NN; i++) *(data+i) *= a;

return (*this);
}

array matrix :: col (intj)
{

array res (Ni);
for (int i=0; i<Ni; i++) res[i] = *(data + i*Nj +j);

return res;
}

//- ........ friends ..........................

matrix operator + (matrix& al, matrix& a2)
{
matrix res (al.Ni-1, al.Nj-1);

for (indx i=0; i < al.NN; i++)
res.data[i] = *(al.data+i) + a2.data[i];

return (res);
}

matrix operator * (num x, matrix& a)
{
matrix res (a.Ni-1, a.Nj-1);

for (indx i=0; i < a.NN; i++)
res.data[i] = x*(a.data[i]);

return (res);
};
//- .......................................................... end.

/*** PS AXIS.H ***/
#if !defined ( PS AXISH)
#define PS AXIS H

#include "psdefs.h"

/. ............................................................

#def'me NBoundaryTypes 7

enum TBoundaryType
{
ConductingBnd = 0,
OpenBnd,
AxisymmetricBnd,
PeriodicBnd,
DielectricBnd,
MirrorsymmetricBnd,
IntemalBnd,
InterRegionsBnd

};
/ .............................................................

#define NAxeTypes 8

I



enum TAxeType

XAxe = 0,
YAxe,
RAxe,
ZAxe,
ThAxe,
xlAxe,
x2Axe,
FiAxe,
tAxe

------------------------------------------------
#define NUnitsTypes 10

enum TUnitsType

arbitrUnits =0,

mUnits,
cmUnits,
mmUnits,
inchUnits,
radUnits,
dgrUnits,
secUnits,
nsUnits,
msUnits,
mcsUnits

-------------- ---- --- axis
class axis

public:
char name [LNGH -NAME];
char units [LNGH UNITS];
hit id;
num org, end;
num step, scale;
int N;
hit uid;
hit OwnDraw;
hit OwnEdit;

axis() id (0), uid (0),N (1)
{org=0.0; end=1 .0; scale=1 .0; step=l .0; OwnDraw=OwnEdit=0; }

axis (char*, num, num=0.0 );
axis ( const mnt at, const num xlI, const num x2,

const hit n, const mnt unts = 0)
axis (const hit at, const num xlI, const num x2,

hit n, char * untstr)
axis (const axis& a)

void Normalyze ()



void ScaleTo ( const axis& x);
void Transform ( const axis& x, num(*F)(num));

virtual void Draw (num Angle)
virtual void Edit ()

num operator () (num i) { return org+i*step; };
protected:

void axname ( int nd);
void axunits ( int ud);

/*== - - - - - -TGeomAxis
class TGeomAxis : public axis
{
public:

TBoundaryType boundl, bound2;
public:

TGeomAxis 0 : axis 0 { };
TGeomAxis ( const TGeomAxis& A);
TGeomAxis ( int at, num xl, num x2,

int bndl, int bnd2, int n, int unts = 0);

/*- - - - - -TPhysAxis
class TPhysAxis : public axis
{
public:

TPhysAxis () : axis 0 { };

/*- - - - - - - TTimeAxis
class TTimeAxis : public axis
{
public:

TTimeAxis (): axis 0 { };

#endif

/*** PS AXIS.CPP ***I
#include <string.h>
#include "psaxis.h"

/* axis */

axis :: axis (char* Nam, num En, num Or)
{
id = 0; org = Or; end = En; uid = 0; N = 1;

axunits ( uid);
strcpy (name, Nam);

step = (end > org)? ((end-org)/N) : -1.0;
scale = 1.0 / step;
OwnDraw = OwnEdit = 0;

axis :: axis (const axis& a)
{



id = a.id; org = a.org; end = a.end; uid = a.uid;
N = a.N; step = a.step; scale = a.scale;

strcpy (name, a.name);
strcpy (units, a.units);

OwnDraw = OwnEdit = 0;

axis :: axis ( const int at, const num xl, const num x2,
const int n, const int unts)

{
id = at; org = xI; end = x2; N =n; uid = unts;

axname ( at); axunits ( uid);
step = (end > org)? ((end-org)/N) : -1.0;
scale = 1.0 / step;

OwnDraw = OwnEdit = 0;

axis :: axis ( const int at, const num xl, const num x2,
int n, char* untstr)

{
id = at; org = xl; end = x2; N =n;

axname (at);
strcpy (units, untstr); uid = -1;

if (stricmp (units, "arbitr")) uid = 0;
if (stricmp (units, "m")) uid = 2;
if (stricmp (units, "cm")) uid = 3;
if (stricmp (units, "mm")) uid = 4;
if (stricmp (units, "inchs")) uid = 5;
if (stricmp (units, "degrees")) uid = 6;
if (stricmp (units, "sec")) uid = 7;
if (stricmp (units, "ns")) uid = 8;
if (stricmp (units, "ins")) uid = 9;
if(stricmp (units, "mcs")) uid = 10;

step = (end > org)? ((end-org)/N) : -1.0;
scale = 1.0 / step;
OwnDraw = OwnEdit = 0;

void axis :: axname ( int nd)
{

switch (nd)
{ case 0: strcpy (name, "X"); break;
case 1: strcpy (name, "Y"); break;
case 2: strcpy (name, "R"); break;
case 3: strcpy (name, "Z"); break;
case 4: strcpy (name, "Th"); break;
case 5: strcpy (name, "XI"); break;
case 6: strcpy (name, "X2"); break;
case 7: strcpy (name, "Fi"); break;
case 8: strcpy (name, "t"); break;
default: break;



void axis :: axunits (mt ud)

switch ( ud)
{case 0: strcpy (units, "arbitr"); break;
case 1: strcpy (units, "in"); break;
case 2: strcpy (units, "1cm"); break;
case 3: strcpy (units, "mm"t); break;
case 4: strcpy (units, "inchs"); break;
case 5: strcpy (units, "rad"); break;
case 6: strcpy (units, "degrees"); break;
case 7: strcpy (units, "isec"); break;
case 8: strcpy (units, tins"); break;
case 9: strcpy (units, "ins"1); break;

case 10: strcpy (units, "mcs"); break;
default: break;

void axis :: Normalyze0

void axis:: ScaleTo (const axis& x)

void axis :: Transform (const axis& x, num(Ff)(num))

-------------------------------------------------
TGeomAxis :: TGeomAxis (const TGeomAxis & A)

axis (A.id, A.org, A.end, A.N, Axuid)

bon{ Abud1
boundi = A.boundl;,

TGeomAxis :: TGeomAxis ( int at, num xl1, num x2,
int bndlI, int bnd2, hit n, hit unts)

axis ( at, xlI, x2, n, unts)

bon{ ~udr~p n
bound 1 = TBoundaryType ( bnd 1)

H ---------------------------------------------- end.

/**PSGEOM.H **

#if! defmed QPS_GEOMH)
#defme _PSGEOMH

#include "ps~defs.h"

template <class tip> struct para.



tip xl;
tip x2;

para( {xl= 0; x2= 0;};
para (para& p) { xl=p.xl; x2 = p.x2;};
para(tipal, tipa2) {xl =al; x2=a2; };

para operator = (para a) { xl = a.xl; x2 = a.x2; return (*this); };
para operator 0 (tip al, tip a2) { xl = al; x2 = a2; return (*this); };

friend int operator == (para p 1, para p2)
{ return ((pl.xl==p2.xl)&&(pl.x2==p2.x2)) ? 1 : 0; };

struct point
{

num xl;
num x2;

point () { xl = 0.0; x2 = 0.0; };
point (point& p) { xl = p.xl; x2 = p.x2; };
point (num al, num a2) {xl=al; x2=a2; };

point operator = (point a) { xl = a.xl; x2 = a.x2; return (*this); };
point operator 0 (num al, num a2) { xl = al; x2 = a2; return (*this); };

friend int operator == (point pl, point p2)
{ return ((pl.xl==p2.xl)&&(pl.x2==p2.x2)) ? 1: 0; };

struct pixel { int h; int v;};
struct vect {num xl; num x2; num x3; };
struct index { int il; int i2; };

struct AXISTRUCT
{

char axtype;
char * axname;
char * units;
char * lobound;
char * upbound;
char * bndtype;

/**** TGeomFrameWork /-------------------

class TGeomFrameWork
{
public:

static int geomrassigned;
int geom;

protected:
num hI, h2; H Space steps for xl, x2
num asph, asph2; //hlih2 & its square
int NI, N2; //Dimensions
int equih; //=0, if hl,h2 - const(xl,x2)

public:
TGeomFrameWork ();

virtual void xl (AXISTRUCT& axe) = 0;
virtual void x2 (AXISTRUCT& axe) = 0;
virtual num ds (point x, point h) = 0;





--------------- ----------------
HI TGeomFrameWork* GFW;
H --------------------------------------------
#endif
I*** PSGEOM.CPP **
#include "ps~geom.h"

1****TGeomnFrameWork-----------------------------
TGeomFrame Work: :TGeomFrame Work0

hi = 1.0; h2 = 1.0; equih = 0; asph =1.0; asph2 = 1.0; geom -1;

int TGeomFrameWork::geom assigned =-1;

/**** TGeomXY ----------------------------------
TGeomXY::TGeomXY () : TGeomFrameWork0

geom =1

void TGeomXY :: xl (AXISTRUCT& axe)

axe.axtype =Y

axe.axname = "Length";
axe.units = "cmn";
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

void TGeomXY :: x2 (AXISTRUCT& axe)

axe.axtype =Y

axe.axname = "Length";
axe.units = "cm";
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

num TGeomXY ::ds (point x, point h)

return (h.xl I h.x2);

void TGeomXY ::LaplaceShablon (point x, point h,
num& xlm, num& xl, num& xlp,
num& x2m, num& x2, num& x2p,

num& gfr)

xlm = 1.0; xl = 2.0; xlp = 1.0;
x2m = asph2; x2 = 2.0*asph2; x2p = asph2;



gOr =hl*hl;

/**TGeomRZ ----------------------------------
TGeomRZ::TGeomRZ (): TGeomFrameWork0

geomn= 2;

void TGeomRZ: xlI (AXISTRUCT& axe)

axe.axtype =Y'x;

axe.axname = "Length";
axe.units = "cmn";
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

void TGeomRZ: x2 (AXISTRUCT& axe)

axe.axtype =Y'x;

axe.axname = "Length";
axe.units = "cmn";
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

num TGeomRZ ::ds (point x, point h)

return (h.xl *h.x2);

void TGeomRZ LaplaceShablon (point x, point h,
num& xlm, num& xl, num& xlp,
num& x2m, num& x2, num& x2p,

num& gfr)

asph = h.xlI / h.x2; asph2 = asph *asph;

xlm = (x.x1-0.5*h.x1)*asph2/x.x1;
xlp =(x.xl+0.5*h.xl)*asph2/x.xl;

xl =xlm+ xlp+ 2;
gfr = h.xl*h.xl*epsO;

x2m= 1.0;
x2p= 1.0;
x2 = x2m +x2p;

I**TGeomRTh --------------------------------- *
TGeomRTh::TGeomRTh 0: TGeomFrameWork0

geomn = 3;



void TGeomRTh: xl (AXISTRUCT& axe)

axe.axtype =Y'x;

axe.axname = "Length";
axe.units = "r"
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

void TGeomRTh: x2 (AXISTRUCT& axe)

axe.axtype =Y'x;

axe.axname = "Length";
axe.units = "r"
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

num TGeomRTh : ds (point x, point h)

return (x.xl *h.xl * h.x2); HI r*dr*dth

void TGeomRTh: LaplaceShablon (point x, point h,
num& xlm, num& xl, num& xlp,
num& x2m, num& x2, num& x2p,

num& gfr)

xlm=1.O; x1=2.O; xlp =1.0;
x2m = asph2; x2 = 2.O*asph2; x2p = asph2;

gfr =hl*hl;

/**TGeomX1X2 ----------------------------------
TGeomX1X2::TGeomX1X2 (): TGeomFrameWork0

geom = 4;

void TGeonX I X2 ::xI (AXISTRUCT& axe)

axe.axtype =Y'x;
axe.axname = "Length";
axe.units = "cmn";
axe.lobound ="Left";

axe.upbound ="Right";

axe.bndtype = "Open";

void TGeomX1X2: x2 (AXISTRUCT& axe)

axe.axtype = 'x';



axe.axname = "Length";
axe.units = "i"
axe.lobound = "Left";
axe.upbound ="Right";

axe.bndtype ="Open";

numn TGeomX IX2 :: ds (point x, point h)

return (x.xl * h.xl * h.x2); HI r"'dr"dth

void TGeomX1X2 ::LaplaceShablon (point x, point h,
num& xlImi, num& xl1, num& xlIp,
num& x2m, num& x2, numn& x2p,

num& gfr)

xlm = 1.0; xl = 2.0; xlp = 1.0;
x2m = asph2; x2 = 2.O*asph2; x2p = asph2;

gfr=hl*hl;

/*PS MESH.H""
#if! defined CPS_MESHH)
#define _PSMESHH

#include "psregn.h"

class TGridVal;
class TAbstrProcess;

typedef void (*TApplicator) (int, int);

typedef void (TAbstrProcess::*TPrcsApplicator) (int, int);

1* ~TAbstrMesh *

class TAbstrMesh

public:
TGeomAxis *Xl, *X2;
TGeomFrameWork *GFW;
TAbsti-Region *Rgn;

static int id-Mesh;
int Status;
int ic, jc; HI Current Node index
num xl1, x2; H/Boundaries for radius
num ylI, y2; H/Boundaries for z
num hi1, h2; HI Space steps
num asph, asph2;
int Nx, Ny; IIDimensions
int Ni1, N2; IIDimensions
int Ms;
int OwnDraw;
int CanEdit;

public:



TAbstrMesh0 {}
TAbstrMesh (int);
TAbstrMesh (const TAbstrMesh& aMesh, int Shift);

virtual -'TAbstrMesh 0

void Prepare 0 {}

virtual void AllocateVal (TGridVal& A, long& MeshSize, int& incr) = 0;

virtual void DeAllocateVal ( TGridVal& A, long& MeshSize) = 0;

virtual point operator () t (i, intj )=0;

virtual unsigned int Offset ( it i, intj )=0;

virtual void ForAliNodes ( TApplicator ) =0;
virtual void ForAilNodes ( TAbstrProcess&, T~rcsApplicator) =0;
virtual void ForAlllnnerNodes ( TApplicator ) = 0;
virtual void ForAllInnerNodes ( TAbstrProcess&, TPrcsApplicator) 0;
virtual void ForRow (num, TApplicator ) = 0;
virtual void ForRow (TAbstrProcess&, num, TPrcsApplicator) 0;
virtual void LeapFrogNodes (TApplicator) =0;
virtual void LeapFrogNodes (TAbstrProcess&, TPrcsApplicator)=0;

virtual void Resetlndex 0) { ic = jc = 0; );
virtual int NextIndex ( int& i, int&j ) { i =ic; j =++jc; return ;};
virtual mnt PreyIndex (int& i, int&j ) { i =ic; j =--jc; return ;};
virtual mnt TopIndex ( int& i, int& j) f i = ++ic; j = jc; return 0;};
virtual mnt DownIndex ( int& i, int& j ) f{ = --ic; j = jc; return 0;);

virtual void DrawMesh(){}
virtual void EditMesh(){}
virtual void SaveMesh(){}
virtual void OpenMesh(){;

1* ~TMesh2D *

class TMesh2D :public TAbstrMesh
f
public:

TMesh2D 0): TAbstrMesh 0 {}
TMesh2D (TGeomAxis* xl1, TGeomAxis* x2;
TMesh2D (TAbstrRegion* aRgn)

virtual unsigned hit Offset (mt i, intj) return (i*(N2-Nl)+j)/*sizeof(nurn)*/;};

virtual num& Centre (num *base) return *(base + Offset(ic, jc );}
virtual num& West (num.* base) return *(base + Offset(ic- 1 jc );}
virtual num& East ( num.* base) return *(base + Offset(ic+1,jc );}
virtual num& North ( num * base) { return *(base + Offset(ic, jc+ 1)); }
virtual num& South ( num. * base) { return *(base + Offset(ic, jc- 1)); }

virtual void Shablon. ( int& left, int& right, int& top, int& bottom)
I left--ic- 1; right--ic+l; top=jc+l; bottom=j c-i; }



virtual point operator 0 ( t i, int j) I return point((*X l)(i),(*X2)(j));};
num. Coordi (int i) return (*Xl)(i); }
num Coord2 (int i) {return (*X2)(i); }

virtual num. Interpolate (const TGridVal& F, point x)
virtual hit NearestRow (num, x = =0;
virtual int NearestCol ( num. x ) 0;

virtual int CreateMesh (){return 0; }

1* ~TRegularMesh *

class TRegularMesh :public TMesh2D

public:
TRegularMesh 0): TMesh2D 0{}
TReg~ularMesh (TGeomAxis* xl, TGeomAxis*x2): TMesh2D (xl,x2){}

HI override pure abstract methods
virtual void Allocate Val (TGridVal& A, long& MeshSize, int& incr);
virtual void DeAllocateVal ( TGridVal& A, long& MeshSize );
virtual int NearestRow ( num y) { return (int)((y - yl1)/h2); };
virtual int NearestCol ( num. x) return (int)((x - x1)Ih1); }

virtual void ForAilNodes ( TApplicator Scheme)
virtual void ForAilNodes ( TAbstrProcess& p, TPrcsApplicator Scheme)
virtual void ForAlllnnerNodes ( TApplicator Scheme );
virtual void ForAlllnnerNodes ( TAbstrProcess& p, T~rcsApplicator Scheme)
virtual void ForRow ( num. Xrow, TApplicator Scheme);
virtual void ForRow ( TAbstrProcess& p, num Xrow, TPrcsApplicator Scheme)
virtual void LeapFrogNodes ( TApplicator Scheme );
virtual void LeapFrogNodes ( TAbstrProcess& p, TPrcsApplicator Scheme)

1* ~TCellsListMesh *

class TCellsListMesh : public TMesh2D

public:
TCellsListMesh 0): TMesh2D 0{}

1* ~TNonRectMesh *

class TNonRectMesh : public TMesh2D
f
public:

TNonRectMesh 0): TMesh2D 0 {}

1* ~TComplexMesh *

class TComplexMesh : public TNonRectMesh

public:
TComplexMesh 0): TNonRectMesh 0{}

1* ~TIDMesh *



class T IDMesh: public TAbstrMesh

public:
T IDMesh 0): TAbstrMesh0{}

1* ~T3DMesh *

class T3DMesh : public TAbstrMesh
f
public:

T3DMesh 0): TAbstrMesh 0{}

1* ~TPhaseSpaceMesh *

class TPhaseSpaceMesh : public TAbstrMesh
I
public:

T~haseSpaceMesh 0): TAbstrMesh 0{}

1* ~TSurfacesMesh *

class TSurfaceMesh : public T IDMesh

public:
TSurfaceMesh 0): T IDMesh 0{}

1* ~TInterlaceMesh *

class TlnterlaceMesh : public TRegularMesh

public:
TinterlaceMesh 0): TRegularMesh 0) (I;

/* ------------------------------------------------- end *

#endif
I*** PS MESH.CPP **

#include "ps~phval.h"
#include "psmesh.h"
#include Ytps~procs~h"

I******TAbstrMesh-----------------------------
TAbstrMesh::TAbstrMesh (int)

TAbstrMesh::TAbstrMesh (const TAbstrMesh& aMesh, hit Shift)

TAbstrMesh::>TAbstrMesh 0 {

TMesh2D::TMesh2D (TGeomAxis* xi, TGeomAxis* x2)

Xi = xl; NI = Nx =(Xl->N); hi = (Xi->step);
X2 = x2; N2 = Ny = (X2->N); h2 = (X2->step);



asph = (h2 > 0.0)? (hl/h2): (1.0); asph2 = asph *asph;

int k =N2;int m =0;
while (k > 1) 1{k/= 2;++m;}

Ms = ((1 «inm) = N2)? (in) :0;

H ------------------------------------------
TMesh2D: :TMesh2D (TAbstrRegion* aRgn)

X I = new TGeomnAxis ~
X2 = new TGeomnAxis ~

numn TMesh2D: Interpolate (const TGridVal& F, point x)

return 0;

H ------------------------------------------
void TRegularMesh ::AllocateVal ( TGridVal& A, long& MeshSize, int& incr)

A.data =new numn [MeshSize = (NI+1)*(N2+1)]; incr= N1+1;

void TRegularMesh ::DeAllocateVal( TGridVal& A, long&)

delete [] A.data;

-------------------------------------------
void TRegularMesh ::ForAilNodes (TApplicator Scheme)
I
for (mnt i=0; i<=N 1; i++)
for (int j=0; j<=N2; j++)

Scheme (ij);

void TRegularMesh ::ForAliNodes (TAbstrProcess& p, TPrcsApplicator Scheme)

for (int i=0; i<=N1I; i++)
for (int j=0; j<=N2; j++)

(p.* Scheme) (i~j);

void TRegularMesh ::ForAlllnnerNodes (TApplicator Scheme)
I
for (int H=; i<N1I; i++)
for (intj=1; j<N2; j++)

Scheme (i~j);

void TRegularMesh ::ForAlllnnerNodes (TAbstrProcess& p, TPrcsApplicator Scheme)

for (int i= 1; i<N 1; i++)
for (int j= 1; j<N2; j++)

(p.* Scheme) (i~j);

void TRegularMesh ::ForRow ( num Xrow, TApplicator Scheme)

hit iO = NearestRow (Xrow);
for (int j=1; j<N2; j++)



Scheme (iO~j);

void TRegularMesh :: ForRow ( TAbstrProcess& p, num. Xrow, TPrcsApplicator Scheme)

int iO = NearestRow (Xrow);
for (int j=l1; j<N2; j++)

(p.*Scheme) (iOj);
I
void TRegularMesh :: LeapFrogNodes (TApplicator Scheme)

for (int i= 1; i <Nl1; i+=2)
for (int j= 1; j <N2; j+=2)

Scheme (i~j);

void TRegularMesh ::LeapFrogNodes (TAbstrProcess& p, TPrcsApplicator Scheme)

for (int i=l1; i <N 1; i+=2)
for (int j=l1; j <N2; j+=2)

(p .* Scheme) (i~j);

I**PSPHVAL.H **

#if! defined CPS_PHVAL-H)
#define _PSPHVALH

#include "psaxis.h"
finclude I"psarray.ht9

#include "ps~geom.h"

class TAbstrMesh;

IH TAbstrPhysVal ----------------------------
class TAbstrPhysVal
f
public:

TAbstrPhysVal * Next;
TPhysAxis * Axis;
num Org, End;
num Min, Max;
int N;
int OwnDraw;

public:
TAbstrPhysVal 0
TAbstrPhysVal ( const TPhysAxis& Ax)
TAbstrPhysVal ( const TAbstrPhysVal& P)

virtual -TAbstrPhysVal 0{}

void Create 0) ();
void Destroy 0 {}
void Update 0{}

void Redraw0{}
void Save 0);
void Restore 0

virtual int PlotsStep (){return 1; }



virtual int PlotsSize 0{return N; }

virtual TAbstrPhysVal operator =(const TAbstrPhysVal& A)
virtual TAbstrPhysVal operator + (const TAbstrPhysVal& A)
virtual TAbstrPhysVal operator - (const TAbstrPhysVal& A)
friend TAbstrPhysVal operator * num coef, const TAbstrPhysVal& A)

HI TEulerVal ----------------------------
class TEulerVal : public TAbstrPhysVal
I
public:

TAbstrMesh *Mesh;

public:
TEulerVal 0:TAbstrPhysVal 0 {}

num operator 0 point x ) { return 0; }
num operator () jt i, int j) return 0; }

IITLagrangeVal ----------------------------
class TLagrangeVal :public TAbstrPhysVal

public:
TLagrangeVal ():TAbstrPhysVal 0 {}

HI THistoricVal ----------------------------
class THistoricVal :public TAbstrPhysVal
I
public:

THistoricVal 0 TAbstrPhysVal {}

HI TGridVal ----------------------------
class TGridVal : public TEulerVal

public:
num * data;

public:
TGridVal ():TEulerVal {}

HI TFunctionVal ----------------------------
class T~unctionVal :public TEulerVal

public:
TFunctionVal 0 TEulerVal 0{}

HI TDoubleGridVal ----------------------------
class TDoubleGridVal : public TGridVal



public:
TDoubleGridVal 0:TGridVal 0{}

HI TBeamnVal----------------------------
class TBeamVal : public TLagrangeVal

public:
TBeamVal () : TLagrangeVal 0 ( };

-----------------------------------------
#endif
f*** PSPHVAL.CPP **

#include "ps~phval.h"

/*------------------------------------------- TAbstrPhysVal -"
TAbstrPhysVal : TAbstrPhysVal0

{~srhsa ~srhsa os ~y~i&A

TAbstrPhysVal : TAbstrPhysVal ( const T~btPhys~xis& Ax

void TAbstrPhysVal :: Save (

void TAbstrPhysVal :: Restore (

TAbstrPhysVal TAbstrPhysVal::operator =(const TAbstrPhysVal& A )

return *this;

TAbstrPhysVal TAbstrPhysVal::operator + (const TAbstrPhysVal& A )

return *this;

TAbstrPhysVal TAbstrPhysVal::operator - (const TAbstrPhysVal& A)

return *this;

TAbstrPhysVal /* friend */ operator * num coef, const TAbstrPhysVal& A)

TAbstrPhysVal tmp;
return tmp;

/*PS REGN.H*~'/
#if defined QPS_REGN_H)
#define _PSREGNH



#include "ps~geom.h"
#include "ps~axis.h"

/* * TBoundairy ---------------------

class TBoundary

static TBoundary * CurrentBnd;
public:

point Org;
point End;

TBoundaryType Bndrype;
mnt OwnDraw;

TBoundary * PrevBnd;
TBoundary * NextBnd;

public:
TBoundary 0{Org = point (0.0, 0.0);

End =point (1.0, 1.0); }
TBoundary (point xl1, point x2,

TBoundaryType bt = Conductingl~nd)
TBoundary (point xl1, point x2,

T~oundaryType bt, TBoundary *x
TBoundary (point x2,

TBoundaryType bt, TBoundary *nxt)

TBoundary ( TBoundary* frm, point x2,
TBoundaryType bt = Conductingl~nd);

int ConnectWith ( TBoundary * bl1, TBoundary * b2)

/**TAbstrRegion-----------------------------

class TAbstrRegion

public:
int Type;
int OwnDraw;
int CanEdit;
int NBounds;

TBoundary * BoundaryList;
TAbstrRegion * Next;

public:
TAbstrRegion 0{Next =0; Type =0; }
TAbstrRegion ( num, num, num, num)

virtual int Islnner (point x) { return 0; };
virtual TGeomAxis* XI ) return 0; }
virtual TGeomAxis* X2 () {return 0; }

1****TRectangleRgn -----------------------------

class TRectangleRgn : public TAbstrRegion

protected:



TGeomAxis * xl;
TGeomAxis *x2
num xlmin, xlmax; HI Boundaries for xl
num x2min, x2max; HI Boundaries for x2

private:
num hxl, hx2; HI Space steps
num asph, asph2;
mnt NxlI, Nx2; H/Dimensions

public:
TRectangleRgn 0:TAbstrRegion (){Type =10; }
TRectangleRgn (num, num, num, nurn);
TRectangleRgn ( TGeomAxis * ax 1, TGeomAxis *ax2)

virtual int Islnner (point x) I return ( (x.xl > xlmin)&&
(x.xl < xlmax)&&
(x.x2 > x2min)&&
(x.x2 < x2max) ); );

int AssignBounds ( TGeomAxis * axi1, TGeomAxis *ax2)

TGeomAxis* Xl () { returnxl; };
TGeomAxis* X2 (){return x2; }

I**TRectRgnRZ-----------------------------*

class TRectRgnRZ : public TRectangleRgn

protected:
num RI, R2; H/Boundaries for radius

nmZi1, Z2; //Boundaries forz
num hr, hz; // Space steps
int Nr, Nz; II Dimensions

public:
TRectRgnRZ 0:TRectangleRgn 0{Type =12; }
TRectRgnRZ ( num, num, num, num)

num rad ( intj ) I return R1 +j*lir; );
num rad ( num x) return RI + x*hr; }

/'" TSimpleRegion-----------------------------

class TSampleRgn : public TAbstrRegion
I
public:

TSampleRgn ():TAbstrRegion() I Type = 20; }

----------------------------------------- end
#endif
/**PSREGN.CPP **

#include "ps~regn.h"

/*****TBoundary --------------------------------

TBoundary* TBoundary::CurrentBnd = 0;

TBoundary::TBoundary (point xl1, point x2, TBoundaryType bt)



Org = xl1; End = x2; BndType = bt;
PrevBnd = CurrentBnd;
NextBnd = 0;

CurrentBnd = this;

TBoundary::TBoundary (point x 1, point x2, T~oundaryType bt, TBoundary *nxt)

Org = xlI; End = x2; BndType = bt;
PrevBnd = CurrentBnd;
NextBnd = nxt;

CurrentBnd = this;

TBoundary::TBoundary (point x2, TBoundaryType bt, TBoundary *nxt)

Org =CurrentBnd->End; End = x2; BndType = bt;
PrevBnd = CurrentBnd;
NextBnd = nxt;

CurrentBnd = this;

TBoundary::TBoundary (TBoundary "'frm, point x2, TBoundaryType bt)

Org =frm->End; End = x2; BndType = bt;
PrevBnd = frm;
Next~nd = 0;

Current~nd = this;

int TBoundary::ComiectWith ( TBoundary *btl, T~oundary *bt2)

PrevBnd = btl;
NextBnd = Wt;

return ( (btlI->End = Org) && (bt2->Org == End))

/******TAbstrRegion-----------------------------

TAbstrRegion::TAbstrRegion ( num, film, num, num)

OwnDraw = 0;

STRectangleRgn ----------------------------
TRectangleRgn::TRectangleRgn ( num, num, num, num)

:TAbstrRegion0

TRectangleRgn::TRectangleRgn ( TGeomAxis *axi1, TGeomAxis *ax2)
:TAbstrRegion ()

{OwnDraw = CanEdit = 0;
xl = new TGeomAxis (*axl)
x2 = new TGeomnAxis (*a);
xlmin =axl->org; xlmax =axl->end;

x2min = ax2->org; x2max = ax2->end;



NBounds = 4;
HI BoundaryList = new TBoundary

( (point (xlImin, x2min), point (xlImax, x2min),
H/ TBoundaryType( ax2->boundl1))

HI new TBoundary
HI (point (xlImax, x2max), PeriodicBnd,
HI new TBoundary
HI (point (xlImin, x2max), ConductingBnd,
HI new TBoundary
HI (point (xlImin, x2min), PeriodicBnd,
HI BoundaryList));

int TRectangleRgn::AssignBounds ( TGeomAxis *axi1, TGeomAxis *ax2)

{~ i x-og ~a x-ed
xlmin = axl->org; xlmax = axl->end;

NBounds = 4;
BoundaryList = new TBoundary

(point (xlmin, x2min), point (xlmax, x2min), AxisymmetricBnd,
new TBoundary

(point (xlmax, x2max), PeriodicBnd,
new TBoundary

(point (xlmin, x2max), ConductingBnd,
new TBoundary

(point (xlmin, x2min), PeriodicBnd,
BoundaryList));

return 0;

I******TRectRgnRZ -------------------------------
TRectRgnRZ::TRectRgnRZ ( num, num, num, num)

:TRectangleRgn0

H ---------------------------------------------- end.

2. VISUALIZATION CLASSES

This part of the library is base on the GUI-interface of the OWL Library
compiled at Borland. The major classes developed to display in the child
windows are based on the abstract class TBasePlotswmn.

ITBasePlotswinAAAAi,

3TSurfaceplot3
AAAAA.AAAAAAAAK,
3 TLinesPlot AAAL

3 TRegionPlot 3

AAAAAAAA.AAAAAA'
3TPointsPlot3



1* ~ObjectOriented PIC for C++ *
1* ~Version 1.00 *

/* Copyright (c) 1993, 1994 The Group Compuetr Simulation *
High Current Electronics Institute *

1*Contract SPC93-4035(F6 170893 W0612)

1* ~Last write 10-20-94 *

/* PSGRAPH.H *
II Graphics window object header

#ifndefPSGRAPHH
#defme _PSGRAPHH

class _OWLCLASS TFrameWindow;
class _OWLCLASS TStatic;
class _OWLCLASS TPen;

finclude "ps~plots.h"
#include "psjphval.h"
#include "psregn.h"
#include "ps-idres.rh"

const int WM PW-CLOSED =WM USER + 100;

* ----- TBaseGraphWin---------------------------------------
/1 Abstract Base class for Graphic Control.
II Separated to easy change general ancestor Window class,

IH e.g. - TFrame Window -> TMDIChild, TDecoratedFrame or TrinyCaption

class TBaseGraph Win :public TFrame Window

public:
TBaseGraphWin (TWindow* parent, char*' title,

TModule* inst = 0 );
virtual LPSTR GetClassName 0 { return "BaseGraph Win"; }
virtual void TimerTick //{} ~ I-- default placeholder
virtual void Animate 0 // I-- default placeholder

void EvDestroy 0; II-post message
int pwid;

protected:
TWindow *mastwinr;

TModule *mastapp;

DECLARERESPONSE-TABLE ( TBaseGraphWin);

* ----- TGraphWin ----------------------------------------

class TGraphWin : public TBaseGraphWin



protected:
BOOL Iconized;-
BOOL Scaled;
BOOL Isotropic;
BOOL Decorated;
BOOL Paused;

public:
TRect Cint;
TPlotsList * PlotsList; IH Plots Elements

protected:
int pwLengthX, pwLengthY; HI Window Size in pixels
int pwbeft, pwRight; HI Viewport coord rel Window
int pwTop, pwBottom; HI

public:
TGraphWin ( TWindow"* parent, char* title,

TModule* inst = 0)
virtual -TGraph Win 0);
virtual void GetWindowClass( WNDCLASS& WndClass)
virtual void SetupWindow 0);
virtual LPSTR GetClassName (){return "GraphicWindow"; }

protected:
virtual void ScaleTo ( int Xs, int Ys)

virtual void Paint ( TDC& dc, BOOL erase, TRect& rect)
virtual void EvSysCommand (UINT id, TPoint& pt);
virtual void EvLButtonDown (UINT, TPoint&)
virtual void EvRButtonDown (UINT, TPoint&)
virtual void EvSize (UJNT, TSize& size);

private:
void DlgSettings 0
void DlgAddPlot 0
void DlgDelPlot 0

public:
void AssignList (TlotsList *p1) {PlotsList =p1; }
void LinkPlot (TBasePlot *bp) {PlotsList -> Ins (bp); }

virtual void TimerTick 0
virtual void Animate 0);

DECLARERESPONSETABLE (TGraph Win);

* ----- TLinesGraphWin ----------------------------------------

class TbinesGraphWin : public TGraph Win
I
protected:

int pwNx, pwNy; HI Axis Draw digits
char cwXfmnt [LNGH -FMT]; HI and its format
char cwYfint [LNGHFMT]; HI
numn rwllx, rwlly; I
num rwScaleX, rwScaleY;
num rwSizeX, rwSizeY;
num rwStepX, rwStepY;



num rwOrgX, rwOrgY; HI Geometry limits in
num. rwEndX, rwEndY; HI physical units
char cwName [LNGH -TITLE];
char cwXname [LNGH _AXIS];
char cwYname [LNGH -AXIS];
char cwXunits [LNGH_.UNITS];
char cwYunits [LNGH UNITS];

public:
TLinesGraphWin ( TWindow* parent, char* title,

axis* hrz, axis* vrt,
TModule* inst = 0)

virtual -TLinesGraphWin 0);

virtual void DrawMesh (TDC& dc);
virtual void DrawAxis (TDC& dc);
virtual void DrawBounds ( TDC& dc)
virtual void DrawComments ( TDC& dc)

protected:
int Icx ( num x ) I return (int)(rwScaleX*(x - rwOrgX)+pwbeft); }
int Icy ( num y ) { return (int)(rwScaleY*(rwEndY - y)+pwTop); }
num Xci ( int i ) { return (rwOrgX + rwStepX*(i-pwLeft)); };
num Yci ( int i ) I return (rwEndY - rwStepY*(i-pwTop)); }

virtual void ScaleTo ( int Xs, int Ys );

virtual void Paint ( TDC& dc, BOOL erase, TRect& rect)
virtual void EvbButtonDown ( UINT, TPoint&)
virtual void EvSize (UINT, TSize& size);

public:
virtual void TimerTick 0
virtual void Animate 0

protected:
long TextClr,

NameClr,
MeshClr,
PlotClr;

TPen * TextPen,
* MeshPen,
* PlotPen;

char txt [LNGH -COMMENT];
TStatic * StaticControl;

int TextHeight;

DECLARERESPONSETABLE (TLinesGraphWin);

* ----- TRegionGraphWin -----------------------------------------

class TRegionGraphWin : public TLinesGraphWin

private:
mnt pwMeshX, pwMeshY; IIMesh Dimension

TBoundaryType pwLeftBnd, pwRightBnd, HI
pwTopBnd, pwBottomBnd; HI

public:



TRegionGraph Win (TWindow* parent, char* title,
TGeomAxis* hrz, TGeonlAxis* vrt,
TModule* inst = 0 );

TRegionGraphWin (TWindow* parent, char* title,
TRectangleRgn* rgn,
TModule* inst = 0 );

virtual LPSTR GetClassName () { return "RegionPlot"; };

void ExamplePaint ( TDC& dc );
virtual void DrawMesh (TDC& dc);
virtual void DrawAxis (TDC& dc);
virtual void DrawBounds ( TDC& dc)
virtual void DrawComments ( TDC& dc);

protected:
TPen* Pen (TBoundaryType ind);
long BudColor (TBoundaryType ind);

virtual void Paint ( TDC& dc, BOOL erase, TRect& rect)
protected:

long BndOpenClr,
BndMetalClr,
BndSymClr,
BndPeriodClr;

TPen * BndOpenPen,
* BndMetalPen,
* BndSymPen,
* BndPeriodPen;

-------------------------------------------------------
#endif HI ifnidef_-PSGRAPHH
H/****** PS GRAPH.CPP* * *** *
Wi defined CSPRTPLOTS PCH)

#pragma hdrfile "d:\picsimn\obj\_plots.csm"
#include <stdlib.h>
#include <stdio.h>
#include <math.h>
#include <typeinfo.h>
#include <owl\dialog.h>
#include <owl\checkbox.h>
#include <owl\static.h>
#include <owl\combobox.h>
#include <owl\edit.h>
#include <owl\groupbox.h>
#include <owl\radiobut.h>
#include <owl\dc.h>
#include <owl\framewin.h>
#include <owl\applicat.h>

#pragma hdrstop

#else

#pragma hdrfile "f:-\picsiim\obj\_allpch.csm"
#defme _ALLPCH
#include <-allpch.h>



#pragma hdrstop

#endif

#include "ps -idres.rh"
#include "ps digO 1.rh"
#include "ps,_menulI.rh"
#include "ps,_strOl1.rh"

#include "ps~graph.h"

static int WinCount = 0;

static int Debug = 0;

struct TGraphDlgStructlI

BOOL svDecor;
BOOL svScale;
BOOL svlsotr;

H ----------------------------------------------------
class TGraphDlg 1 : public TDialog
f
public:

TGraphDlgl (TWindow* parent, mnt resld, TGraphDlgStructl & ts);

TGraphDlgl :: TGraphDlglI (TWindow* parent, int resld, TGraphDlgStructlI & ts)
TDialog (parent, resld), TWindow (parent)

ne{~ eko ti, d hcl )
new TCheckBox (this, idc_checki, 0);
new TCheckBox (this, idc-check2, 0);

TransferBuffer = (void far*)&ts;

struct TGraphDlgStruct2

TComboBoxData svPlots;

-----------------------------------------------------
class TGraphDlg2 : public TDialog

public:
TGraphDlg2 (TWindow* parent, int resld, TGraphDlgStruct2 & ts);

TGraphDlg2 :: TGraphDlg2 (TWindow* parent, hit resld, TGraphDlgStruct2 & ts)
TDialog (parent, resld), TWindow (parent)

new TComboBox (this, idc -combol, MXCOMBO);
TransferBuffer = (void far*)&ts;



TBaseGraphWin------------------------------

DEFINE_-RESPONSETABLE 1 (TBaseGraphWin,TWindow)
EVWMDESTROY,

ENDRESPONSETABLE;

-------------------------------------------------
TBaseGraphWin:: TBaseGraphWin (TWindow* parent, char* title,

TModule* inst )
TFrame Window (parent, title, 0, FALSE, inst)

mastwin = parent; mastapp = inst; pwid = ++WinCount;

---------------------------------------------------
void TBaseGraphWin: :EvDestroy0

Parent->PostMessage ()WM_PWCLOSED, pwid);
TFrameWindow::EvDestroyo;

#defme cms_-Settings 201
#defme cmsAddPlot 202
#define cmsDelPlot 203
#define cmsRevision 209

/*********TGraphWin ----------------------------- *

DEFINE_-RESPONSETABLE 1 (TGraphWin, TBaseGraphWin)
EVV/WM_-SIZE,
EVWMSYSCOMMAND,
EVWMLBUTTONDOWN,
EVVIWM_-RBUTTONDOWN,

ENDRESPONSETABLE;

//-------------------------------------------------
TGraphWin :: TGraphWin (TWindow* parent, char* title,

TModule* inst)
TBaseGraphWin (parent, title, inst),

PlotsList ( 0)

Attr. Style = WIS_-VISIBLE I WIS -POPUP I IS-OVERLAPPEDWINDOW;
Attr.X = 70 + 15*WinCount;
Attr.Y = 50 + 10* WinCount;
Attr.W =500;

Attr.H 300;
Iconized = Scaled = Isotropic = Paused = FALSE; Decorated = TRUE;
pwLeft = 8*7; pwRight = 8*9;
pwTop = 16*2; pwBottom = 16*3;

pwLengthX = Attr.W - (pwLeft + pwRight); Iwork area width
pwLengthY = Attr.H - (pwTop + pwBottom); IH work area height

Clnt.left = pwLeft; Clnt.right = pwLeft + pwLengthX;



Clnt.top = pwTop; Clnt.bottom = pwTop + pwLengthY;

---------------------------------------------------
TGraphWin :: ~-TGraphWin0
I
if (PlotsList) delete PlotsList;

---------------------------------------------------
void TGraphWin::GetWindowClass( WNDCLASS& WndClass)

TBaseGraph Win: :GetWindowClass( WndClass)
WndClass.hbrBackground = (HBRUSH) GetStockObject (BLACKBRUSH);

HI WndClass.hlcon = 0;
HI WndClass.hlcon = mastapp -> Loadlcon ("idilconPiCppl V);

WndClass.hlcon = HICON (Tlcon (HINSTANCE(*mastapp), idilconPiCpp2));

---------------------------------------------------
void TGraph Win::Setup Window0

HMENU hSysMnu;
char captio [25];
char numero [10];
i t Ic;

TBaseGraph Win: :Setup Window 0
itoa ( WinCount, numero, 10 );

I* ic = */ Get WindowText (captio, 24);
strcat (captio, "Win=");
strcat (captio, numero);

SetWindowText (captio);
hSysMnu = GetSystemMenu ();
AppendMenu (hSysMnu, MF_-SEPARATOR, 0, NULL);
AppendMenu (hSysMnu, ME_-STRING, cmnsSettings, "&Settings...");
AppendMenu (hSysMnu, MESEPARATOR, 0, NULL);
AppendMenu (hSysMnu, ME_-STRING, cmsAddPlot, "&Add Plot..."');
AppendMenu (hSysMnu, ME_-STRING, cmsDelPlot, "&Delete Plot..."');
AppendMenu (hSysMnu, MESTRING, cmsRevision, "&Revision...");

---------------------------------------------------
void TGraph Win: :EvSize( U1NT sizeType, TSize& size)

int NewXmax, NewYmax;
TRect cint = GetClientRect 0;

TBaseGraphWin::EvSize (sizeType, size);
Invalidate (TRUE);

NewXmax = clnt.right - (pwLeft + pwRight);
NewYmax = clnt.bottom - (pwTop + pwBottom);

if (sizeType == SIZEIMINIMIZED)
{if (! Iconized) ( Iconized = TRUE;}

else
{if (Iconized) Iconized = FALSE;
if (Scaled) ScaleTo (NewXmax, NewYmax);

Clnt.left = pwLeft; Clnt.riglit = pwLeft + pwLengthX;



Clnt.top = pwTop; Clnt.bottom. = pwTop + pwbengthY;

H --------------------------------------------------
void TGraphWin::EvSysCommand (ULNT id, TPoint& pt)

switch (id)

case cms_-settings: DigSettings 0; break;
case cms_-AddPlot: DlgAddPlot 0; break;
case cms_-DelPlot: DlgDelPlot 0; break;
case cmsRevision:

if (PlotsList) PlotsList -> Revision 0
else MessageBox ("PlotsList is Empty! ",""MBOK);

break;

default: TBaseGraphWin::EvSysCommand (id, pt);

---------------------------------------------------
void TGraphWin::DlgAddPlot0

TGraphDlgStruct2 ds2;
ds2.svPlots.AddStringltem ("Text Element", 0);
ds2.svPlots.AddStringltem ("Axis Element", 1);
ds2.svPlots.AddStringltem ("Boundary Element", 2);
ds2.svPlots.AddStringltem ("Frame Element", 3);
ds2.svPlots.AddStringltem ("Region Element", 4);
ds2.svPlots.AddStringltemn ("Mesh Element", 5);
ds2.svPlots.AddStringltem ("Line Element", 6);
ds2.svPlots.AddStringltem ("Func Element", 7);
ds2.svPlots.AddStringltem ("GridValue Element", 8);
ds2. svPlots. Select (0);

if (TGraphDlg2 (this, iddGraph2, ds2).Execute (= IDOK)

TBasePlot * NP = 0;
mnt Sel = ds2.svPlots.GetSellndex0;

switch ( Sel )
{case 0: NP =new T1 extrlot (tims); break;
case 1: NP =new TAxisPlot (this); break;

if ( NP ) PlotsList -> Ins (NP);

---------------------------------------------------
void TGraphWin::DlgDelPlot 0

TGraphDlgStruct2 ds2; int k = 0; char buf [80];
while (++k <= (PlotsList ->Ne))
{PlotsList -> Element ( buf, k );
ds2.svPlots.AddStringltem ( buf, k- I)

ds2.svPlots. Select (0);
if (TGraphDlg2 (this, iddGraph2, ds2).Execute 0 =IDOK)



int Sel = ds2.svPlots.GetSellndexo + 1;
if ( Sel > 0 ) PlotsList -> Del ( Sel)

---------------------------------------------------
void TGraphWin::DlgSettings 0

TGraphDlgStructl dsl;
dsl .svDecor = Decorated;
dsl.svScale = Scaled;
dsl1.svlsotr = Isotropic;

if ( TGraphDlglI (this, iddGraphl1, dsl1).Execute 0 =IDOK)

Decorated = dsl1.svDecor;
Scaled = dsl .svScale;
Isotropic = dsl .svlsotr;

TRect chit = GetClientRect 0
int NewXmax = clnt.right - (pwLeft + pwRight);
int NewYmax = clnt.bottom - (pwTop + pwBottom);

if (Scaled) ScaleTo (NewXmax, NewYmax);
Invalidate (TRUE);

H --------------------------------------------------
void TGraphWin::ScaleTo ( int Xs, hit Ys)

if{s>0 wegh s
if (Xs > 0) pwLengthX = Xs;

if (PlotsList) PlotsList -> ScaleTo ( pwLengthX, pwLengthY)

---------------------------------------------------
void TGraphWin ::EvLButtonDown ( UINT, TPoint&)

Paused = !Paused;

//--------------------------------------------------
void TGraphWin: EvRButtonDown (U1NT, TPoint&)

Scaled = ! Scaled;

---------------------------------------------------
void TGraphWin::TimerTick0
I
HIHDC dc;

if(!Paused)
//I dc = GetDC (HWindow);
if (PlotsList) PlotsList -> Draw ( TClientDC (HWindow))

HI ReleaseDC (H Window, dc);

---------------------------------------------------
void TGraphWin::Animate0



HDC dc;
if (!Iconized)

H I dc = GetDC (H Window);
if (PlotsList) PlotsList -> Redraw (TClientDC (HWindow));

II ReleaseDC (HWindow, dc);

-----------------------------------------------------
void TGraph Win: :Paint ( TDC& dc, BOOL erase, TRect& rect)

TBaseGraphWin::Paint (dc, erase, rect);
dc.SetBkMode (TRANSPARENT);
dc.SetBkColor (RGB(O,O,O));
dc.SetTextAlign (TACENTER I TABASELINE I TA-NOUPDATECP);

II ~dc.SetTextColor ( TextClr)
if (!Iconized)

if (PlotsList) PlotsList -> Draw ( dc, 0)

STbinesGraphWin ------------------------------

DEFINERESPONSETABLE 1 (TLinesGraphWin, TGraph Win)
EVWM_-SIZE,
EVWM_-LBUTTONDOWN,

ENDRESPONSETABLE;

//--------------------------------------------------
TLinesGraphWin :: TLinesGraphWin (TWindow* parent, char* title,

axis * hrz, axis * vrt, TModule* inst)
T~raph Win (parent, title, inst)

TextClr =RGB (255, 255, 255)
NameCIr = RGB (127, 127, 0);
MeshClr = RGB (127, 127, 127);
PlotClr =RGB (255, 255, 127 );

TextPen =new TPen (TextClr);
MeshPen = new TPen (MeshClr, 1, PS_-SOLID);
PlotPen =new TPen (PlotClr, 1, PS SOLID);

if (!hrz) MessageBox ("Horiz Axis NULL pointer","Error");
if (!vrt) MessageBox ("Vert Axis NULL pointer", Error");

if ((hrz)&&(vrt))

rwOrgX = hrz->org; rwOrgY =vrt->org;

rwEndX = hrz->end; rwEndY =vrt->end;

strcpy (cwXname, hrz->namne); strcpy (cwYname, vrt->namne);
strcpy (cwXunits, hrz->units); strcpy (cwYunits, vrt->units);

pwNx = ((hrz->N > 0)&&(hrz->N < 51))? brz->N --1;
pwNy = ((vrt->N > 0)&&(vrt->N < 5 1))? vrt->N : 1;

else



rwOrgX = 0.0; rwOrgY = 0.0;
rwEndX = 10.0; rwEndY = 10.0;

strcpy (cwXnamne, "fiffi X"); strcpy (cwYname, "Ififl Y");
strcpy (cwXunits,"cm"); strcpy (cwYunits,"m");

pwNx=-1; pwNy =-1;

rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;
if (rwSizeX <= 0.0) rwSizeX = 1.0; lHd
if (rwSizeY <= 0.0) rwSizeY = 1.0; /Idd

pwLeft = 8*7; pwRight = 8*9;
pwTop = 16*2; pwBottom = 16*3;

pwLengthX = Attr.W - (pwbeft + pwRight); HI work area width
pwLengthY = Attr.H - (pwTop + pwBottom); HI work area height

rwScaleX = pwLengthXlrwSizeX; rwScaleY = pwLengthY/rwSizeY;
rwStepX = 1 .O/rwScaleX; rwStepY = 1 .0/rwScaleY;
rwHx = rwSizeX I pwNx; rwHy = rwSizeY I pwNy;

strcpy (cwXfint, "%.2f'); strcpy (cwYfint, 't%.2f');
strcpy (cwName, " Lines Plot ");

StaticControl = new TStatic (this, 100, cwName, 10, 10, 10, 10, 0);

HI--------------------------------------------------
TLinesGraphWin: ~-TLinesGraph Win0

delete StaticControl;
I/if (PlotsList) delete PlotsList;

//--------------------------------------------------
void TLinesGraphWin::EvSize( UINT sizeType, TSize& size)

TRect clnt = GetClientRect 0
TGraphWin::EvSize (sizeType, size);

Invalidate (TRUE);
if ((StaticCont~rol)&&(! Iconized))

StaticControl -> MoveWindow ( 0, 0, clnt.right, 16, TRUE)

void TLinesGraphWin:: ScaleTo ( int Xs, hit Ys)

TGraphWin:: ScaleTo (Xs, Ys);
rwScaleX = pwLengthXlrwSizeX; rwScaleY = pwLengthYlrwSizeY;
rwStepX = 1.O/rwScaleX; rwStepY = 1.O/rwScaleY;

HI--------------------------------------------------
void TLinesGraphWin EvLButtonDown ( UINT, TPoint&)

delete StaticControl;
strcpy (txt, "lih~ !");

StaticControl = new TStatic(this, 100, txt, 10, 10, 10, 10,0);
Paused = !Paused;

HI--------------------------------------------------
void TLinesGraphWin::TimerTick0

if (!Paused) TGraphWin ::TimerTick 0



------------------ -----------------
void TLinesGraph Win: :Animate0

I
if (!Paused) TGraphWin: Animate 0

H --------------------------------------------------
void TLinesGraphWin::DrawBounds ( TDC& dc)

f
dc.MoveTo ( pwLeft, pwTop)

dc.SelectObject (*TextPen);
dc.LineTo ( pwLeft+pwLengthX, pwTop)
dc.LineTo ( pwLeft+pwLengthX, pwTop+pwLengthY)
dc.LineTo ( pwLeft, pwTop+pwLengthY)
dc.LineTo ( pwLeft, pwTop)

dc.RestorePen 0;

---------------------------------------------------
void TLinesGraphWin::DrawAxis ( TDC& dc)

char txt [20];
dc.SetrextAlign (TACENTER I TA -TOP);

/* H(m) */ sprintf (txt,"%s (%/s)", cwXname, cwXunits);
dc.TextOut (pwLeft+pwLengthX/2, pwTop+pwLengthY+22, txt, strlen(txt));

1* -5.0 */ sprintf (txt, cwXfint, rwOrgX);
dc.TextOut (pwLeft+1, pwTop+pwLengthY+4, txt, strlen(txt));

/* 10.0 */ sprintf (txt, cwXfint, rwEndX);
dc.TextOut (pwLeft+pwLengthX- 1, pwTop+pwLengthY+4, txt, strlen(txt));

1* 0 */ if (rwOrgX*rwEndX < 0.0)
dc.TextOut (Icx(0.0), pwTop+pwLengthY+4, 90.O0t, 3);

dc.SetTextAlign (TA,_LEFT I TABASELINE );
1* V */ sprintf (txt,"%s", cwYname);

dc.TextOut (pwLeft+pwLengthX+ 12, pwTop+pwLengthY/2, txt, strlen(txt));
/* (in) */ sprintf (txt,"(%s)", cwYunits);

dc.TextOut (pwLeft+pwbengthX+6, pwTop+pwLengthY/2+1 6, txt, strlen(txt));
dc.SetTextAlign (TA RIGHT I TA BASELINE);

/* -1 */ sprintf (txt, cwYfint, rwOrgY);
dc.TextOut (pwLeft-3, pwTop+pwLengthY, txt, strlen(txt));

/* 1 */ sprintf (txt, cwYfint, rwEndY);
dc.TextOut (pwLeft-3, pwTop, txt, strlen(txt));

/* 0 */ if (rwOrgY*rwEndY < 0.0)
dc.TextOut (pwLeft-3, Icy(0.0), "0.0", 3);

dc.SetTextAlign (TACENTER I TABASELINE I TA-NOUPDATECP);

HI--------------------------------------------------
void TLinesGraphWin::DrawMesh ( TDC& dc)

int i;
dc.SelectObject (*MeshPen);

for ( i= 1; i < pwNy; i++)
{ dc.MoveTo (pwLeft, Icy (rwOrgY + i*rwlly))

dc.LineTo ( pwLeft+pwLengthX, Icy (rwOrgY + i*rwHy))

for ( i=I1; i < pwNx; i++)



{ dc.MoveTo ( Icx (rwOrgX + i*rwHx), pwTop)
dc.LineTo ( Icx (rwOrgX + i*rw{x), pwTop+pwLengthY)

dc.RestorePen 0

---------------------------------------------------
void TLinesGraph Win: :DrawComments ( TDC& dc)

I
char txt [ 1 =iD

double d, w, a, h;
num x, y;

HI TRect rct (0, 12, pwLeft+pwRight+pwLengthX, 28);
HI dc.SetTextAlign (TA,_CENTER);
HI dc.SetTextColor (NameCir);
HI strcat (txt, cwName);
HI dc.ExtTextOut (1, 1, ETO OPAQUE, &rct, txt, strlen(txt));

h = rwSizeX /pwLengthX;
a = rwSizeY *0.25;

w =6.28 * 8 /rwSizeX;
dc.MoveTo (pwLeft, Icy (0.0));

dc.SelectObject (*PlotPen);
for ( int i=1; i < pwLengthX; i++)

{ a*= 0.9;
x = num (rwOrgX + i * h);
y = num (a * sin (w * x)

dc.LineTo ( Icx ( x), Icy (y))

dc.RestorePen 0

-----------------------------------------------------
void TLinesGraphWin::Paint ( TDC& dc, BOOL erase, TRect& rect)

TGraph Win: :Paint (dc, erase, rect);
dc.SetBkMode (TRANSPARENT);
dc.SetBkColor (RGB(0,0,0));
dc.SetTextAlign (TACENTER ITABASELINE I TANOUPDATECP);
dc. SetTextColor ( TextClr)

if (!Iconized)

DrawBounds ( dc)
DrawAxis ( dc );
DrawMesh ( dc );

if (Isotropic) DrawComments ( dc)
H ---------------------------

if (PlotsList) PlotsList -> Draw (dc);

STRegionGraphWin ------------------------------
-------------------------------------------------------

TRegionGraphWin :: TRegionGraphWin (TWindow* parent, char* title,
TGeomAxis * hrz, TGeomAxis * vrt,



TModule* inst)
TLinesGraph Win (parent, title, hrz, vrt, inst)

BndOpenClr =RGB ( 0, 0, 255)
BndMetalClr = RGB ( 255, 0, 0)
BndSymClr = RGB (127, 255, 0);
BndPeriodClr = RGB (0, 127, 127 );

BndOpenPen =new TPen (BndOpenClr, 1, PS_-DASH);
BndMetalPen =new TPen (BndMetalClr, 2, PS_SOLID);
BndSymPen new T~en (BndSymClr, 1, PS_-DASHDOT);
BndPeriodPen =new T~en (BndPeriodClr 1, PS_SOLID);

if ((hrz) && (vrt))

pwMesbX =(hrz->N); pwMeshY = (vrt->N);
pwLeftBnd =TBoundaryType(hrz->bound 1); pwRightBnd =TBoundaryType (hrz->bound2);
pwBottomBnd = TBoundaryType(vrt->bound 1); pwTopBnd = TBoundaryType (vrt->bound2);

else
I

pwMeshX = 20; pwMeshY =10;

pwLeftBnd = 1; pwRightBnd =3;

pwBottomBnd =2; pwTopBnd =4;

}wx=(p~sX>0&(weh 51) weh 0
pwNx = ((pwMesbX > 0)&&(pwMeshX < 15 1))? pwMeshX: 10;

rwHx = rwSizeX / pwNx; rwHy = rwSizeY / pwNy;
strcpy (cwName, "Two Axis and Homogeneous Mesh");
wsprintf (txt," Regular Mesh = %d x %d", pwMeshX, pwMeshY);

StaticControl = new TStatic(this, 100, txt, 10, 10, 10, 10,0);

---------------------------------------------------
TRegionGraphWin: TRegionGraphWin (TWindow* parent, char* title,

TRectangleRgn * rgn, TModule* inst)
TLinesGraphWin (parent, title, rgn->XIO), rgn->X2(), inst)

TGeomAxis * hrz =rgn -> X1I(;
TGeomAxis * vrt =rgn -> X2();

BndOpenClr = RGB (0, 0, 255)
BndMetalClr = RGB (255, 0, 0)
BndSymClr = RGB (127, 255, 0);
BndPeriodClr = RGB (0, 127, 127 );

BndOpenPen =new TPen (BndOpenClr, 1, PS_-DASH);
BndMetalPen =new TPen (BndMetalClr, 2, PS_SOLID);
BndSymPen =new TPen (BndSymClr, 1, PS_-DASHDOT);
BndPeriodPen =new TPen (BndPeriodClr, 1, PSSOLID);

if ((hrz) && (vrt)).

pwMeshX = hrz->N; pwMeshY = vrt->N;
pwLeftBnd = TBoundaryType(hrz->bound 1); pwRightBnd =T~oundaryType (hrz->bound2);
pwBottomBnd = TBoundaryType(vrt->bound 1); pwTopBnd = TBoundaryType (vrt->bound2);

else

pwMeshX = 20; pwMeshY = 10;



pwLeftBnd = 1; pwRightBnd =3;

pwBottomBnd = 2; pwTopBnd =4;

}wx=(p~sX>0&(weh 51) weh 0
pwNx = ((pwMeshX > 0)&&(pwMeshX < 15 1))? pwMeshX: 10;

rwHx = rwSizeX / pwNx; rwHy = rwSizeY / pwNy;
strcpy (cwNarne, "Rectangle Region and Homogeneous Mesh");
wsprintf (txt," Rectangle Mesh = %d x %d", pwMeshX, pwMeshY);

StaticControl = new TStatic(this, 100, txt, 10, 10, 10, 10,0);

---------------------------------------------------
long TRegionGraphWin: :lndColor ( TBoundaiyType nd)

{ switch (hid)
f case ConductingBnd: return (BndMetalCir);

case OpenBnd: return (BndOpenClr);
case AxisymmetricBnd: return (BndSymClr);
case PeriodicBnd: return (BndPeriodClr);

default: return (TextClr);

---------------------------------------------------
TPen* TRegionGraphWin: :Pen ( TBoundaryType hid)

{ switch (hid)
{case Conductingl~nd: return (BndMetalPen);
case OpenBnd: return (BndOpenPen);
case AxisymrnetricBnd: return (BndSymPen);
case PeriodicBnd: return (BndPeriodPen);

default: return (TextPen);

H --------------------------------------------------
void TRegionGraphWin::ExarnplePaint ( TDC& dc)

TRect rct = GetClientRecto;
rct.Inflate(-2, 0);

if (!Iconized)
dc.DrawText(txt, strlen(txt), rct, DT_-WORDBREAK);

dc.MoveTo ( 10, 3 0);
dc.SelectObject (*BndSymPen); dc.LineTo (pwLengthX-10, 30 H;I dc.RestorePen 0
dc.SelectObject (*BndOpenPen); dc.LineTo (pwLengthX-10, pwLengthY-10 ); II dc.RestorePen 0;
dc.SelectObject (*BndMetalPen); dc.LineTo ( 10, pwLengthY-10 ); HI dc.RestorePen 0;
dc.SelectObject (*BndPeriodPen); dc.LineTo ( 10, 30 ) Idc.RestorePen 0
dc.RestorePen 0

-----------------------------------------------------
void TRegionGraphWin::DrawBounds ( TDC& dc)

dc.MoveTo ( pwLeft, pwTop)
dc.SelectObject (*Pen (pwTopBnd));

dc.LineTo ( pwLeft+pwLengthX, pwTop) dc.RestorePen 0
dc.SelectObject (*Pen (pwRightBnd));

dc.LineTo (pwLeft+pwLengthX, pwTop+pwLengthY); dc.RestorePen 0;
dc.SelectObject (*Pen (pwBottomBnd));

dc.LineTo (pwLeft, pwTop+pwLengthY); dc.RestorePen 0



dc.SelectObject (*Pen (pwLeftBnd));
dc.LineTo ( pwLeft, pwTop) dc.RestorePen 0;

H --------------------------------------------------
void TRegionGraph Win: :DrawAxis ( TDC& dc)

char txt [20];
dc.SetTextAlign (TACENTER I TATOP);

1* H(m) */ sprintf (txt,"%s (%s)", cwXname, cwXunits);
dc.TextOut (pwLeft+pwLengthXl2, pwTop+pwLengthY+22, txt, strlen(txt));

1* -5.0 */ sprintf (txt, cwXfhnt, rwOrgX);
dc.TextOut (pwLeft+1, pwTop+pwLengthY+ 10, txt, strlen(txt));

/* 10.0 */ sprintf (txt, cwXfint, rwEndX);
dc.TextOut (pwLeft+pwLengtbX- 1, pwTop+pwbengthY+ 10, txt, strlen(txt));

/* 0 */ if (rwOrgX*rwEndX < 0.0)
dc.TextOut (Icx(0.0), pwTop+pwLengthY+1 0, "10.0"1, 3);

dc. SetTextAlign (TALEFT I TA BASELINE )
1* V */ sprintf (txt,"%s", cwYname);

dc.TextOut (pwLeft+pwLengthX+24, pwTop+pwLengthY/2, txt, strlen(txt));
1* (in) */ sprintf (txt,"(%s)", cwYunits);

dc.TextOut (pwLeft+pwLengthX+ 18, pwTop+pwLengthYf2+ 16, txt, strlen(txt));
dc. SetTextAlign (TA RIGHT I TABASELINE)

/* -1 */ sprintf (txt, cwYfint, rwOrgY);
dc.TextOut (pwLeft-3, pwTopH-pwLengthY-4, txt, strlen(txt));

1* 1 */ sprintf (txt, cwYfint, rwEndY);
dc.TextOut (pwLeft-3, pwTopH-2, txt, strlen(txt));

1* 0 */ if (rwOrgY*rwEndY < 0.0)
dc.TextOut (pwLeft-3, Icy(0.0), "0.0", 3);

dc.SetTextAlign (TACENTER I TA BASELINE I TA-NOUPDATECP);

---------------------------------------------------
void TRegionGraphWin::DrawMesh (TDC& dc)

int i;
dc.SelectObject (*MeshPen);

for ( i= 1; i < pwNy; i++)
{ dc.MoveTo (pwLeft, Icy (rwOrgY + i*rwHy))

dc.LineTo ( pwLeft+pwLengtbX, Icy (rwOrgY + i*rwHy))

for (i= 1; i <pwNx; i++)
{ dc.MoveTo ( Icx (rwOrgX + i*rwHx), pwTop)

dc.LineTo ( Icx (rwOrgX + i*rwHx), pwTop+pwLengthY)

dc.RestorePen 0

---------------------------------------------------
void TRegionGraphWin::DrawComments ( TDC& dc)

I
char txt [20];
TRect rct (0, 0, pwLeft+pwRight+pwLengtbX, pwTop/2);

strcpy (txt, string (*GetModule0, ids boundary00+pwTopBnd).c -str0)
dc. SetTextColor ( BndColor (pwTopBnd) ); HI Top

dc.TextOut (pwLeft+(pwLengthXf2), pwTop, txt, strlen(txt));



strcpy (txt, string (* GetModuleo, ids boundaryOO+pwBottomBnd).c -str0)
dc.SetTextColor ( BndColor (pwBottomBnd) ); HI Bottom

dc.TextOut (pwLeft+pwbengthX/2, pwTop+pwLengthY+1 0, txt, strlen(txt));
dc.SetTextAlign (TALEFT I TABASELINE);

strcpy (txt, string (*GetModule0, ids -boundaryOO+pwLeftBnd).c _str0)
dc. SetTextColor ( BndColor (pwLeftBnd) ); HI Left

dc.TextOut (2, pwTop+pwLengthY/2- 16, txt, strlen(txt));
strcpy (txt, string (*GetModule0, ids boundaryO0+pwRightBnd).c -str0)
dc. SetTextColor ( BndColor (pwRightBnd) ); HI Right

dc.TextOut (pwLeft+pwLengthX- 12, pwTop+pwLengthY/2- 16, txt, strlen(txt));
HI dc.SetTextAlign (TA.CENTER);

II dc.SetTextColor (NamneCir);
/Idc.ExtTextOut (1, 1, ETO OPAQUE, &rct, cwName, strlen(cwName));

---------------------------------------------------
void TRegionGraphWin::Paint ( TDC& dc, BOOL erase, TRect& rect)

TLinesGraphWin::Paint (dc, erase, rect);
dc.SetBkMode (TRANSPARENT);
dc.SetBkColor (RGB(0,0,0));
dc.SetTextAlign (TA CENTER I TA-BASELINE ITANOUPDATECP);
dc.SetTextColor ( TextClr)

if (!Iconized)

HI DrawBounds ( dc)
HI DrawAxis ( dc );
HI DrawMesh ( dc );

if (Decorated) DrawComments (dc)

1* PSPLOTS.H *
H/ Plot Element objects header

#iffidefPSPLOTSH
#define _PSPLOTSH

#include <owl\point.h>

#include "ps~phval.h"
#include t'ps,.reg.h"
#include "psidres.rh"

class -OWLCLASS TDC;
class _ OWLCLASS TPen;
class _ OWLCLASS TStatic;
struct TFrameStruct;
class _OWLCLASS TWindow;

* ----- TBasePlot ---------------------------------------

class TBasePlot
I
protected:



int pwXl1, pwYl; HI Viewport Org coord rel Window
hit pwX2, pwY2; H/ Viewport End coord rel Window
int pwLengthX, pwLengthY; HI Viewport Size
num rwScaleX, rwScaleY;
num rwSizeX, rwSizeY;
num rwStepX, rwStepY;
num rwOrgX, rwOrgY; H/ Phys limits in
num rwEndX, rwEndY; HI physical units

public:
TBasePlot ( TRect& x, TBasePlot* p = 0)
TBasePlot ();

virtual -TBasePlot ()
int id;
char ClassName [80];

protected:
int Icx (num x) { return(int)(rwScaleX*(x -rwOrgX)+pwXI); };
int Icy (num y) { return(int)(rwScaleY*(rwEndY -y)+pwY 1); };
nurn Xci (int i) { return(rwOrgX +rwStepX*(i-pwXl)); };
num Yci (int i) { return(rwEndY -rwStepY*(i-pwYl)); };

public:
virtual void ScaleTo ( int Xs, int Ys)
virtual void Draw (TDC &dc) {}
virtual void Erase (TDC & dc) {}

void Adjust ( int Adj = 0)
virtual void IdClassMessage ();
virtual void Privatelnfo (char* info) {}

BOOL Static;
TBasePlot * next;

long Color;
TPen * Pen;

DECLARECASTABLE;

/*'--- TTextPlot ----------------------------------------
class TTextPlot : public TBasePlot

char Text [LNGHCOMMENT];
TStatic * sctl;

int Htxt, Ltxt;
public:

TTextPlot (char*' text, TRect& x, TBasePlot* p = 0)
TTextPlot (TWindow* parent, TBasePlot* p = 0 );

virtual -TTextPlot () f if (sctl) delete sctl; TBasePlot: :-TBasePlot 0; }

virtual void Draw (TDC & dc)
virtual void Erase( (TDC & dc)
virtual void Privatelnfo (char* info);

DECLARECASTABLE;

/*'--- TAxisPlot ----------------------------------------
class TAxisPlot : public TBasePlot



public:
axis * Axe;
int Orient;

protected:
int pwN; HI Axe Draw digits
char cwFmt [LNGH -FMT]; HI and its format
num rwSize, rwH;
char cwAname [LNGH -AXIS];
char cwUnits [LNGHUNITS];

public:
TAxisPlot (axis* e, TRect& x, int oni = 0, TBasePlot* p =0)

TAxisPlot (TWindow* parent, TBasePlot* p =0)
virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)
virtual void ScaleTo ( hit Xs, hit Ys)
virtual void Privatelnfo (char* info);

DECLARECASTABLE;

/*--- TBoundsPlot----------------------------------------
class TBoundsPlot : public TAxisPlot

public:
TBoundaryType * Bnd;

public:
TBoundsPlot ( axis* e, TRect& x, int on =0, TBasePlot* p =0)

virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)
virtual void PrivateInfo (char* info);

DECLARE-CASTABLE;

/*--- TLinesPlot ----------------------------------------
class TLinesPlot : public TBasePlot

protected:
TAbstrPhysVal * PhVal;

int pwN;
public:

TLinesPlot ( TAbstrPhysVal* e, TRect& x, TBasePlot* p =0)

TLinesPlot ( TWindow* parent, TBasePlot* p = 0)
virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)
virtual void PrivateInfo (char* info);

DECLARECASTABLE;

/*'--- TPointsPlot ----------------------------------------
class TPointsPlot : public TLinesPlot
I
public:



TPointsPlot ( TAbstrPhysVal* e, TRect& x, TBasePlot* p =0)
: TLinesPlot e, x, p){

virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)

DECLARECASTABLE;

/*~--- TFuncPlot -----------------------------------------
class TFuncPlot : public TLinesPlot

array A;
public:

TFuncPlot (TFunctionVal* e, TRect& x, TBasePlot* p =0)

TFuncPlot (TWindow* parent, TBasePlot* p = 0)
virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)

DECLARECASTABLE;

/*--- TAffayPlot -----------------------------------------
class TArrayPlot : public TLinesPlot

array A;
public:

TArrayPlot ( TGridVal* e, TRect& x, TBasePlot* p = 0)
TArrayPlot ( TWindow"' parent, TBasePlot* p = 0)

virtual void Draw (TDC & dc)
virtual void Erase (TDC & dc)

DECLARECASTABLE;

/ *- TFramePlot -----------------------------------------
class TFramePlot : public TBasePlot

I
protected:

int pwNx, pwNy; IAxis Draw digits
char cwXfmnt [LNGH -FMT]; HI and its format
char cwYfmnt [LNGHLFMT]; / fill
int pwMeshX, pwMeshY; HI Mesh Dimension
num rwHx, rwHy; Hf
char cwName [LNGH -TITLE];
char cwXname [LNGH AXIS];
char cwYname [LNGH -AXIS];
char cwXunits [LNGH_ UNITS];
char cwYunits [LNGH UNITS];

public:
TFramePlot (TFrameStruct* e, TRect& x, TBasePlot* p =0)

TFramePlot (TWindow* parent, TBasePlot* p = 0)
virtual -TFramePlot 0);

virtual void Draw ( TDC & dc)



virtual void Erase ( TDC & dc);
virtual void Privatelnfo (char* info);

protected:
long FramClr,

AxisCir,
MeshClr,
TextClr;

TPen * FramPen,
* AxisPen,
* MeshPen;

DECLARECASTABLE;

/*--- TRegionPlot -----------------------------------------
class TRegionPlot : public T~asePlot

public:
TAbstrRegion * Rgn;

protected:
int pwNx, pwNy; HI Axis Draw digits
char cwXfmnt [LNGH -FMT]; HI and its format
char cwYfmnt [LNGHLFMT]; H
numn rwHx, rwHy; HI
char cwName [LNGH TITLE];
char cwXname [LNGH -AXIS];
char cwYname [LNGH AXIS];
char cwXunits [LNGHIJ NITS];
char cwYunits [LNGH LUNITS];

public:
TRegionPlot ( TAbstrRegion* e, TRect& x, TBasePlot* p =0)

TRegionPlot ( TWindow"' parent, TBasePlot* p =0)

virtual ~-TRegionPlot 0);

virtual void Draw ( TDC & dc)
virtual void Erase( (TDC & dc)
virtual void PrivateInfo (char* info);

protected:
TPen* BndPen (TBoundaryType ind);
long BndColor (TBoundaryType ind);

protected:
long BndOpenClr,

BndMetalClr,
BndSymClr,
BndPeriodClr;

TPen * BndOpenPen,
* BndMetalPen,
* BndSymPen,
* BndPeriodPen;

private:
int pwMeshX, pwMeshY; HI Mesh Dimension

TBoundaryType pwLeftBnd, pwRightBnd, HI
pwTopBnd, pwBottomBnd; I



DECLARECASTABLE;

/*--- TMeshPlot /------------------------------

class TMeshPlot : public TRegionPlot
{
public:

TAbstrMesh * Mesh;
TMeshPlot ( TAbstrMesh* e, TRect& x, TBasePlot* p = 0);
TMeshPlot ( TWindow* parent, TBasePlot* p = 0);

virtual void Draw ( TDC & dc);
virtual void Erase ( TDC & dc);
virtual void Privatelnfo (char* info);

DECLARECASTABLE;

/* ------- TPlotsList ------------------------------ *

class TPlotsList

TBasePlot * First;
public:

TPlotsList 0: First ( 0) { Ne = 0; };
TPlotsList (TBasePlot * frst);

-TPlotsList 0;
void Ins ( TBasePlot * Plot);
void Del ( TBasePlot * Plot);
void Del ( it k );
void ScaleTo ( int Xs, int Ys);
void Draw ( TDC & dc, BOOL NonStaticOnly = 1);
void Redraw ( TDC & dc, BOOL NonStaticOnly 1);
void Revision ( BOOL NonStaticOnly = 0);
int Element ( char* item, int k);

int Ne;
private:

void ForEach ( void (*Procedure) (TBasePlot *));

// Structures for Transfer Data between Dialog, Plot and Base classes

struct TAxisStruct
{
TAxisStruct (;
TAxisStruct (axis & A);
void GetData ( axis & A);

char svName [LNGH AXIS]; //chr.
char svOrg [LNGH FLOAT]; H num.
char svEnd [LNGHFLOAT]; H num.
char svN [LNGHINT]; H int. Axis Draw digits
char svM [LNGHINT]; H int. Axis Draw mesh
char svFmt [LNGHFMT]; H chr. and its format



char svH [LNGH -FLOAT]; HI num.
char svUnits [LNGH UNITS]; HI chr.
char svXlI [LNGHJ- NT]; H int. Win coords in pics
char svYlI [LNGHI- NT]; HI int."
char svX2 [LNGH -INT]; // int."
char svY2 [LNGH-INT]; HI int."

struct TFrameStruct
I
TFramieStruct 0
TFrameStruct (axis & Hrz, axis & Vrt)
void GetData (axis & Hrz, axis & Vrt)

TAxisStruct X;
TAxisStruct Y;
char svName [LNGH TITLE];

---------------------------------------------------------
#endif HI ifnidefPSPLOTSH
H/ ********* PSPLOTS.CPP *****

#if defined CSPRTPLOTS PCH)

#pragma hdrfile "d:\picsim\obj\_plots.csm"
#include <stdlib.h>
#include <stdio.h>
#include <math.h>
#include <typeinfo.h>
#include <owl\dialog.h>
#include <owl\checkbox.h>
#include <owl\static.h>
#include <owl\combobox.h>
#include <owl\edit.h>
#include <owl\groupbox.h>
#include <owl\radiobut.h>
#include <owl\dc.h>
#include <owl\framewin.h>
#include <owl\applicat.h>

#pragma hdrstop

#else

#pragma hdrfile "f.\picsim\obj\.allpch.csm"
#defme _ALLPCH
#include <_-allpch.h>

#pragma hdrstop

#endif

#include "ps-idres.rh"
//#include "ps_menul1.rh"
#include "ps,_strOl .rh"
#include "ps,_digO 1.rh"



#include "ps~phval.h"

#include "ps~mesh.h"

#include "psj~ilots.h"

f/f/I/II//I/,II////IIII/f//,/If/I/ Il/I//I/I~

stutTTextPlotStr

char svText [LNGH -COMMENT];
char svX [5], svY [5];
BOOL svAxl, svAxc, svAx2;
BOOL svAyl, svAyc, svAy2;
char svR [4], svG [4], svB [4];

TTextPlotStr:: TTextPlotStr 0

svText [0] = 0; strcpy (svX, "5"); strcpy (svY, "5");
strcpy (svR, "255"); strcpy (svG, "255"); strcpy (svB, "255");

svAxlI = svAx2 = svAyc = svAy2 = 0; svAxc = svAylI = 1;

-----------------------------------------------------
class TTextPlotDlg: public TDialog

public:
TTextPlotDlg (TWindow* p, TTextPlotStr & ts, int resld = iddPlot0 1);

TTextPlotDlg :: TTextPlotDlg (TWindow* p, TTextPlotStr & ts, lint resld)
TDialog (p, resld)

new TEdit (this, idc editO 1, LNGHCOMMENT);
new TEdit (this, idc-edit02, 5);
new TEdit (this, idc-edit03, 5);

TGroupBox * ivGroup I = new TGroupBox (this, idc~grouplI);
new TRadioButton (this, idc-radiolI ivGrouplI);
new TRadioButton (this, idc-radio2, ivGroupl);
new TRadioButton (this, idc-radio3, ivGroup 1);

TGroupBox * ivGroup2 = new TGroupBox (this, idc~group2);
new TRadioButton (this, idc -radio4, ivGroup2);
new TRadioButton (this, idc_radio5, ivGroup2);
new TRadioButton (this, idc-radio6, ivGroup2);

new TEdit (this, idc -edit04, 4);
new TEdit (this, idcedit&05, 4);
new TEdit (this, idc-edit06, 4);

TransferBuffer = (void far*)&ts;

IMPLEMENTCASTABLEl (TBasePlot, TWindow);



IMPLEMENTCASTABLEl (TTextPlot, TBasePlot);
IMPLEMENTCASTABLEl (TAxisPlot, T~asePlot);
IMPLEMENTCASTABLEl (TLinesPlot, TBasePlot);
IMPLEMENTCASTABLEl (TRegionPiot, T~asePlot);
IMPLEMENTCASTABLEl (TFramePlot, TBasePlot);

IMPLEMENTCASTABLEl (TBoundsPlot, TAxisPlot);
IMPLEMENTCASTABLEl (T~ointsPlot, TLinesPlot);
IMPLEMENTCASTABLEI (TFuncPlot, TbinesPlot);
IMPLEMENTCASTABLEI (TArrayPlot, TLinesPlot);
IMPLEMENTCASTABLEI (TMeshPlot, TRegionPiot);

I********TBasePlot------------------------------------
static int PlotsCount = 0;
---------------------------------------------------

TBasePlot :: TBasePlot ( TRect& x, TBasePlot* p)
:next ( p ), Static (1I)

{pwXl =x.left; pwX2 = x.right; pwLengthX = pwX2 - pwXl;
pwYl =x.top; pwY2 x.bottom; pwLengthY =pwY2 -pwYl;

Color = RGB ( 255, 255, 255)
Pen = new TPen (Color);

rwScaleX = rwSizeX = rwStepX = rwOrgX = rwEndX = 0.0;
rwScaleY = rwSizeY = rwStepY = rwOrgY = rwEndY = 0.0;

id = ++PlotsCount;
strcpy (ClassName,"Abstract Base Plot");

---------------------------------------------------
TBasePlot:: TBasePlot ( )
{next = ; Static =1;

pwXl= 0; pwX2 =100; pwLengthX =pwX2 -pwXl;

pwYl =0; pwY2 =100; pwLengthY =pwY2 -pwYl;

Color = RGB (255, 255, 255);
Pen = new TPen (Color);

rwScaleX = rwSizeX = rwStepX = rwOrgX = rwEndX = 0.0;
rwScaleY = rwSizeY = rwStepY = rwOrgY = rwEndY = 0.0;

id = ++PlotsCount;
strcpy (ClassName,"Abstract Base Plot");

---------------------------------------------------
TBasePlot ::-TBasePlot () I delete Pen; );

---------------------------------------------------
void TBasePlot:: ScaleTo ( it Xs, hit Ys)
I

if (Xs > 0) 1 pwLengthX = Xs; pwX2 = pwXlI + pwLengthX;}
if (Ys > 0) { pwLengthY = Ys; pwY2 = pwYlI + pwLengthY;}

rwScaleX = (rwSizeX > 0.0) ? (pwLengthX/rwSizeX) -1;
rwStepX = I .O/rwScaleX;

rwScaleY =(rwSizeY > 0.0) ? (pwLengthY/rwSizeY) -1;
rwStepY = I.0/rwScaleY;

---------------------------------------------------
void TBasePlot ::Adjust ( hit Adj)

switch ( AdJ)



{case 0:
{ rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;

pwLengthX = pwX2-pwXl; if (pwLengthX <= 0) {pwLengthX=pwX2=l00; pwXl=0;}
pwLengthY = pwY2-pwYl1; if (pwLengthY <= 0) {pwLengthY=pwY2= 100; pwYl1=0;}

if (rwSizeX <= 0.0) { rwSizeX=1 .0; rwOrgX=0; rwEndX = rwOrgX+rwSizeX; }
if (rwSizeY <= 0.0) 1 rwSizeY=1 .0; rwOrgY=0; rwEndY = rwOrgY+rwSizeY; }

rwScaleX =pwLengthX/rwSizeX; rwScaleY = pwLengthYfrwSizeY;
rwStepX =1 .0/rwScaleX; rwStepY = 1 .0/rwScaleY;
rwScaleX =(rwSizeX > 0.0) ? (pwLengthX/rwSizeX) -1;
rwStepX =1 .0/rwScaleX;
rwScaleY =(rwSizeY > 0.0) ? (pwLengthY/rwSizeY) : 1;
rwStepY =1.0/rwScaleY; break;

default:
( rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;

pwLengthX = pwX2-pwXl1; if (pwLengthX <= 0) {pwLengthX=pwX2= 100; pwXlI=0;}
pwLengthY = pwY2-pwYl1; if (pwLengthY <= 0) {pwLengthY=pwY2= 100; pwYlI=0;}

if (rwSizeX <= 0.0) {rwSizeX=1 .0; rwOrgX=0; rwEndX = rwOrgX+rwSizeX; )
if (rwSizeY <= 0.0) {rwSizeY=l .0; rwOrgY=0; rwEndY = rwOrgY+rwSizeY; )

rwScaleX = pwLengthX/rwSizeX; rwScaleY = pwLengthY/rwSizeY;
rwStepX = 1 .0/rwScaleX; rwStepY = 1 .0/rwScaleY;
rwScaleX = (rwSizeX >0.0) ? (pwLengthXlrwSizeX) : 1;
rwStepX = l.0/rwScaleX;

rwScaleY = (rwSizeY > 0.0) ? (pwLengthY/rwSizeY) : 1;
rwStepY = 1.0/rwScaleY;

---------------------------------------------------
void TBasePlot :: IdClassMessage (

char txt [255],
buf [ 80],

captio[ 20];
strcpy (txt, "Client work area:\n");

sprintf (buf," X1 = %d, X2 = %d, Length X = %d\n", pwXl, pwX2, pwbengthX);
strcat (txt, but);

sprintf (buf," YI = %d, Yl = %d, Length Y = %d\n", pwYl, pwY2, pwLengthY);
strcat (txt, but);
strcat (txt," Phys. Area: \n");

sprintf (buf," xl = %.2f, x2 = %.2f, Size X = %.2f, l/hx = %.2f, hx = %2~"
rwOrgX, rwEndX, rwSizeX, rwScaleX, rwStepX);

strcat (txt, but);
sprintf (buf," yl = %.2f, y2 = %.2f, Size Y = %.2f, 1/hy = %.2f, hy = %2~"

rwOrgY, rwEndY, rwSizeY, rwScaleY, rwStepY);
strcat (txt, but);
strcat (txt," Private info: \n");

PrivateInfo ( buf ); strcat (txt, but);
itoa ( id, buf, 10 ); strcpy (captio, but); strcat (captio,"

strcat (captio, ClassName);
::MessageBox (0, txt, captio, MB ICONINFORMATION IMBOK);

I********TrextPlot------------------------------------



H I-------------------- -----------------
TTextPlot :: TTextPlot ( char*~ text, TRect& x, TBasePlot* p)

TBasePlot ( x, p)

strcpy (Text, text); Htxt = 16; Ltxt = strien (Text);
pwX2 = pwXlI + 8*Ltxt; pwLengthX = pwX2 - pwX I;
pwY2 =pwY + Htxt; pwLengthY =pwY2 -pwYl;

strcpy ( ClassName, typeid (this).nameo)

H -------------------------------------------------------
TTextPlot ::TTextPlot ( TWindow* parent, TBasePlot* p)

TBasePlot (

strcpy (Text, " text") Htxt = 16; Ltxt = strien (Text);
TTextPlotStr tds;

if ( TTextPlotDlg (parent, tds).Execute 0IDOK)
f

strcpy (Text, tds.svText);
Htxt = 16; Ltxt = strien (Text);

pwXl = atoi (tds.svX); pwX2 = pwXl + 8*Ltxt; pwLengthX =pwX2 - pwXl;
pwY 1 = atoi (tds.svY); pwY2 = pwY 1 + Htxt; pwLengthY pwY2 - pwY 1;

Color = RGB (atoi(tds.svR), atoi(tds.svG), atoi(tds.svB));
delete Pen; Pen = new TPen (Color);

strcpy ( ClassName, typeid (this).nameo)

--------------------------------------------------------
void TTextPlot:: Draw (TDC & dc)

dc.SelectObject (*Pen);
dc.SetTextAlign (TACENTER I TATOP);
dc.TextOut (pwXl+pwLengthX/2, pwYl, Text, Ltxt);
dc.RestorePen 0

H ------------------------------------------------
void TTextPlot ::Erase ( TDC & dc)

-------------------------------------------------
void TTextPlot: Privatelnfo (char* info)
I char buf [80];
sprintf (buf," Text = %s, H = %d, L = %d\n", Text, Htxt, Ltxt);
strcpy (info, but);

/*1 ****** ;i~ot-----------*
I,------------ ---------------------------------

TAxisPlot :: TAxisPlot ( axis * e, TRect& x, int ori TBasePlot* p)
TBasePlot ( x, p ), Axe (e)

Orient = (Axe != NULL) ? or: -1;
switch ( or)

case 0 /*-- horizontal ---
rwOrgX = e->org; rwOrgY = 0.0;



rwEndX =e->end; rwEndY 1 1.0;
Color =RGB (255, 0, 0) break;

case 1 : I"'---- vertical ---
rwOrgX =0.0; rwOrgY = e->org;
rwEndX =1.0; rwEndY = e->end;

Color =RGB (0, 25 5, 0 ); break;
case 2 : I"'---- arbitrary ----"

rwOrgX =0.0; rwOrgY =e->org;

rwEndX =1.0; rwEndY =e->end;

Color =RGB (0, 0, 255) break;
default:

rwOrgX= 0.0; rwOrgY =0.0;

rwEndX= 1.0; rwEndY =1.0;

Color =RGB (127, 127, 127 );
::MessageBox (O,"Axis NULL pointer","Error",MB OK);

pwXl = x.left+2; pwX2 = x.right-2;
pwYl = x.boftom-2; pwY2 = x.bottom+2;

rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;
if (rwSizeX <= 0.0) rwSizeX = 1.0;
if (rwSizeY <= 0.0) rwSizeY = 1.0;

rwScaleX = pwLengtbXlrwSizeX; rwScaleY = pwbengthY/rWSizeY;
rwStepX = 1 .0/rwScaleX; rwStepY = 1 .0/rwScaleY;

delete Pen; Pen = new TPen (Color);
strcpy (cwAname, e->name); strcpy (cwUnits, e->units);

pwN = ((e->N > 0)&&(e->N < 15 1)) ? (e->N) : 1;
switch ( Orient)

f
case 0: rwSize = rwSizeX; break;
case 1: rwSize = rwSizeY; break;
case 2: rwSize = sqrt(rwSizeY*rwSizeY + rwSizeX*rwSizeX); break;
default: rwSize = 1.0;

I
rwH =rwSize /pwN;

strcpy (cwFmt, "%.2f');
strcpy ( ClassName, typeid (this).nameo)

* .MessageBox (0,"ClassName defmned","Infb",MB OK);
IdClassMessage 0

H -------------------------------------------------------
TAxisPlot :: TAxisPlot ( TWindow * parent, TBasePlot* p)

TBasePlot ()
{Axe NULL;

Orient= -1;
rwOrgX = 0.0; rwOrgY =0.0;

rwEndX = 1.0; rwEndY =1.0;

Color = RGB ( 127, 127, 127)
rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;
rwScaleX =pwLengthXlrwSizeX; rwScaleY = pwLengthY/rwSizeY;
rwStepX =1 .0/rwScaleX; rwStepY = 1 .0/rwScaleY;

delete Pen; Pen = new TPen (Color);
strcpy (cwAname," e->name "); strcpy (cwUnits," e->units");

pwN=1; rwSize = 1.0;
rwH =rwSize / pwN;



strcpy (cwFmt, "%.2f');
* .MessageBox (0,"Axis NULL pointer", "Error" ,MB OK);

strcpy ( ClassName, typeid (this).nameo );
* .MessageBox (0,"ClassName defined","Info",MB-OK);
IdClassMessage 0

H -------------------------------------------------------
void TAxisPlot :: Draw ( TDC & dc)
{num x =rwOrgX;

num y =rwOrgY;

dc.SelectObject (*Pen);
dc.MoveTo (pwXl, pwYl)
dc.LineTo (pwX2, pwY2)

for (int i--1; i <pwN; i++)

dc.MoveTo ( Icx ( x), Icy (y))
II dc.LineTo ( Icx ( x), Icy (y))

x+=rwSizeX/pwN;

dc.RestorePen 0

-------------------------------------------------
void TAxisPlot :: Erase ( TDC & dc )

I Draw( dc);}

void TAxisPlot :: ScaleTo ( int Xs, int Ys)

TBasePlot :: ScaleTo (Xs, Ys)
switch ( Orient)

I
case 0: rwSize = rwSizeX; break;
case 1: rwSize = rwSizeY; break;
case 2: rwSize = sqrt(rwSizeY*rwSizeY + rwSizeX*rwSizeX); break;
default: rwSize = 1.0;

-------------------------------------------------
void TAxisPlot :: PrivateInfo (char* info)
I char buf [80];
sprintf (buf," Name = %s, N = %d, h = %.3f, Fmt = %s, Orient =%d \n",

cwAname, pwN, rwH, cwFmt, Orient);
strcpy (info, buf);
I/if (Axe) strcpy (buf, typeid (Axe).name0);
IH else strcpy (buf, "NULL pointer");
H/ strcat (info,"Axe: "); strcat (info, but);

STBoundsPlot ----------------------------------
--------------------------------------------------------

TBoundsPlot :: TBoundsPlot ( axis * e, TRect& x, int ori TBasePlot* p)
:TAxisPlot ( e, x, oni, p )

{ strcpy ( ClassName, typeid (this).nameo)

--------------------------------------------------------



void TBoundsPlot: Draw ( TDC & dc)

dc.SelectObject (*Pen);
dc.RestorePen 0

---------------------------------------------------
void TBoundsPlot ::Erase ( TDC & dc)

{ Draw( dc); }
---------------------------------------------------

void TBoundsPlot :: Privatelnfo (char* info)
{char buf [80];

TAxisPlot :: PrivateInfo ( info)
sprintf (buf," BounaryType: %d\n", (int)Bnd);
strcat (info, buf);

/*********TinesPlot------------------------------------

----------------------------------------------------------
TLinesPlot :: TLinesPlot ( TAbstrPhysVal * e, TRect& x, TBasePlot* p)

TBasePlot ( x, p ), PhVal (e)
{if (e)

I rwOrgX =e->Org; rwOrgY =e->Min;

rwEndX =e->End; rwEndY =e->Max;

else
{rwOrgX =0.0; rwOrgY =0.0;

rwEndX =10.0; rwEndY =10.0;

::MessageBox (0,"PhysVal NULL pointer", "Error",MB_OK);

rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;
if (rwSizeX <= 0.0) rwSizeX = 1.0;
if (rwSizeY <= 0.0) rwSizeY = 1.0;

rwScaleX = pwLength~rwSizeX; rwScaleY = pwLengthY/rwSizeY;
rwStepX = 1 .0/rwScaleX; rwStepY = I .0/rwScaleY;

Color =RGB ( 255, 255, 255)
Pen =new TPen (Color);

Static = 0;
strcpy ( ClassName, typeid (this).name0)

----------------------------------------------------------
TLinesPlot :: TLinesPlot ( TWindow * parent, TBasePlot* p)

T~asePlot (), PhVal (0)

strcpy ( ClassName, typeid (this).namneo)

----------------------------------------------------------
void TLinesPlot ::Draw ( TDC & dc)

char txt "I ="D "

double d, w, a, h;
num x, y;

h = rwSizeX IpwLengthX;
a = rwSizeY *0.25;

w = 6.28 * 8 IrwSizeX;



dc.MoveTo (pwXlI, Icy (0.0));
dc.SelectObject (*Pen);

for ( int H1; i < pwLengthX; i++)
{~ a*= 0.9;

x = num (rwOrgX + i * h);
y =num (a * sin (w * x)

dc.LineTo ( Icx ( x ), Icy ( y))

dc.RestorePen 0

//-------------------------------------------------
void TbinesPlot :: Erase ( TDC & dc)
f
char txt [I ='D "

double d, w, a, h;
num x, y;

h =rwSizeX IpwLengthX;
a = rwSizeY *0.25;

w = 6.28 * 8 IrwSizeX;
dc.MoveTo (pwXl, Icy (0.0));

dc.SelectObject (*Pen);
for ( int i--1; i < pwLengthX; i++)

{ a*= 0.9;
x = num (rwOrgX + i * h);
y = num (a * sin (w * x)

dc.LineTo ( Icx ( x), Icy (y))

dc.RestorePen 0

-------------------------------------------------
void TLinesPlot :: PrivateInfo (char* info)
f char buf [80];
sprintf (buf," N = %d\n", pwN);
strcpy (info, buf);
strcpy (buf, typeid (PhVal).name0);
strcat (info, "PhysVal: "); strcat (info, buf);

I********TPointsPlot ----------------------------------
--------------------------------------------------------

void TPointsPlot ::Draw ( TDC & dc)
f num x =rwOrgX;

num y =rwOrgY;

dc.SelectObject (*Pen);
dc.MoveTo (pwXl, pwYl)

for(inti=I; i<pwN; i++)

dc.MoveTo ( Icx ( x), Icy (y))
HI dc.LineTo (Icx ( x),Icy (y ))

x+=rwSizeX; I/pwN;

dc.RestorePen 0

-------------------------------------------------



void TPointsPlot :: Erase ( TDC & dc)
f Draw( dc);}

I********TFuncPlot ----------------------------------
--------------------------------------------------------

TFuncPlot :: TFuncPlot ( TFunctionVal* e, TRect& x, TBasePlot* p)
TLinesPlot ( e, x, p)

strcpy ( ClassName, typeid (this).nameo)

--------------------------------------------------------
TFuncPlot :: TFuncPlot ( TWindow * parent, TBasePlot* p)

TLinesPlot ( parent, p)

strcpy ( ClassName, typeid (this).nameo)

--------------------------------------------------------
void TFuncPlot: Draw (TDC & dc)
{num x =rwOrgX;

num y =rwOrgY;

dc.SelectObject (*Pen);
dc.MoveTo (pwXl, pwYl);

for (int il-; i <pwN; i++)

dc.MoveTo ( Icx ( x), Icy ( y))
IIdc.LineTo (Icx ( x),Icy ( y )

x += rwSizeX; //pwN;

dc.RestorePen 0;

-------------------------------------------------
void TFuncPlot :: Erase ( TDC & dc )

{ Draw( dc);}

I********TArrayPlot ----------------------------------
--------------------------------------------------------

TArrayPlot :: TArrayPlot ( TGridVal* e, TRect& x, TBasePlot* p)
TLinesPlot ( e, x, p)

H{ ra -dte>Ms-N1 -Ms-N
HI array A mti ( e->data, e->Mesh->N 1, e->Mesh->N2))ro;()

strcpy ( ClassNamne, typeid (this).name0)

--------------------------------------------------------
TArrayPlot :: TArrayPlot ( TWindow * parent, TBasePlot* p)

TLinesPlot ( parent, p)

strcpy (ClassName, typeid (this).nameo)

--------------------------------------------------------
void TArrayPlot ::Draw ( TDC & dc)
{num x=rwOrgX;
numn y=rwOrgY;

dc.SelectObject (*Pen);



dc.MoveTo (pwXl, pwYl)
for (int i=l; i <pwN; i++)

dc.MoveTo ( Icx ( x), Icy (y))
HI dc.LineTo ( Icx ( x), Icy ( y ))

x+=rwSizeX; //pwN;

dc.RestorePen 0

-------------------------------------------------
void TArrayPlot ::Erase ( TDC & dc )

{ Draw( dc);}

/********TFramePlot --------------------------------- *
--------------------------------------------------------
TFramePlot :: TFramePlot ( TFrameStruct* e, TRect& x, TBasePlot* p)

:TBasePlot (x, p
{char * erp;

FramClr = RGB ( 0, 0, 255)
AxisCir =RGB (255, 0, 0);
MeshClr =RGB (127, 255, 0);
TextClr = RGB (0, 127, 127 );

FramPen =new TPen (FramClr, 1, PS_-DASH);
AxisPen =new TPen (AxisCir, 2, PS_-SOLID);
MeshPen = new TPen (MeshClr, 1, PS_-DASHDOT);

pwMeshX = atai (e->X.svM); pwMeshY = atoi (e->Y.svM);
pwNx = atoi (e->X.svN); pwNy = atoi (e->Y.svN);

strcpy (cwXname, e->X.svName); strcpy (cwYname, e->Y.svName);
strcpy (cwXunits, e->X.svUnits); strcpy (cwYunits, e->Y.svUnits);
strcpy (cwXfmnt, e->X.svFmt); strcpy (cwYfmnt, e->Y.svFmt);

strcpy (cwName, e->svName);
rwOrgX = (num) strtod (e->X.svOrg, &erp)
rwEndX = (num) strtod (e->X.svEnd, &erp)
rwOrgY = (num) strtod (e->Y.svOrg, &erp)
rwEndY = (num) strtod (e->Y.svEnd, &erp)

rwSizeX = rwEndX - rwOrgX; rwSizeY = rwEndY - rwOrgY;
if (rwSizeX <= 0.0) rwSizeX = 1.0;
if (rwSizeY <= 0.0) rwSizeY = 1.0;

rwScaleX = pwLengthXlrwSizeX; rwScaleY = pwLengthY/rwSizeY;
rwStepX = I .0/rwScaleX; rwStepY = I .O/rwScaleY;
rwHx = rwSizeXlpwMeshX; rwHy = rwSizeY/pwMeshY;

strcpy ( ClassName, typeid (this).nameo)

H -------------------------------------------------------
TFramePlot :: TFramePlot ( TWindow* parent, TBasePlot* p)

TBasePlot (

char * erp;
FramClr = RGB ( 0, 0, 255)
AxisCir =RGB (255, 0, 0);
MeshClr =RGB (127, 255, 0);
TextClr =RGB( 0, 127, 127 );

FramPen =new TPen (FramClr, 1, PS_-DASH);
AxisPen =new TPen (AxisCIr, 2, PSSOLID);



MeshPen = new TPen (MeshClr, 1, PS_-DASHDOT);
strcpy ( ClassName, typeid (this).nameo)

---------------------------------------------------
TFramePlot: -T~ramePlot ()

{ ~~TBasePlot ::--TBasePlot 0
delete FramPen; delete MeshPen; delete AxisPen;

---------------------------------------------------
void TFramePlot ::Draw ( TDC & dc)

dc.MoveTo (pwXl, pwYl)I
dc.SelectObject (*FrairPen);

dc.LineTo (pwXl+pwLengthX, pwYl);
dc.LineTo (pwXl+pwLengthX, pwYl+pwLengthY);
dc.LineTo (pwXl, pwYl+pwLengthY);
dc.LineTo (pwXl, pwY 1)

dc.RestorePen 0

-------------------------------------------------
void TFramnePlot :: Erase ( TDC & dc )

f Draw (dc);}
-------------------------------------------------

void TFramePlot :: PrivateInfo (char* info)
I char buf [80];
sprintf (buf,t9 Name = %s\n", cwName);
strcpy (info, but);

HI strcpy (buf, typeid (PhVal).name0);
HI strcat (info,"PhysVal: "); strcat (info, but);

I********TRegionPiot------------------------------------
--------------------------------------------------------
TRegionPiot ::TRegionPiot ( TAbstrRegion* e, TRect& x, TBasePlot* p)

TBasePlot ( x, p ), Rgn ( e)
{ Rgn =e;

TGeomAxis * hrz =Rgn >Xl 0;
TGeomAxis * vrt =Rgn ->X2 0

BndOpenClr = RGB (0, 0, 255)
BndMetalClr = RGB (255, 0, 0)
BndSymClr = RGB (127, 255, 0);
BndPeriodClr = RGB (0, 127, 127 );

BndOpenPen =new TPen (BndOpenClr I, PS_-DASH);
BndMetalPen =new TPen (BndMetalClr, 2, PS_ýSOLID);
BndSymPen =new TPen (BndSymClr, 1, PS_-DASHDOT);
BndPeriodPen =new TPen (BndPeriodClr 1, PS_SOLID);

if ((hrz) && (vrt))

rwOrgX = hrz->org; rwOrgY =vrt->org;

rwEndX = hrz->end; rwEndY =vrt->end;

strcpy (cwXname, hrz->name); strcpy (cwYname, vrt->name);
strcpy (cwXunits, hrz->units); strcpy (cwYunits, vrt->units);

pwNx = ((hrz->N > 0)&&(brz->N < 51))? hrz->N -1;
pwNy = ((vrt->N > 0)&&(vrt->N < 5 1))? vrt->N -1;



pwMeshX = hrz->N; pwMeshY = vrt->N;
pwLeftBnd = TBoundaryType(hrz->bound 1); pwRightBnd = T~oundaryType (hrz->bound2);
pwBottomBnd = TBoundaryType(vrt->bound 1); pwTopBnd = TBoundaryType (vrt->bound2);

else
I
.:MessageBox (0,"Horiz Or Vert Axis NULL pointer","Error",MB OK);

rwOrgX = 0.0; rwOrgY = 0.0;
rwEndX =10.0; rwEndY = 10.0;

strcpy (cwXname, "Nif X"); strcpy (cwYname, "Mul Y11);
strcpy (cwXunits,"cm"); strcpy (cwYunits,"mn");

pwNx =-l1; pwNy=-1;
pwMeshX = 20; pwMeshY = 10;
pwLeftBnd = 1; pwRightBnd =3;
pwBottomBnd = 2; pwTopBnd =4;

}wx=(p~sX>0&(weh 51) weh 0
pwNx = ((pwMesbX > 0)&&(pwMeshX < 15 1))? pwMeshX:10;

rwHx = rwSizeX / pwNx; rwHy = rwSizeY / pwNy;
strcpy ( ClassName, typeid (this).narneo)

Adjust 0

--------------------------------------------------------
TRegionPiot :: TRegionPiot ( TWindow"' parent, TBasePlot* p)

TBasePlot (

strcpy ( ClassName, typeid (this).narne0)
Adjust 0

---------------------------------------------------
TRegionPiot :: -TRegionPlot ()

{ TBasePlot ::TBasePlot 0;
delete BndOpenPen; delete BndMetalPen;
delete BndSymPen; delete BndPeriodPen;

//--------------------------------------------------
long TRegionPiot :: BndColor ( TBoundaryType nd)

{ switch (ind)
{case ConductingBnd: return (BndMetalClr);
case OpenBnd: return (BndOpenClr);
case AxisymmetricBnd: return (BndSymClr);
case PeriodicBnd: return (BndPeriodClr);

default: return (Color);

---------------------------------------------------
TPen* TRegionPlot :: BndPen ( TBoundaryType ind)

{ switch (ind)
{case Conductingl~nd: return (BndMetalPen);
case OpenBnd: return (BndOpenPen);
case AxisymmetricBnd: return (BndSymPen);
case PeriodicBnd: return (BndPeriodPen);

default: return (Pen);



-------------------- ------------------
void TRegionPiot :: Draw ( TDC & dc)

dc.MoveTo (pwXl, pwYl)
dc.SelectObject (*BndPen (pwropBnd));

dc.LineTo ( pwXlI+pwLengthX, pwY 1) dc.RestorePen 0
dc.SelectObject (*BndPen (pwRightBnd));

dc.LineTo (pwXl+pwLengthX, pwYl+pwLengthY); dc.RestorePen 0;
dc.SelectObject (*BndPen (pwBottomBnd));

dc.LineTo (pwXl, pwYl+pwLengthY); dc.RestorePen 0
dc.SelectObject (*BndPen (pwLeftBnd));

dc.LineTo (pwXlI, pwY 1) dc.RestorePen 0

-------------------------------------------------
void TRegionPiot ::Erase (TDC & dc)

{Draw( dc);}
-------------------------------------------------

void TRegionPiot :: PrivateInfo (char* info)
f char buf [80];
sprintf (buf," Name = %s\n", cwName);
strcpy (info, buf);

HI strcpy (buf, typeid (Rgn).nameo);
HI strcat (info,"Rgn: "); strcat (info, buf);

/********TMeshPlot ----------------------------------
--------------------------------------------------------

TMeshPlot :: TMeshPlot ( TAbstrMesh* e, TRect& x, TBasePlot* p)
TRegionPiot ( (e->Rgn), x, p ), Mesh (e)

strcpy ( ClassName, typeid (this).name0)

--------------------------------------------------------
TMeshPlot :: TMeshPlot ( TWindow* parent, TBasePlot* p)

TRegionPiot ( parent, p)

strcpy ( ClassName, typeid (this).name0)

--------------------------------------------------------
void TMeshPlot :: Draw ( TDC & dc)
fint i;

dc.SelectObject (*Pen);
for ( i= 1; i < pwNy; i++)
{ dc.MoveTo (pwX I, Icy (rwOrgY + i*rwHy))

dc.LineTo ( pwXlI+pwLengthX, Icy (rwOrgY + i*rwHy))

for ( i=l1; i < pwNx; i++)
{ dc.MoveTo ( Icx (rwOrgX + i*rwHx), pwY 1)

dc.LineTo ( Icx (rwOrgX + i*rwHx), pwYlI+pwLengthY)

dc.RestorePen 0

-------------------------------------------------



void TMeshPlot :: Erase ( TDC & dc)
f Draw( dc);}

-------------------------------------------------
void TMeshPlot ::Privatelnfo (char* info)

{char buf [80];
TRegionPiot: Privatelnfo ( info)

sprintf (buf," Name = %s\n", cwName);
strcpy (info, but);
IH strcpy (buf, typeid (Rgn).namneo);
HI strcat (info,"Rgn: "); strcat (info, but);

HI

HI TPlotsList

TPlotsList :: TPlotsList ( TBasePlot *frst)

f
First =frst; Ne = 1;

TBasePlot * p =First;

while ( p->next )
{p = p->next;

++Ne;

-------------------------------------------------
TPlotsList -TPlotsList (

TBasePlot *c, *p = First;
while (p )

{c = p; p = p->next;
delete c; --Ne;

-------------------------------------------------
void TPlotsbist :: Ins ( TBasePlot *Plot)

I
if (Ne ==0 ) First =Plot;

else
{ TBasePlot *p =First;

while ( p->next )p =p->next;

p->next = Plot;

Plot->next = 0; ++Ne;

-------------------------------------------------
void TPlotsList :: Del ( TBasePlot * Plot)

if (Ne == 0) return;
TBasePlot *c, * p First;
if (Plot != First)

{ while (p)
f if ((p->next) ==Plot)

{ c = p->next;



p->next = c->next;
delete c; --Ne; break;

}
p = p->next;
}

}
else

{ c = First->next;
delete First;

First = c; --Ne;
}

H -------------------------------------------------
void TPlotsList :: Del ( int k)

{
if ( Ne == 0 ) return;
TBasePlot *c, * p = First; intj = 1;
if(k != 1 )

{ while ( p)
{ if(k == ++j)

{ c = p->next;
p->next = c->next;

delete c; --Ne; break;
}

p = p->next;
I

I
else

{ c = First->next;
delete First;

First = c; --Ne;
I

};
/--------------------------------------------------------------
void TPlotsList:: ScaleTo ( int Xs, int Ys)
{
if( Ne == 0 ) return;

TBasePlot * plot = First;
while (plot)

{ plot -> ScaleTo ( Xs, Ys);
plot = (plot->next);

I

-------------------------------------------------
void TPlotsList :: Draw ( TDC & dc, BOOL NonStaticOnly)
{
if(Ne == 0 ) return;

TBasePlot * plot = First;
while (plot)

{
if (!(plot -> Static) II (!NonStaticOnly))

plot -> Draw ( dc );
plot = (plot->next);

}



----------------- -- --------------
void TPlotsbist :: Redraw ( TDC & dc, BOOL NonStaticOnly)

if( Ne== 0) return;
T~asePlot * plot = First;

while (plot)
I

if (!(plot -> Static) 11 (!NonStaticOnly))
{plot -> Erase (dc)
plot -> Draw (dc)

plot = (plot->next);

-------------------------------------------------
void TPlotsList ::Revision (BOOL NonStaticOnly)
{char txt [80];

if (NonStaticOnly) strcpy (txt," NonStatic")
else strcpy (txt," Certain")

strcat (txt, " Plots List")
if ( Ne 0 0)

{strcat (txt, "is Empty !");
::MessageBox (0, txt, "Revision", MBICONINFORMATION I MBOK);

return;

sprintf (txt," %s \n Ne = %d ", txt, Ne);
::MessageBox (0, txt, "Revision", MBICONINFORNMTION IMB _OK);

T~asePlot * plot = First;
while (plot)

if (!(plot -> Static) 11 (!NonStaticOnly))
plot -> IdClassMessage Q
plot = (plot->next);

-------------------------------------------------
int TPlotsList ::Element ( char"' item, int k)

int Res =0;
if( Ne== 0 return Res;

T~asePlot *p =First; inj = 0;
while (p)

{if(k==++j)
{sprintf (item,"%d:%s", p->id, p->ClassName);

Res =j; break;

p = p->next;

return Res;

-------------------------------------------------
void TPlotsList: ForEach ( void (*Procedure) (TBasePlot*)



if (Ne == 0) return;
TBasePlot * plot = First;

while ( plot )
{ ~Procedure ( plot)

plot = (plot->next);

II----------------------------------------------------
TAxisStruct :: TAxisStruct0

{int rx = 10;
svName [0] = 0;

sprintf ( svOrg, "%g", 0.0)
sprintf ( svEnd, "%g", 1.0)

itoa (10, svN, rx);
itoa (10, svM, rx);

strcpy ( svFmt, "%.2f')
sprintf ( svll, "%g", 0.1)

svUnits [0] = 0;
itoa(10, svXl, rx);
itoa( 10, svYl, rx);
itoa (90, svX2, rx);
itoa (90, svY2, rx);

HI----------------------------------------------------
TAxisStruct :: TAxisStruct ( axis & A)

{intrx = 10;
strcpy ( svName, A.name);

sprintf ( svOrg, "%g", A.org)
sprintf ( svEnd, "%g", A.end);

itoa (A.N, svN, ix);

itoa (A.N, svM, ix);

strcpy (svFmt, "%.2f');
sprintf (svll, "%g", A.step)
strcpy (svUnits, A.units)

itoa(10, svXl, ix);

itoa( 10, svYl, ix);

itoa (90, svX2, ix);

itoa (90, svY2, ix);

-----------------------------------------------------
void TAxisStruct ::GetData ( axis & A)
{char * erp;
strcpy ( A.name, svName )

A.org = (num) strtod ( svOrg, &erp)
A.end = (num) strtod ( svEnd, &erp)
A.N = atoi ( svN );
A.step = (num) strtod ( svH, &erp)

strcpy ( A.units, svUnits)

-----------------------------------------------------
T~rameStruct:: TFrameStruct0



TAxisStruct X 0;
TAxisStruct Y 0;

svName [0] =0;

-----------------------------------------------------
TFrameStruct :: TFrameStruct ( axis & Hrz, axis & Vrt)

{
TAxisStruct X (Hrz);
TAxisStruct Y ( Vrt);

svName [0] = 0;

-----------------------------------------------------
void TFrameStruct :: GetData ( axis & Hrz, axis & Vrt)
{
X.GetData ( Hrz);
Y.GetData ( Vrt);

-----------------------------------------------------

3.DIALOG CLASSES

Dialog classes are necessary to create a friendly environment for the
user working with the software package. In view of the fact that the project
under developments meant for operation under MS WINDOWS we make use of the
OWL Library, v.2 compiled by Borland.

THe report contains the child classes from the class TDialog OWL Borland
Library. They were developed for input and variation of data required to
initialize new objects. In addition to the input dialog windows the library
contains windows for systems messages and information windows.

Windows informing of the version and authors of the code.

UAAAAAAAAAAAAAAAL UAAAAAAAAXAAAAL
3ProjectRCVersion3 3 OWL-class 3

AAAAAAA.AAAAAAAAAA0 TDialog AAXAAAi,
AAAAAAAAAAAAAAO 3

3 TAboutVersDlg 3
AAAAAAAAAAA0

The dialog window (TInfoDig 1 ) and the data structure (TlnfoTrsl)
are to output information data on reserves of the computer, on computetional
model, etc. through the window of the class TlnfoDlg I.

JAAAAAAAAAAA.
3 OWL-class 3

3 TDialog AAAAAL
0AAAAAAAAAAAAAAAAL AAAAAAAAAAAAAAi 3
3 TlnfoTrsl AAAAAAAAAAAAAAA TInfoDlgl 3

AAAAAAAAAAAAAAAAA0 AAAAAAAXAAAAAAAAA0



The dialog window (TRegion Dig) are to input data into the class TAbstr
and its child classes.

OAAAAAAAAAAAAAk
3 OWL-class3

3TDialog AAAAAAL,
(IAAAAAAAAAAAA 1, AAAAAAAAAAAAAAfP

3TRegionBndsTrs I AAAAAAAAAAAAAK' TRegionBndsDlg 3

A service class to check the input information in the dialog window
(TRegionBndsDlg).

IJAAAAAA.AAAAAAAAAAAA 1,
3OWL-class 3

3TFilterValidator AýAAAL
AWAAAAAAAAAAAAAAAA0 3

3 TAboutVersDlg 3

1* ObjectOriented PIC for C++
1* Version 1.00

1* Copyright (c) 1993, 1994 The Group Compuetr Simulation *

1*High Current Electronics Institute *
1*Contract SPC93-4035(F6 170893 W0612) *

1* ~Last write 10-20-94 *

#if !defined (_PS_-ABOUT _H)
#define _PSABOUTH

#include <owl\dialog.h>
#include "ps idres.rht'

class TAboutVersDlg :public TDialog

pbi:TAboutVersDlg (TWindow * parent,
TResId resld = iddAboutVer,
TModule *module =0);

virtual -TAboutVersDlg 0

public:
void Setup Window 0

#endif
I*** PSABOUT.CPP **
HI #include <_-allpch.h>
HI #pragma hdrstop

#include <owl\static.h>



#include <ver.h>

#include "ps~owl.rh"
#include "ps~idres.rh"
#include "psabout.h"

HI Reading the VERSIONINFO resource.
class ProjectRCVersion

public:
ProjectRCVersion (TModule *module);

virtual -ProjectRCVersion 0);

BOOL GetProductName (LPSTR &prodName);
BOOL GetProductVersion (LPSTR &prod Version);
BOOL GetAuthorName (LPSTR &authorName);
BOOL GetCopyright (LPSTR &copyright);
BOOL GetDebug (LPSTR &debug);

protected:
LPBYTE Transl~lock;
void FAR *FVData;

private:
HI Don't allow this object to be copied.
Proj ectRC Version (const Proj ectRC Version &ft
ProjectRCVersion & operator =(const ProjectRCVersion &)t

ProjectRCVersion: :ProjectRCVersion (TModule *module)

char appFNamne[255];
DWORD fvHandle;
UINT vSize;

FVData = 0;

module->GetModuleFileName(appFName, sizeof(appFNamne));
DWORD dwSize = GetFileVersionlnfoSize(appFName, &fvHandle);
if (dwSize) {

FVData = (void FAR *)new char[(UINT)dwSize];
if (GetFileVersionlnfo(appFName, fvHandle, dwSize, FVData))

if (!VerQueryValue(FVData, "\\arFilelnfo\\ranslation", (void FAR* FAR*)&TransBlock,
&vSize)) {

delete FVData;
FVData = 0;

ProjectRC Version: :-Proj ectRC Version0

if (FVData)



delete FVData;

BOOL Proj ectRC Version: :GetProductName (LPSTR &prodName)

UINT vSize;
char subBlockNamne[255];

wsprintf ( subBlockName,
"\\StringFilelnfo\\%0o81x\\%s",

*(DWORfl *)TransBlock,
(LPSTR)"ProductNarne");

return FVData ?
VerQueryValue ( FVData,

subBlockName,
(void FAR* FAR*) & prodName,
&vSize)

FALSE;

BOOL Proj ectRC Version: :GetProductVersion (LPSTR &prodVersion)

UINT vSize;
char subBlockName[255];

wsprintf ( subBlockName,
"\\StringFilelnfo\\%0o8lx\\%/s",

*(DWORfD *)TransBlock,
(LPSTR)"ProductVersion");

return FVData ?
VerQueryValue ( FVData,

subBlockName,
(void FAR* FAR*)&prodVersion,
&vSize)

FALSE;

BOOL ProjectRCVersion: :GetAuthorName (LPSTR &authName)

UINT vSize;
char subBlockNarne[255];

wsprintf ( subBlockNamne,
"\\StringFilelnfo\\%0o81x\\%/s",

*(DWORfl *)TransBlock,
(LPSTR)"AuthorName");

return FVData ?
VerQueryValue ( FVData,

subBlockName,
(void FAR* FAR*) & authName,
&vSize)

FALSE;



BOOL ProjectRCVersion::GetCopyright (LPSTR &copyright)

UINT vSize;
char subBlockName[25 5];

wsprintf ( subBlockName,
"\\StringFilelnfo\\%0o81x\\%/s",

*(DWORD *)TransBlock,
(LPSTR)"LegalCopyright");

return FVData ?
VerQueryValue ( FVData,

subBlockName,
(void FAR* FAR*) & copyright,
& vSize)

FALSE;

BOOL ProjectRCVersion::GetDebug (LPSTR &debug)

U1NT vSize;
char subBlockName[255];

wsprintf ( subBlockName,
"\\StringFilelnfo\\%0o81x\\%/st',

*(DWORD *)TransBlock,
(LPSTR)"SpecialBuild");

return FVData ?
VerQueryValue ( FVData,

subBlockName,
(void FAR* FAR*) & debug,
& vSize)

FALSE;

--------------------------------------------------------
TAboutVersDlg: TAboutVersDlg (TWindow *parent, TResId resld, TModule *module)

TDialog (parent, resld, module)

HI INSERT>> Your constructor code here.

TAboutVersDlg: :-TAboutVersDlg0

Destroy 0

IIINSERT»> Your destructor code here.

void TAboutVersDlg::SetupWindow 0



LPSTR prodName, prodVersion, authName, copyright, debug;

HI Get the static text who's value is based on VERSIONINFO.
TStatic *versionCtrl = new TStatic (this, IDC_-VERSION, 255);
TStatic *copyrightCtrl = new TStatic (this, IDC -COPYRIGHT, 255);
TStatic *debugCtrl = new TStatic (this, IDC_-DEBUG, 255);
TStatic *authorCtrl = new TStatic (this, IDCAUTHOR, 255);

TDialog:: SetupWindowo;

HI Process the VERSIONINFO.

ProjectRCVersion psVers ( GetModuleo)

HI Get the product name, product version, author name and legal copyright strings.
psVers.GetProductName (prodName);
psVers.GetProductVersion (prodVersion);
psVers.GetAuthorName (authName);
psVers.GetCopyright (copyright);

HI IDC_-VERSION is the product name and version number, the initial value of IDCVERSION is
H/the word Version (in whatever language) product name VERSION product version.

char buffer[255];
char versionName[128];

versionCtrl -> GetText (versionName, sizeof(versionName));
wsprintf (buffer, "%s %s %s", prodName, versionName, prodVersion);
versionCtrl -> SetText (buffer);

authorCtrl -> SetText (authName);
copyrightCtrl -> SetText (copyright);

HI Only get the SpecialBuild text if the VERSIONINFO resource is there.
if (psVers.GetDebug (debug))

debugCtrl -> SetText (debug);

I**PSDLGS1.H*/
#if ! defined (_PS_-DLGSlH)
#define _PSDLGS 1_H

HI #include "psaxis.h"

class _OWLCLASS TDialog;
class _OWLCLASS TComboBox;
class _OWLCLASS TGroupBox;
class _OWLCLASS TEdit;
class _OWLCLASS TStatic;
class_-OWLCLASS TComboBoxData;

#include "ps~regn.h"

#include "ps,_dlgO 1 .rh" // Definition of dialogs resources.

#include "ps idres.rh" HI Definition of dialogs resources.

---------------------------------------------------------



struct TRegionBndsTrslI

TRegionBndsTrsl ~
TRegionBndsTrsl (const TGeomAxis *xl, const TGeomAxis *x2);
TRegionBndsTrsl (TRegionBndsTrsl &src);

void DefaultFill ();
void GetRegionBndsData (const TGeomAxis * xl1, const TGeomAxis * x2)
void SetRegionBndsData ( TGeomAxis & xlI, TGeomAxis & x2)

BOOL svXY;
BOOL svRZ;
BOOL svRTh;
BOOL svxlx2;
char svxlIminprmpt [MXSTAT];
char svxlImaxprmpt [MXSTATjj;
char svx2minprmpt [MXSTAT];
char svx2maxprmpt [MXSTAT];
char svxlmin [MXEDIT];
char svxlmax [MXEDIT];
char svx2min [MXEDIT];
char svx2max [MXEDIT];
TComboBoxData svxlminbnd;
TComboBoxData svxlmaxbnd;
TComboBoxData svx2minbnd;
TComboBoxData svx2maxbnd;
char svNxlprmpt [MXSTAT];
char svNx2prmpt [MXSTAT];
char svNxl [MXLNT];
char svNx2 [MXINT];
char svxlunitsprmpt [MXSTAT];
char svx2unitsprmpt [MIXSTAT];
TComboBoxData svxlunits;
TComboBoxData svx2units;

---------------------------------------------------------

class TRegionBndsDlg :public TDialog
f
public:

TRegionBndsDlg (TWindow *parent,

TRegionBndsTrs 1 & ds,
TRectangleRgn * rgn = 0,
TResld resld = iddBounds 1,
TModule *module = 0);

virtual -TRegionBndsDlg 0

virtual void SetupWindow 0
void CmRestore 0
void CmReset 0);

virtual void CloseWindow (int retVal = 0);
virtual void EvSysCommand (U1NT id, TPoint& pt);
virtual void EvDestroy 0);
virtual BOOL CanClose 0

hit errret;



private:
void FillBoundsCb (TComboBox * cb, WORD mask, int sel);

const char* BoundaryStr (TBoundaryType ind);
void UpdatePrompts 0);
BOOL IsValid (char * errmnsg);
void ChangeGeometry (hit gfW);
void EvCBNxlInKillfocus 0
void EvCBNxlxKillfocus 0
void EvCBNx2nKillfocus 0
void EvCBNx2xKillfocus 0
void EvBNClickedl 0
void EvBNClicked2 0
void EvBNClicked3 0
void EvBNClicked4 0

protected:
TGroupBox *ivGeom;

TStatic *ivx1maxprrpt;
TStatic *jvx2minprmpt;
TStatic *ivx2maxprmpt;

TEdit *ivx1max;
TEdit *ivx~vmin;
TEdit *ivx2max;
TComboBox *ivx1mhibnd;
TComboBox *ivx1maxbnd;
TComboBox *ivx~mhibnd;
TComboBox *ivv,~maxbnd;
TStatic *ivNx lprmnpt;
TStatic *ivNx2prmpt;
TEdit *ivNxl;
TEdit *ivNx2;
TStatic * ivx Ilunitspnnpt;
TStatic *ivx~unitsprmpt;
TComboBox *ivx lunits;
TComboBox *ivx2units;

private:
TRegionBndsTrs 1 * rbtData;
TRegionBndsTrs 1 * iniData;

hit Geom;
TRectangleRgn * Region;

DECLARERESPONSETABLE (TRegionBndsDlg);

---------------------------------------------------------
#defme MXLNF 1 12
#define MXINF2 25
const mnt WMDLGCLOSED = WMUSER + 200;

struct TlnfoTrs 1

f
char svi0 1 [M4XINF 1];
char svi02 [MXINF 1];
char svi03 [MIXINE 1];



char sviO4 [MXINF 1];
char sviO5 [MIXINF 1];
char sviO6 [MXINF 1];
char sviO7 [MXINF 1];
char svi I11 [MX1NF2];
char svil2 [MX1NF2];
char svil3 [MX[NF2];
char svi14 [MXINF2];
char svi 15 [MLXINF2];
char svil16 [MXINF2];
char svil 17 [MXINF2];

class TlnfoDIgI: public TDialog

public:
TInfoDig 1 (TWindow *parent,

TlnfoTrsl & ds,
TResId resld =iddlnfoOl);

void EvDestroy 0);

DECLARERESPONSETABLE ( TinfoDIg 1)

#endif

I*** PS DLG1.CPP **

#if defined QSPRTSERVICE PCH)

#pragma hdrfile "d:\picsim\obj\_service.csm"
#include <owl\dialog.h>
#include <stdlib.h>
#include <stdio.h>
#include <bwcc.h>
#include <owl\combobox.h>
#include <owl\edit.h>
#include <owl\groupbox.h>
#include <owl\radiobut.h>
#include <owl\edit.h>
#include <owl\validate.h>
#include <owl\applicat.h>

#pragma hdrstop

#else

#pragma hdrfile "f:\picsim\obj\.allpch.csm"
#define _ALLPCH
#include< _allpch.h>

#pragma hdrstop

#endif

#include "ps,_digi.h"



#include "ps,_strOl1.rh"

class TNumValidator : public TFilterValidator

public:
TNumValidator (num amin, num amax);

virtual void Error 0;
virtual BOOL IsValid (const char far * str);

IIvirtual UINT Transfer (char far * str, void * buf, TTransDirection drctn);
protected:

num Amin;
num Amax;

//-----------------------------------------------------
TNumValidator:: TNumValidator (num. amin, num amax)

TFilterValidator ("-+01 2345 6789eE.")

Amin = amin; Amax = amax;

//-----------------------------------------------------
BOOL TNumValidator :: IsValid (const char far * str)

char ** erp;
num res = Amin -1.0;

if (strlen(str)==0) return TRUE;
if (!TFilterValidator::IsValid (str)) return FALSE;

res = strtod ( str, erp );
return (erp == NULL) && (res >= Amin) && (res <= Arnax);

H ----------------------------------------------------
void TNumValidator :: Error0
I

char buff [56];
sprintf (buff, "%s %g to %g","Nurnber Must Be In Diapazon", Arnin, Amax);

MessageBox (0, buff,"Bad Floating Point Number", MBOK I MBICONEXCLAMATION);

H ----------------------------------------------------
void TRegionBndsTrs 1 :: DefaultFill0

num x = 0.0;
svXY =FALSE;

svRZ =FALSE;

svRTh = FALSE;
svxlx2 = TRUE;

strcpy (svxlminprmpt, "XI mini");
strcpy (svxlmaxprmpt, "XI max")
strcpy (svx2minprmpt, "X2 min" );
strcpy (svx2maxprmpt, "X2 max")

sprintf ( svxlImin, "%g", x)
sprintf ( svxlImax, "%/g", x)
sprintf ( svx2min, "%g", x)
sprintf ( svx2max, "%g", x)



strcpy (svNxlprmpt, "Nx 1")
strcpy (svNx2prmpt, "Nx2")

svNxl1 [0] = 0;
svNx2 [0] = 0;

strcpy (svxlunitsprmpt, "Xl units")
strcpy (svx2unitsprmpt, "X2 units")

svx lminbnd.AddStringltem ("Conducting", ConductingBnd);
svx lminbnd.AddStringltem ("Open", OpenBnd);
svxlminbnd.AddStringltem ("Axisymmetric", AxisymmetricBnd);
svxlminbnd.AddStringltem ("Periodic", PeriodicBnd);
svxlminbnd.AddStringltem ("Dielectric", DielectricBnd);

svx lminbnd.Select (ConductingBnd);
svxlmaxbnd.AddStringltem ("Conducting", ConductingBnd);
svx lmaxbnd.AddStringltem ("Open", OpenBnd);
svx lmaxbnd.AddStringltem ("Axisymmetric", AxisymmetricBnd);
svxlmaxbnd.AddStringltem ("Periodic", PeriodicBnd);
svxlmaxbnd.AddStringltem ("Dielectric", DielectricBnd);

svxlmaxbnd.Select (ConductingBnd);
svx2minbnd.AddStringltem ("Conducting", ConductingBnd);
svx2minbnd.AddStringltem ("Open", OpenBnd);
svx2minbnd.AddStringltem ("Axisymmetric", AxisymmetricBnd);
svx2minbnd.AddStringltem ("Periodic", PeriodicBnd);
svx2minbnd.AddStringltem ("Dielectric", DielectricBnd);

svx2minbnd.Select (ConductingBnd);
svx2maxbnd.AddStringltem ("Conducting", ConductingBnd);
svx2maxbnd.AddStringltem ("Open", OpenBnd);
svx2maxbnd.AddStringltem ("Axisymmetric", AxisymmetricBnd);
svx2maxbnd.AddStringltem ("Periodic", PeriodicBnd);
svx2maxbnd.AddStringltem ("Dielectric", DielectricBnd);

svx2maxbnd. Select (ConductingBnd);
svx Ilunits.AddString("arbitr");
svxlunits.AddString("m "1);
svxlunits.AddString("cm");
svxlunits.AddString("mm");
svxlunits.AddString("inchs");

svxlunits.Select (2);
svx2units.AddString("arbitr");
svx2units.AddString("m ");
svx2units.AddString("cm");
svx2units.AddString("mm");
svx2units.AddString("inchs");
svx2units.AddString("radians");
svx2units.AddString("degrees");

svx2units. Select (2);

-----------------------------------------------------
TRegionBndsTrs 1:: TRegionBndsTrs 1

DefaultFill 0

-----------------------------------------------------
TRegionBndsTrsl ::TRegionBndsTrsl (TRegionBndsTrs 1 & src)



HI memcpy (this, *(&src), sizeof TRegionBndsTrs 1)
DefaultFill 0);

svXY =src.svXY;

svRZ =src.svRZ;

svRTh =src.svRTh;

svxlx2 =src.svxlx2;

strcpy (svxlminprmpt, src.svxlminprmpt);
strcpy (svxlmaxprmpt, src.svxlmaxprmpt);
strcpy (svx2minprmpt, src.svx2minprmpt);
strcpy (svx2maxprmnpt, src.svx2maxprmpt)
strcpy (svxlmin, src.svxlmin);
strcpy (svxlmax, src.svxlmax)
strcpy (svx2min, src.svx2min );
strcpy (svx2max, src.svx2max)
strcpy (svNxlprmpt, src.svNxlprmpt);
strcpy (svNx2prmpt, src.svNx2prmpt)
strcpy (svNxl, src.svNxl)
strcpy (svNx2, src.svNx2)
strcpy (svxl1unitsprmpt, src.svxlIunitsprmpt)
strcpy (svx2unitsprmpt, src.svx2unitsprmpt)

svxlminbnd.Select (src.svxlminbnd.GetSellndexo);
svxlmaxbnd.Select (src.svxlmaxbnd.GetSellndexo);
svx2minbnd. Select (src.svx2minbnd.GetSellndexo);
svx2maxbnd. Select (src.svx2maxbnd.GetSellndexo);
svxlunits.Select (src.svxlunits.GetSellndexo);
svx2units.Select (src.svx2units.GetSellndexo);

H ----------------------------------------------------
TRegionBndsTrs 1:: TRegionBndsrrsl (const TGeomAxis * xl,

const TGeomAxis *x2

GetRegionBndsData (xl, x2);

-----------------------------------------------------
void TRegionBndsTrs 1 :: GetRegionBndsData (const TGeomAxis x xI,

const TGeomAxis *x2

f
int rx = 10;

DefaultFill 0
if ((x 1)&&(x2))

f
wsprintf ( svxlminprmpt, "%s min", (xl->name))
wsprintf ( svxlmaxprmpt, "%s max", (xl->name))
wsprintf ( svx2minprmpt, "%s min", (x2->name) );
wsprintf ( svx2maxprmpt, "%s max", (x2->name))

sprintf ( svx Imin, "%g", (xl1 ->org))
sprintf ( svx imax, "%g", (xl ->end))
sprintf ( svx2min, "%g", (x2->org))
sprintf ( svx2max, "%g", (x2->end))

wsprintf ( svNxlprmpt, "N %s", (xl ->name));
wsprintf ( svNx2prmpt, "N %s", (x2->name))

itoa ((xlI->N), svNxl1, rx);
itoa ((x2->N), svNx2, rx);

svXY = svRZ = svRTh = svxlx2 = FALSE;



if((xl->id == 0)&&(x2->id = )) svXY =TRUE;

if((xl->id == 2)&&(x2->id == 3)) svRZ = TRUE;
if ((x I ->id ==2)&&(x2->id ==4)) svRTh = TRUE;
if ((xlI->id ==5)&&(x2->id ==6)) svxl1x2 = TRUE;

svxlminbnd.Select (xl->boundl);
svx Imaxbnd. Select (xlI ->bound2);
svx2minbnd. Select (x2->bound 1);
svx2maxbnd.Select (x2->bound2);

if (xl->uid > 0) svxlunits.Select (xl->uid);
if (x2->uid > 0) svx2units.Select (x2->uid);

-------------------------------------------------------
void TRegionBndsTrslI: SetRegionBndsData (TGeomAxis & xl1, TGeomAxis & x2)

string str;
char * erp;
double resi, res2;

if (svXY) {xl.id =0; x2.id =1; strcpy (xl.namne, "X"); strcpy (x2.anae, "Y"); }
if (svRZ) {xl.id =2; x2.id =3; strcpy (xl.name, "tR"); strcpy (x2.name, "Z"); }
if (svRTh) {xl.id =2; x2.id =4; strcpy (xl.name, "R"); strcpy (x2.name, "Th"); }
if (svxlx2){ xl.id =5; x2.id =6; strcpy (xl.name, "XI"); strcpy (x2.name, "X2"); }
x Lorg = (num) strtod (svxl1min, &erp)
x2.org = (num) strtod (svx2min, &erp)
xl .end = (num) strtod (svxlmax, &erp)
x2.end = (num) strtod (svx2max, &erp)
xl.N =atoi(svNxl);
x2.N = atoi ( svNx2 );

xl .boundl = svxlminbnd.GetSellndexo;
x2.boundl = svx2minbnd.GetSellndexo;
xl .bound2 = svxlmaxbnd.GetSellndexo;
x2.bound2 = svx2maxbnd.GetSellndexo;

str =svxlunits.GetSelection 0; strcpy (xl .units, str.c -stro);
str = svx2units.GetSelection 0; strcpy (x2.units, strxýcstr0);

xl .uid = svxlunits.GetSellndexo;
x2.uid = svx2units.GetSellndexo;

H ------------------------------------------------------

-------------------------------------------------------
II it errret;

#define cmsRestore 201
#define cmsReset 202

DEFINE_-RESPONSETABLE I (TRegionBndsDlg, TDialog)
EVENCLICKED (idcXY, EvBNClicked 1),
EV_-BN_-CLICKED (idc_-RZ, EvBNClicked2),
EVENCLICKED (idcRTh, EvBNClicked3),
EV_-BN_-CLICKED (idc-xlx2, EvBNClicked4),
EV_-CBN_-KILLEOCUS (idc xlmin-bnd, EvCBNxlnKillfocus),
EVCBNKILLEOCUS (idc xlmax-bnd, EvCBNxlxKillfocus),
EV_-CBN_-KILLFOCUS (idc x2min-bnd, EvCBNx2nKillfocus),
EVCBNKILLEOCUS (idc x2max-bnd, EvCBNx2xKillfocus),



EV WM DESTROY,
EV WM SYSCOMMAND,
EVCOMMAND (cms_-Restore, CmRestore),
EV_-COMMAND (cms_-Reset, CmReset),

END_-RESPONSETABLE;
// ---------- ------------------------------------------------
TRegionBndsDlg: TRegionBndsDlg (TWindow *parent,

TRegionBndsTrs 1 & ds,
TRectangleRgn * rgn,
TResld resld,
TModule * module)

TDialog (parent, resld, module), iniData (0), rbtData (0)

ivGeom = new TGroupBox (this, idc~geom);
new TRadioButton (this, idc_-XY, ivGeom);
new TRadioButton (this, idc_RZ, ivGeom);
new TRadioButton (this, idcRTh, ivGeom);
new TRadioButton (this, idc -xlx2, ivGeom);

ivxlIminprmpt =new TStatic (this, idcx 1lminjprompt, MXSTAT);
ivxlImaxprmpt = new TStatic (this, idc-x Imaxjprompt, MXSTAT);
ivx2minprmpt =new TStatic (this, idc x2min~prompt, MXSTAT);
ivx2maxprmpt =new TStatic (this, idc -x2max~prompt, MXSTAT);

ivxlminprmpt -> EnableTransfer 0
ivxlmaxpnnpt ->EnableTransfer 0
ivx2minprmpt ->EnableTransfer 0
ivx2maxprmpt ->EnableTransfer 0

ivxlmin =new TEdit (this, idc -xlmin, MXEDIT);
ivxlmax =new TEdit (this, idc xlmax, MXEDIT);
ivx2min =new TEdit (this, idc -x2min, MXEDIT);
ivx2max =new TEdit (this, idc x2max, MXEDIT);

ivxlminbnd =new TComboBox (this, idc-xlmin-bnd, MXCOMBO);
ivxlmaxbnd =new TComboBox (this, idc-xlmax-bnd, MXCOMBO);
ivx2minbnd =new TComboBox (this, idc-x2min-bnd, MXCOMBO);
ivx2maxbnd =new TComboBox (this, idc -x2max-bnd, MXGOMBO);
ivNxlprmpt = new TStatic (this, idc Nxljprompt, MXSTAT);
ivNx2prmpt = new TStatic (this, idcNx2_prompt, MXSTAT);

ivNxlprmpt ->EnableTransfer 0;
ivNx2prmpt ->EnableTransfer 0;

ivNx 1 = new TEdit (this, idc_-Nx 1, MXINT);
ivNx2 = new TEdit (this, idc_Nx2, MXINT);

ivxlIunitsprmpt = new TStatic (this, idc -xlunits~prompt, MXSTAT);
ivx2unitsprmpt = new TStatic (this, idc -x2unitsjprompt, MXSTAT);

ivxlunitsprmpt -> EnableTransfer 0
ivx2unitsprmpt -> EnableTransfer 0

ivxlIunits = new TComboBox (this, idc -xlunits, MXCOMBO);
ivx2units = new TComboBox (this, idc;_x2units, MXCOMBO);

H ivxlImin -> SetValidator (new TNumValidator (- 1000.0, 1000));
ivx 1mi -> SetValidator (new TFilterValidator ("-+.0 123456789eE"));
ivx2max -> SetValidator (new TFilterValidlator ("-+.0 123 456789eE"));
ivNxl - SetValidlator (new TRangeValidator ( 3, 128));
ivNx2 ->SetValidator (new TRangeValidator ( 3, 128));

if ( rgn )
I if ((rgn->X20)->id == 2)



rbtData = new TRegionBndsTrslI ( rgn->X2(), rgn->X1OI
else

rbtData = new TRegionBndsTrslI ( rgn->X 10, rgn->X2();

else
rbtData = new TRegionBndsTrslI ( ds)
iniData = &ds;

Geomn = (rgn ? 1 :4);
if (rbtData->svXY) Geom =1;

if (rbtData->svRZ) Geom =2;
if (rbtData->svRTh) Geom =3;
if (rbtData->svxlIx2) Geom =4;

SetTransferBuffer ( rbtData );
errret = IDOK;

HI SetBkgndColor (COLORAPPWORKSPACE);
HI SetBkgndColor (RGB (0, 127, 127));

-------------------------------------------------------
TRegionBndsDlg: -'TRegionBndsDlg0

HI Destroy (errret);
if (rbtData) delete rbtData;

else MessageBeep (-1);
H/if (iniData) delete iniData;

II GetApplicationo -> EnableCtl3d (FALSE);

H ------------------------------------------------------
void TRegionBndsDlg: :SetupWindow0

HMENU hSysMnu;
TDialog: :SetupWindow 0;

hSysMnu = GetSystemMenu ();
AppendMenu (hSysMnu, MF_-SEPARATOR, 0, NULL);
AppendMenu (hSysMnu, MFSTRING, cmsRestore, "Restore &Initial");
AppendMenu (hSysMnu, ME_-STRING, cmsReset, "Reset &Default");
II GetApplicationo -> EnableCtl3d (TRUE);

-------------------------------------------------------
void TRegionBndsDlg ::UpdatePrompts 0

TransferData (tdSetData);

-------------------------------------------------------
BOOL TRegionBndsDlg: Isyalid (char * errmsg)

char * erp;
double resl, res2;
long les;

strcpy (errmsg, "okay");
erp = 0; resi = strtod ( rbtData->svxlmin, &erp)
if (*erp) { strcpy (enrmsg,"Bad xlmin."); return FALSE;}
if (((Geom==2)II(Geom==3))&&(resl < 0.0))

{strcpy (errmsg, "Radius must be positive."); return FALSE;}



erp = 0; res2 = strtod ( rbtData->svxlImax, &erp)
if (*erp) I strcpy (errmsg,"Bad xlrnax."); return FALSE;}
if (resl >= res2) { strcpy (errmsg,"xlmin >= xlmax."); return FALSE;}

erp = 0; res I = strtod ( rbtData->svx2min, &erp );
if (*erp) I strcpy (errmsg,"Bad x2min."); return FALSE;}

erp = 0; res2 = strtod ( rbtData->svx2max, &erp );
if (*eirp) { strcpy (errmsg,"Bad x2max."); return FALSE;}
if (res 1 >= res2) { strcpy (errmsg,"x2min >= x2max."); return FALSE;}
if (((Geom==2)Ii(Geom==3))&&(rbtData->svxlminbnd.GetSellndexo==(int)PeriodicBnd))

{strcpy (errmsg,"Missmatch boundary (Periodic) for radii."); return FALSE; I
if ((Geom==1)&&(rbtData->svx lminbnd.GetSellndexo=(int)AxisymmetricBnd))

{strcpy (errmsg,"Missmatch boundary for Xmin."); return FALSE; }
if (rbtData->svxlmaxbnd.GetSellndexo==(int)AxisymmetricBnd)

{strcpy (errmnsg,"Missmatch outer boundary (Axisymmetric)."); return FALSE;}
if (rbtData->svx2minbnd.GetSellndexo==(int)AxisymmetricBnd)

{ strcpy (errmsg,"Missmatch boundary (not Radial)."); return FALSE;}
if (rbtData->svx2rnaxbnd.GetSellndexo==(int)AxisymmetricBnd)

f strcpy (errmsg,"Missmatch boundary (Axisymmetric not Radial)."); return FALSE;}
if (((rbtData->svxlminbnd.GetSellndexo==(int)PeriodicBnd)&&

(rbtData->svx lmaxbnd.GetSellndexo!=(int)PeriodicBnd))It
((rbtData->svxlminbnd.GetSellndexo!=(int)PeriodicBnd)&&
(rbtData->svxlmaxbnd.GetSellndexo==(int)PeriodicBnd)))

{strcpy (errrnsg,"Missmatch Periodic boundaries for Ml."); return FALSE;}
if (((rbtData->svx2minbnd.GetSellndexo==(int)PeriodicBnd)&&

(rbtData->svx2maxbnd.GetSellndexo!=(int)PeriodicBnd))II
((rbtData->svx2minbnd.GetSellndexo!=(int)PeriodicBnd)&&
(rbtData->svx2maxbnd.GetSellndexo==(int)PeriodicBnd)))

{strcpy (errmsg,"Missmatch Periodic boundaries for X2."); return FALSE;}
if (((rbtData->svx2units.GetSellndexo==5)II

(rbtData->svx2units.GetSellndexo==6))&&
(Georn != 3))

{strcpy (errmsg,"Missmatch Units for X2 (not Angle)."); return FALSE;}
erp = 0; les = strtol ( rbtData->svNxl1, &erp, 10 );
if (*elrp) { strcpy (errmsg,"Bad MIl."); return FALSE;}
if((fles < 3)1I(les > 512))

( strcpy (errmsg,"Nxl must be in range 3 - 512."); return FALSE; }
erp = 0; les = strtol ( rbtData->svNx2, &erp, 10 );
if (*erp) { strcpy (ernnsg,"Bad Nx2."); return FALSE; I
if ((Ies < 3)II(les > 512))

f strcpy (errmsg,"Nx2 must be in range 3 - 512."); return FALSE; }
return TRUE;

-------------------------------------------------------
BOOL TRegionBndsDlg:: CanClose0
f
char ErrorMessage [80];

TransferData (tdGetData); errret = IDOK;
if (!Is Valid (ErrorMessage))

{strcat (ErrorMessage, "\n Return for Edit ?)

MessageBeep ( -1)
SetDefaultid (idc -x2min);

if (BWCCMessageBox (HWindow, ErrorMessage, "Errors",
MBICONEXCLAMATION I MB IYESNO) == IDYES)

{errret = IDOK; return FALSE;}



else ( errret = IDCANCEL; return TRUE;}

if ( ::MessageBox (O,"Transfer Data ?","PICSIM",
MBJCONQUESTION I MB_YESNO ) == IDYES)

I
Transfer (iniData, tdGetData);
errret = IDOK;
return TRUE;

else return FALSE;

-------------------------------------------------------
void TRegionBndsDlg :: CloseWindow (int retVal)

if (errret != IDOK) TDialog::CloseWindow (errret);
else TDialog: :CloseWindow (retVal);

-------------------------------------------------------
void TRegionBndsDlg :: EvDestroy 0

TDialog: :EvDestroy 0

-------------------------------------------------------
void TRegionBndsDlg: :EvSysCommand (ULNT id, TPoint& pt)

switch (id)
{case cms -Reset: CmReset 0; break;
case cms_-Restore: CmRestore 0; break;

default: TDialog: :EvSysCommand (id, pt);

-------------------------------------------------------
void TRegionBndsDlg::CmReset H) I default

delete rbtData;
rbtData = new TRegionBndsTrs 0;

SetTransferBuffer ( rbtData)
TransferData (tdSetData);

MessageBeep (-1);

--------------------------------------------------------------

void TRegionBndsDlg::CmRestore 0 /initial

delete rbtData;
rbtData = new TRegionBndsTrsl1 (* iniData);

SetTransferBuffer ( rbtData)
TransferData (tdSetData);

if (Transfer (rbtData, tdSetData) < 10) MessageBeep (-1);

//-------------------------------------------------------------

void TRegionBndsDlg :: EvCBNxlInKillfocus0



hit hid = ivxlIminbnd -> GetSellndex 0;
if (ind == PeriodicBnd) ivxlImaxbnd -> SetSellndex (PeriodicBnd);

------------------------------------
void TRegionBndsDlg: EvCBNxlxKillfocus0

hit hid = ivxlmaxbnd -> GetSellndex 0
if (hid == PeriodicBnd) ivxlmhibnd -> SetSellndex (PeriodicBnd);

------------------------------------
void TRegionBndsDlg: EvCBNx2nKillfocus0

hit ind = ivx2mhibnd -> GetSellndex 0
if (hid == PeriodicBnd) ivx2maxbnd ->SetSellndex (PeriodicBnd);

------------------------------------
void TRegionBndsDlg: EvCBNx2xKillfocus0

hit nd. = ivx2maxbnd -> GetSellndex 0
if (ind == PeriodicBnd) ivx2mhibnd -> SetSellndex (PeriodicBnd);

------------------------------------
void TRegionBndsDlg: EvBNClickedl
f
if (Geom != 1)

if (BWCCMessageBox (O,"Set Cartesian Coordhinate System.\n Are You Sure?",
"Change Geometry",

MB -ICONQUESTION I MBYESNO ) == IDYES)
Geom = 1;

ChangeGeometry ( Geom)

------------------------------------
void TRegionBndsDlg: EvBNClicked2 0
{
if (Geom != 2)

if (::MessageBox (O,"Set Cylindric Coordinate System.\n Are You Sure?",
"Change Geometry",

MBI- CONQUESTION I MBYESNO) == IDYES)
Geom = 2;

ChangeGeometry ( Geom)

------------------------------------
void TRegionBndsDlg: EvBNClicked3 0

if (Geom! =3)
{

if (MessageBox ("Set Polar Coordhinate System.\n Are You Sure?",
"Change Geometry",

MB-ICONQUESTION I MBYESNO ) =- IDYES)



Geom = 3;
ChangeGeometry ( Geom)

------------------------------------
void TRegionBndsDlg: EvBNClicked4
f
if (Geom !=4)

if (::MessageBox (O,"Set General Orthogonal Coordinate Systemn.\n Are You Sure?",
"Change Geometry",

MB-ICONQUESTION I MB_YESNO) == IDYES)
Geom =4;

ChangeGeometry ( Geom)

-------------------------------------------------------
void TRegionBndsDlg :: ChangeGeometry (int gfw)

TransferData (tdGetData);
switch (gfw)

case 1:
{strcpy ( rbtData->svxlminprmpt, "ox min")#
strcpy ( rbtData->svxlImaxprmpt, "ox max")
strcpy (rbtData->svNxlprmpt, "Nx");
strcpy ( rbtData->svxlunitsprmpt, "ox units")

break;

case 2:
case 3:

{strcpy (rbtData->svxlminprmpt, "R mlin");
strcpy ( rbtData->svxlImaxprmpt, "R max")
strcpy (rbtData->svNxlprmpt, "Nr" );
strcpy ( rbtData->svxlunitsprnipt, "R units")

break;

case 4:
{strcpy (rbtData->svxlminprmnpt, "Xl mlin");
strcpy ( rbtData->svxlImaxprmpt, foxI max")
strcpy (rbtData->svNx lprmnpt, "Nx 1");
strcpy ( rbtData->svxlunitsprmpt, "XI units")

break;

default: break;

switch (gfw)

case 1:
{strcpy (rbtData->svx2minprmpt, "Y mlin");
strcpy ( rbtData->svx2maxprmpt, "ly max");
strcpy ( rbtData->svNx2prmpt, "Ny" );
strcpy ( rbtData->svx2unitsprmpt, "Y units")

break;



case 2:
{strcpy ( rbtData->svx2minprmpt, "Z mlin");
strcpy ( rbtData->svx2maxprmpt, "Z max")
strcpy (rbtData->svNx2prmpt, "Nz" );
strcpy ( rbtData->svx2unitsprmpt, "Z units")

break;

case 3:
{strcpy (rbtData->svx2minprmpt, "Th mlin");
strcpy ( rbtData->svx2maxpnnpt, "Th max")
strcpy ( rbtData->svNx2prmpt, "Nth"');
strcpy ( rbtData->svx2unitsprmnpt, "Theta")
II rbtData->svx2units.Clear 0);
II rbtData->svx2units.AddString ("radians");
II rbtData->svx2units.AddString ("degrees");
II rbtData->svx2units.AddString ("arbitrary");
rbtData->svx2units.Select (5);

II ivx2units->DeleteString (3);
II ivx2units->DeleteString (4);
II ivx2units->ClearList 0);
Ifivx2units->AddString ("radians");
II ivx2units->AddString ("degrees");
Ifivx2units->SetSellndex (0);

break;

case 4:
{strcpy (rbtData->svx2minprmpt, "X2 mlin");
strcpy ( rbtData->svx2maxprmpt, IX2 max");
strcpy (rbtData->svNx2prmpt, "Nx2"');
strcpy ( rbtData->svx2unitsprmpt, "X2 units")

break;

default: break;

TransferData (tdSetData);

-----------------------------------------------------
const char* TRegionBndsDlg :: BoundaryStr (TBoundaryrype ind)

return string (*GetModule0, ids boundaryOO+ind).c _str 0;
HI return "No Bounds";

II-----------------------------------
void TRegionBndsDlg :: FillBoundsCb (TComboBox * cb, WORD mask, hit sel)

TBoundaryType i;
for ( i = 0; i < NBoundaryTypes; i++)

if ( mask && i ) cb -> InsertString (BoundaryStr (i), i)
cb -> SetSellndex ( sel)

DEFINE_-RESPONSETABLEl (TInfoDlgl,TDialog)
EVWMDESTROY,



ENDRESPONSETABLE;

H ---------------------------------------------------------------------------
TInfoDIgl :: TInfoDlgl (TWindow * parent,

TlnfoTrsl & ds,
TResId resId)

TDialog (parent, resId, 0)
{

hat MXl = sizeof (ds.svi0 1); hat MX2 = sizeof (ds.svil 1);
new TEdit (this, idcinfo0 1, MX 1); new TEdit (this, idcinfo02, MX 1);
new TEdit (this, idcinfo03, MX1); new TEdit (this, idcinfo04, MX1);
new TEdit (this, idcinfo05, MXl); new TEdit (this, idcinfo06, MXl);
new TEdit (this, idcinfo07, MXl); new TEdit (this, idcinfol 1, MX2);
new TEdit (this, idcinfol2, MX2); new TEdit (this, idcinfol3, MX2);
new TEdit (this, idcinfol4, MX2); new TEdit (this, idcinfol5, MX2);
new TEdit (this, idcinfol6, MX2); new TEdit (this, idcinfol7, MX2);

SetTransferBuffer ( &ds );
HI GetApplication0 -> EnableCtl3d (TRUE);
}
H --------------------------------------------------
void TInfoDlg ::EvDestroy 0
{
Parent -> PostMessage ( WM_DLG_CLOSED, WM_DLG_CLOSED);
TDialog::EvDestroyo;

4.COMPUTATIONAL CLASSES

Due to the fact that during the project implementation on various nume-
rical algorythms are used to compute the same physical values and also to
reach the main target of the project-REUSABILITY-we attempted to separate
computational classes from base classes. Development of the class hierarchy
with inheritance is feasible only foe families of certain numerical algo-
ryrhms having similar structure and identical sets of input and output
parameters. In this case the base class is used for late binding and repla-
cement of the numerical algorythms on the run. The library contains only
one computational class which is a prototype of the approach described.

TPoisson
The service class providing links between the computational module and

the object -oriented base classes is to be made up by the classes-descen-
dants TAbstrProcess.

TAbstrProcess
TDetermPrcs
TMomentPrcs
TStaticPrcs - TElectrostaticPrcs
TDynamicPrcs
THistoricPrcs



However, simple and laconic algorythms can be fully encapsulated into
respective classes of our main structure, e. g. the FFT algorythm can be
implemented both in a member-function of the class TGridVal: Spectrum ~j
and in a member-function of the class THarmonic Process:: Spectrum (TPhysVal*).

1* ObjectOriented PIC for C++
1* ~Version 1.00 *

f* Copyright (c) 1993, 1994 The Group Compuetr Simulation *
1*High Current Electronics Institute
1*Contract SPC93-4035(F6170893W06 12)

1* ~Last write 10-20-94 *

#if !defmned CPS_-MODELH)
#defmne _PSMODELH

#include "ps~phval.h't

#include "ps~procs.h"

/* TAbstrModel-----------------------------

class TAbstrModel
I
public:

int idModel; I
IDSTRUCT * Modellnfo; HI

static int ModelsCount; HI
int ModelStatus;!

TGeomFrameWork *GFW;
TAbstrRegion *Region;
TAbstrProcess *Processes;
TAbstrPhysVal *PhysVals;

int phvCount;
hit prcCount;

public:
TAbstrModel 0{ModelStatus =0; phvCount =0; prcCount =0; }

virtual -TAbstrModel 0{}

virtual void Prepare () }
virtual void SetupModel0
virtual void Initialization 0 { };

virtual int DefRegion (TAbstrRegion* Rgn);
virtual int AddSubRegion (TAbstrRegion* Rgn) f return 0; }
virtual int DetMesh (TAbstrMesh* Mesh) = 0;
virtual int AssignGeom (TGeomFrameWork* Geom) = 0;

virtual int DefProcess (TAbstrProcess* Prcs);
virtual mnt AddProcessToList (TAbstrProcess* Prcs);
virtual mnt DefPhysVal (TAbstrPhysVal* PhVal);
virtual mnt AddPhysVal (TAbstrPhysVal* PhVal);



virtual void Run 0 = 0; HI Pure virtual, must be defined in Ancesors
virtual void Stopo = 0; // Pure virtual, must be defined in Ancesors

int Status 0{return ModeiStatus; }

STSimple2DModel-----------------------------

class TSimple2DModel: public TAbstrModel

public:
TAbstrMesh * mesh;

public:
TSimple2DModel 0

virtual hit DefRegion (TAbstrRegion* Rgn);
virtual hit AddSubRegion (TAbstrRegion* Rgn);
virtual hit Defflesh (TAbstrMesh* Mesh);
virtual int AssignGeom (TGeomFrameWork* Geom);

virtual hit DefProcess (TAbstrProcess* Prcs);
virtual hit AddProcessToList (TAbstrProcess* Prcs);

virtual void Run 0);
virtual void Stopo;

1********TElectrostaticModel-----------------------------

class TElectrostaticModel : public TSimple2DModel

public:
TEulerVal * charge;
TEulerVal * potential;
TEulerVal * Ex 1;
TEulerVal * Ex2;
TBeamVal *ebeam;

THistoricVal *time;

public:
TElectrostaticModel 0

virtual void Prepare 0);
virtual void SetupModel 0
virtual void Initialization 0

virtual hit DefRegion (TAbstrRegion* Rgn);
virtual hit AddSubRegion (TAbstrRegion* Rgn);

virtual mnt DefProcess (TAbstrProcess* Prcs);
virtual hit AddProcessToList (TAbstrProcess* Prcs);

virtual void Run 0;
virtual void Stopo;



TPiClassicModel-----------------------------

class TPiClassicModel : public TAbstrModel

public:
T'PiClassicModel 0 : TAbstrModel 0{}

/* TMixModel-----------------------------

class TMixModel : public TPiClassicModel
I ,virtual public TAbstrRegion

public:
TMixModelO : TPiClassicModel 0{}

II ,TAbstrRegion 0) {);
virtual void Run 0 { );
virtual void Stopo { );

/*--------------------------------
#endif
f*** PSMODEL.CPP **

#include "ps~model.h"

/*******TAbstrModel ---------------------------

int TAbstrModel :: DefRegion (TAbstrRegion* Rgn)

Region = Rgn; return (Region? 1 : 0);

int TAbstrModel :: DefProcess (TAbstrProcess* Prcs)

Processes = Prcs; return (Processes ? prcCount--1 : prcCount=-O);

int TAbstrModel :: AddProcessToList (TAbstrProcess* Prcs)

if (prcCount =- 0) return Defl~rocess ( Prcs)
else

f TAbstrProcess *Curr.ent = Processes; hit cnt = 0;
while ( Current->Next )

f Current = Current->Next; cnt++;

Current->Next =Prcs; hit added = ++cnt - prcCount;
return (added)

hit TAbstrModel :: DefPhysVal (TAbstrPhysVal* PhVal)

PhysVals = PhVal; return (PhysVals ? phvCount--1 : phvCount=-O);



hit TAbstrModel ::AddPhysVal (TAbstrPhysVal* PhVal)

if (phvCount == 0) return Defl'hysVal ( PhVal)
else
( TAbstrPhysVal *Current = PhysVals; int cnt = 0;

while ( Current->Next )
{Current = Current->Next; cnt++;

Current->Next =PhVal; int added = ++cnt - phvCount;
return (added)

/* TSirnple2DModel ----------------------------

TSimnple2DModel: TSimple2DModel0
TAbstrModel0

int TSirnple2DModel ::DefRegion (TAbstrRegion* Rgn)

if (Rgn)
{if ((Rgn->Type < 20) && (Rgn->Type > 0))

return (TAbstrModel: :DefRegion (Rgn));
else return 0;
}else return 0;

int TSirnple2DModel: AddSubRegion (TAbstrRegion* Rgn)

return 0;

int TSimple2DModel Def~rocess (TAbstrProcess* Prcs)

return TAbstrModel Def~rocess ( Prcs)

int TSimple2DModel: DefMesh (TAbstrMesh* Mesh)

mesh = Mesh; return 0;

hit TSimple2DModel: AssignGeom (TGeomFrameWork* Geom)

GFW = Geom; return 0;

hit TSimple2DModel AddProcessToList (TAbstrProcess* Prcs)

return TAbstrModel AddProcessToList ( Prcs)



void TSimple2DModel: Run0

TAbstrProcess *Each = Processes; int cnt =0;

while ( Each)

Each -> Run 0
Each = Each->Next; cnt++;

void TSimple2DModel :: Stop0

STElectrostaticModel..................---------

TElectrostaticModel ::TElectrostaticModel0
TSimple2DModel0

int TElectrostaticModel DefRegion (TAbstrRegion* Rgn)

Region = Rgn; return 0;

int TElectrostaticModel AddSubRegion (TAbstrRegion* Rgn)

Region =Rgn; return 0;

int TElectrostaticModel ::DefProcess (TAbstrProcess* Prcs)

Processes = Prcs; return 0;

mnt TElectrostaticModel ::AddProcessToList (TAbstrProcess* Prcs)

Processes = Prcs; return 0;

void TElectrostaticModel Prepare0

void TElectrostaticModel ::SetupModel0

void TElectrostaticModel Initialization 0



void TElectrostaticModel Run 0

void TElectrostaticModel ::Stop0

f****TPiCiassicModei ----------------------------
PS* p5POISS.CPP **

#include "ps~poiss.h"
#include "math.h"

/******** TPoisson-----------------------------

TPoisson ::TPoisson ( TGridVal* Source, TGridVal* Result)

Mesh = Source->Mesh;
NI = Mesh->N1;
N2 =Mesh->N2;
Ms = Mesh->Ms; N = N2;
h I = Mesh->hl1;
h2 = Mesh->h2;

asph = hi/h2; asph2 = asph*asph;
array a (N I); IH scheme coeffs at u[i-1Ij]
array b (Ni1); f/scheme coeffs at u[i+ I j]
array ei(N 1); HI scheme sub-coeffs at u[i~j]
array q (N I); // scheme coeffs at RHS
array c (N2); HI scheme coeffs at u[i~j-i]
array d (N2); II scheme coeffs at u[i~j+i]
array ej(N2); HI scheme sub-coeffs at u[i~j]

HI e = ei+ej
matrix Aq ( Source->data, N I, N2) H/Charge Density f~iji]
matrix Ap ( Result->data, Ni1, N2) I/Potential p[i~j]

array v (N I); I/work array
array cosin2 (N2); HI scheme cosins

/* -----------------------------------------------------
void TPoisson: Prepare (

mnt i, j;
point x, h (hI,h2);

for (i=O; i<=N I; i++)
for 0j=0; i<=N2; j++)
{ ~x = (*Mesh)(i~j);

(Mesh->GFW)->LapiaceShabion (x, h,

c U], ej U], dU], q [i])

q *= epsO;
TBoundaryType btl = (Mesh->X1 )->boundl;
TBoundaryType bt2 = (Mesh->X1)->bound2;

BoundaryConditions (btl, Wt);



for (j=1;j<=Ms-1; j++)
{int k =I«(j -1);

for (i=1; i<=k; i++) cosin2 [k+i-1] = 2.0*cos(O.5*(2*i-1)*M-PI/k);

Ap =Aq = 0.0;

ii =7; i2 =8;
for 0=1; j<=3; j++) Aq 0] = 1.0;

/* -----------------------------------------------------
void TPoisson ::BoundaryConditions (TBoundaryType sbc 1, TBoundaryType sbc2)

switch (sbc 1)

case Conductingl~nd : c [0] = 1.0; b [0] = 0.0; break;
case AxisymmetricBnd : c [0] -= a [0]; break;
default: c [0] -= a [0]; break;

switch (sbc2)
I

case Conductingl~nd : c [NI] = 1.0; a [Ni]= 0.0; break;
case OpenBnd : c [NI] = 1.0; a [NI] = 1.0; break;
default :c[NI] =1.0; a[N1]=0.0; break;

/* -----------------------------------------------------
TPoisson : :-TPoisson (

/* -----------------------------------------------------
void TPoisson :: GetSource ( TGridVal * Src)

Ap =0.0;
Aq.assign (Src->data);

/* -----------------------------------------------------
void TPoisson :: TestSource 0

for (int i=0O; i <Ni1; i++)
for (int j=0; j < N2; j++)

Ap[i][j] = 0.0;
if ((i <= i2) && (i >= i I))

I
if 0 > 0) Aq[i]Ij] = Aq[i]Uj-1];

else Aq[i] [0] = Aq[i] [N2-1]I

/* -----------------------------------------------------
void TPoisson :: TridiagSolver ( array& vp, num dc, num ds)

ara ( )
array x (NI1);



num d;
vp *=ds;

x[i]= b[O]/(ei[0]-dc);
y[l]= vp[0]/(ei[0]-dc);

for (int i--i; i <Ni1; i++)

d = 1.0 / (ei [i] - dc - a [i] * x i)
x [i+i] d b [i];
y [i+i] =d *(vp [i] + a [i] * y [ii);

VP [NI] = (vp [NI] + a [NI] * y [Ni]) / (ei [NI] - dc - a [NI] *x [Ni]);

for (i=N1-1; i >= 0; i--) VP [i] = x [i+1] * VP [i+1] + y [i+i];

/* -----------------------------------------------------
void TPoisson ::AdditiveFactorization ( array & vs, mnt 1ev)

arraywi (Ni); wi =0.0; H (nO);
array w2 (vs); IH ( vec)
num signt=-1.0;
int j, msl;
num dc, de, ds;

msl = I «1 ev;
for (j= 1; j <= msl; j++)

de = 0.5*( dc = cosin2 [j+msl- I]) -signt;
ds = signt * sqrt(i.0 - de*de) / msl;

TridiagSolver ( w2, dc, ds)
wi += w2;

vs = wi;

/* -----------------------------------------------------
void TPoisson ::TopFactorization ( array & vs)

int j;
for 0j=i; j <= (Ms-2); j++) AdditiveFactorization ( vs, j)
for 0=i1; j <= (Ms-2); j++) AdditivelFactorization ( vs, j)

TridiagSolver (vs, 2.0);
TridiagSolver ( vs, -2.0)

/* -----------------------------------------------------
void TPoisson ::PeriodicSolver (

array vw (Ni);
int level, j, h;
int Nm = I «<(Ms-i1);

HI--------------------------UpTo -
for ( level=i; level < Ms; level++)

h = 1 «<(level-i1);
HI....................... boundary
vw = Aq [0] + Aq [h] + Aq [N-h];

AdditiveFactorization ( vw, level)
Ap [0] += vw;



Aq [0] = 2.0*Ap [0] + Aq [h] + Aq [N-h];
/ .......................... regular
for (j=2*h; j <= N-2*h; j += 2*h)

{
vw = Aq U] + Ap [0-h] + Ap [j+h];

AdditiveFactorization ( vw, level);
Ap j] += vw;
Aq [] = 2.0*Ap U] + Aq 0-h] + Aq U+h];

}
} H I/level

H ------------------------ Top Level -
vw = Aq [0] + 2.0*Ap [Nm];

TopFactorization ( vw);
Ap [Nm] += vw;
Ap [N] = Ap [0] += vw;

H -------------------------- Down To -
for ( level=Ms- 1; level > 0; level--)
{ h = 1 << (level-l);

for (j=h; j <= N-h;j += 2*h)
{

vw = Aq U] + Ap 0-h] + Ap U+h];
AdditiveFactorization ( vw, level);

Ap U] += vw;
}; j

; /level

/* -------------------------------------------------------------- */

void TPoisson:: DirichletSolver ()
{
array vw (NI);
int level, j, h;

for ( level= 1; level < Ms; level++)
{ h = 1 << (level-I);

for (j = 2*h; j <= N-2*h; j += 2*h)
{

vw = Aq U] + Ap U-h] + Ap U+h];
AdditiveFactorization ( vw, level);

Ap [] += vw;
Aq U] = 2.0*Ap U] + Aq U-h] + Aq U+h];

}

............................................... level dow n to
for ( level = Ms; level >= 1; level--)

{ h = 1 << (level-i);
for(j =h; j <=N-h; j +=2*h)

{
vw = Aq U] + Ap U-h] + Ap U+h];

AdditiveFactorization ( vw, level);
Ap U] += vw;

}; /level

/* ------------------------------------------- --------------------- */



void TPoisson:: NeumannSolver ()
{

array vw (N1);
int level, j, h;

H -------------------------- Up To -
for ( level= 1; level < Ms; level++)
{

h = 1 << (level-I);
/ ......................... boundaries
vw = Aq [0] + 2.0*Aq [h]; // 0

AdditiveFactorization ( vw, level);
Ap [0] += vw;
Aq [0] = 2.0*Ap [0] + 2.0*Aq [h];

vw = Aq [N] + 2.0*Aq [N-h]; // N
AdditiveFactorization ( vw, level);

Ap [N] += vw;
Aq [N] = 2.0*Ap [N] + 2.0*Aq [N-h];

/ .......................... regular
for (j=2*h; j <= N-2*h; j += 2*h)
{
vw = Aq [U] + Ap [j-h] + Ap [j+h];

AdditiveFactorization ( vw, level);
Ap [j] += vw;
Aq [j] = 2.0*Ap [j] + Aq [i-h] + Aq [j+h];

}
}; // level

H ---------------------- Top Level -
vw = Aq [N] + 2.0*Ap [0];

TopFactorization ( vw);
Ap [N] = Ap [0] += vw;

S------------------------Down To -
for ( level=Ms; level > 0; level--)
{ h = 1 << (level-I);

for (j=h; j <= N-h; j += 2*h)
{

vw = Aq [j] + Ap [i-h] + Ap [U+h];
AdditiveFactorization ( vw, level);

Ap [] += vw;

; /level

/******** TPoisson /-------------------
/*** PS PROCS.H ***/
#if !defined (PS_PROCSH)
#define _PSPROCSH

#include "psregn.h"
#include "psmesh.h"
#include "psphval.h"

class TPoisson;

// --------------------------------
enum TAlgorithm



naDirecti = 1,
naDirect2,
naSOR,
naADE,

STAbstrProcess-----------------------------
class TAbstrProcess

protected:
int idPrcs;

static hit PrcsCount;
int PrcsStatus;

IDSTRUCT *Prcslnfo;
public:

TAbstrProcess * Next;
TAbstrProcess 0): PrcsStatus(O) {++PrcsCount; Next =0; }

virtual -TAbstrProcess 0{}

virtual void Prepare 0 0; HI Pure virtual, must be defined hin Ancesors
virtual void Run () =0; HI Pure virtual, must be defined hin Ancesors
virtual void Stopo 0; // Pure virtual, must be defined hin Ancesors

hit Status () { return PrcsStatus; );
static hit GetCount (){return PrcsCount; }

1****TDetermPrcs-----------------------------

class TDetermPrcs : public TAbstrProcess

public:
TDetennPrcs ():TAbstrProcess(){}

virtual void Run (){}
virtual void Stopo { };

1****TMomentPrcs-----------------------------

class TMomentPrcs : public TAbstrProcess

public:
TMomentPrcs ():TAbstrProcess) {1};

virtual void Run 0) { }
virtual void Stopo {}

I**** TStaticPrcs------------------------------

class TStaticPrcs : public TAbstrProcess

public:
TStaticPrcs 0:TAbstrProcess() {J;

virtual void RunG }



virtual void Stopo f }

/**TDynamicPrcs-----------------------------

class TDynamicPrcs : public TAbstrProcess
f
public:

TDynamicPrcs 0:TAbstrProcess() f
virtual void Run 0) {};
virtual void Stopo {}

1****THistoricPrcs-----------------------------

class THistoricPrcs : public TAbstrProcess

public:
THistoricPrcs 0:TAbstrProcess(){}

virtual void Run 0()}
virtual void Stop(){}

1****TElectrostatics-----------------------------

class TElectrostaticPrcs : public TStaticPrcs
f

TApplicator ShablonO;
TPrcsApplicator Shablon;

public:
TElectrostaticPrcs ( TGridVal* charge, TGridVal* scpot, TAlgorithmn Algorithm)
'-TElectrostaticPrcs(;

virtual void Run 0
virtual void Stop 0

static void SOR (mnt i, hit j) HI probe Successes Over Relaxation
f p [U]u] =p Uil[] + f iN[ub };

void ADE (hit i, intj) f//probe Altemn.Directions Explicit
f p [U]u] p [i][j + f iU[u]; );

void Iteration () { Mesh->LeapFrogNodes (*this, Shablon); }
void Staticltero { Mesh->LeapFrogNodes (SOR); };

private:
TPoisson * Poisson;
TRegularMesh * Mesh;

static matrix p;
static matrix f;

-------------------------------------------------------
class TCoulombFieldsPrcs : public TStaticPrcs
I

TApplicator Shablon;
public:

TCoulombFieldsPrcs ( TGridVal* scpot, TGridVal* ex 1, TGridVal* ex2)
'-TCoulombFieldsPrcs ();



virtual void Run 0
virtual void Stop 0

void GradXl (int i, intj)
( ExI [i][j] = -(p [i+l]0j] - p [i-il]]I) *xhli;

void GradX2 (int i, minj)
(Ex2 [ilUl = -(p [i][j+1] - p [i]U-1]) *xh2; }

private:
TRegularMesh * Mesh;

matrix p;
matrix Exi;
matrix Ex2;

num. xhI, xh2;

/*----------------------------------------------------
#endif
/*** PS PROCS.CPP **
#include "ps~procs.h"
#include "ps~poiss.h"

#include "math.h"

/* ** ** TAbstrProcess-----------------------------
int TAbstrProcess :: PrcsCount = 0;

/* * * * * * * * TElectrostatics-----------------------------
matrix TElectrostaticPrcs p;
matrix TElectrostaticPrcs f;

H ------------------------------------------------
TElectrostaticPrcs :: TElectrostaticPrcs ( TGridVal *charge,

TGridVal * scpot,
TAlgorithm Algorithm)

TStaticPrcs 0,
Shablon ( 0)
Poisson (0)

matrix f ( charge->data, HI Charge Density f [i~j]
charge->Mesh->Nl,
charge->Mesh->N2)

matrix p ( scpot->data, HI Scalar Potential p [i~j]
scpot->Mesh->N 1,
scpot->Mesh->N2)

switch (Algorithm)

cae{~ iet
case naDirecti

Poisson = new TPoisson ( charge, scpot)
Poisson -> Prepare 0;

break;
case naSOR:

ShablonO =reinterpret -cast <TApplicator>(&TElectrostaticPrcs: :SOR);
//Shablon =reinterpret -cast <TPrcsApplicator>(&TElectrostaticPrcs: :SOR);

break;
case naADE :

Shablon = reinterpret-cast <TPrcsApplicator> (&TElectrostaticPrcs: :ADE);



break;

-------------------------------------------------
TElectrostaticPrcs ::-TElectrostaticPrcs (

if (Poisson) ( delete Poisson; Poisson = 0;}

-------------------------------------------------
void TElectrostaticPrcs RunRun

if (Poisson) Poisson -> PeriodicSolver 0

H ------------------------------------------------
void TElectrostaticPrcs :: Stop (

1******** TCoulombFieldsPrcs-----------------------------
TCoulombFieldsPrcs ::TCoulombFieldsPrcs ( TGridVal *scpot,

TGridVal *exi,

TGridVal *ex2)

TStaticPrcs 0,
Shablon ( 0)

matrix p ( scpot->data, HI Scalar Potential p [i~j]
scpot->Mesh->N1,
scpot->Mesh->N2)

matrix Ex 1 ( ex I1->data, HI
ex I ->Mesh->N 1,
ex 1 ->Mesh->N2)

matrix Ex2 ( ex2->data, HI
ex2->Mesh->N 1,
ex2->Mesh->N2)

-------------------------------------------------
TCoulombFieldsPrcs ::--TCoulombFieldsPrcs (

H ------------------------------------------------
void TCoulombFieldsPrcs RunRun

H ------------------------------------------------
void TCoulombFieldsPrcs :: Stop (

H ----------------------------------------- end.


